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Introduction
This course introduces the functionality of the Acumatica ERP data retrieval tools such as Generic
Inquiry and Report Designer. The course is based on a set of examples demonstrating data retrieval
and processing to form data representations that can be viewed and printed.
The course is intended for advanced Acumatica ERP users who are familiar with the user interface
and main principles of the system. Acumatica ERP application specialists and engineers might find the
course useful as well.
On completing the course, you will have an understanding of how to use Acumatica ERP and Acumatica
Report Designer to retrieve data and easily manage it.
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How to Complete the Course
You will start learning how to use Acumatica ERP data retrieval tools with simple examples of the
common functionality and then move to more advanced examples as you go through the course. To
complete the course, we recommend that you do the lessons in the order they are provided, because
some lessons use the results of the previous ones.
What Is in Each Part?
Each of the course parts is dedicated to a particular Acumatica ERP data retrieval tool or related
procedure and consists of lessons you are to complete. Each part begins with an overview topic that
explains the main concepts of the Acumatica ERP subject area that you are going to use in the lessons.
What Is in Each Lesson?
Each lesson consists of steps that outline the procedures you are completing and describe the related
concepts you are learning.
How Should I Use Review Questions?
Review questions help you remember the key ideas of a lesson. Review questions are provided with
an answer key. After you have completed a lesson, answer the review questions without looking at the
correct answers. Then check your result with the answer key, and review the materials, if needed.
What Are the Documentation Resources?
All the links listed in the Related Links sections refer to the documentation available on the https://
help.acumatica.com/ website. These and other topics are also included in the Acumatica ERP instance,
and you can find them under the Help menu.

| Course Prerequisites | 8

Course Prerequisites
For this course, you should be familiar with the Acumatica ERP user interface and the main principles
of the system. Knowledge of the Distribution and Account Receivable modules of Acumatica ERP is
desirable but not necessary. This course is designed for use with Acumatica ERP 2017 R2 with the
SalesDemo company instance. You also have to import the S130 customization project.
To complete the course, deploy an instance of Acumatica ERP, complete the lessons from each part of
the course in the order in which they are presented, and pass the assessment tests. That is, perform
the following steps:
1.

Download and install the latest version of Acumatica ERP 2017 R2, which is available on our
Partner Portal https://partners.acumatica.com/ (login required).

2.

Create a company with the SalesDemo data on an instance of Acumatica ERP 2017 R2. To do
that, perform one of the following steps:
•

Deploy a new Acumatica ERP 2017 R2 instance with the SalesDemo company.

•

Update an existing Acumatica ERP instance to 2017 R2, and then add the SalesDemo
company to this instance.

3.

Change the home page of your user account and the name of the SalesDemo company.

4.

Import the S130 customization project to the SalesDemo company.

5.

Start with Part 1, and complete all the lessons of the part.

6.

On Acumatica University, take Certification Test 1.

7.

Continue with Part 2, and complete all the lessons of the part.

8.

On Acumatica University, take Certification Test 2.

9.

Complete Part 3, Part 4, Part 5, and Part 6.

10. On Acumatica University, take Certification Test 3.
How to Specify User Settings
To specify the settings of your user account, do the following:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

In the upper-right corner of the Acumatica ERP screen, in the info area, click your user name to
open the user menu, as shown in the following screenshot, and select User Profile.

3.

In the Personal Settings area of the General Info tab of the User Profile form (SM203010),
which opens, clear the Home Page box, as shown in the screenshot below, to use the default
home page for this user.

| Course Prerequisites | 9

Figure: Specifying the default home page

4.

Save your changes to your user account.

How to Change the Company Name
The company login name is the name you select when you log in to Acumatica ERP. For the SalesDemo
company, you have specified the SalesDemo login name.
The company name, which can be the same as the company login name or can differ from it, is the
name that is used in Acumatica ERP. This name is the topmost node in the site map. To change the
company name of the SalesDemo company, do the following:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

On the Companies form (SM203520; System > Management > Manage), in the Company ID
box, click the magnifier icon and select the company with the SalesDemo login name, as shown
in the screenshot below.

3.

In the Company Name box, type Company.

4.

Save your changes to the company.

Figure: Specifying the company name

| Course Prerequisites | 10

What Files Are Provided with the Course
The following files are provided with this course:
•

S130_InquiriesReportsDashboards_5_3.pdf: This guide

•

S130.zip: The S130 customization project to be used in some lessons

•

S130_Files.zip: Files, such as images, to be used in some lessons

How to Import a Customization Project
The list of files provided with the course includes the S130.zip file. This is the customization project,
whose data you will use in the course lessons. To import this customization project, do the following:
1.

On the Customization Projects form (SM204505; System > Customization > Manage), on the
form toolbar, select Import > Import New Project.

2.

In the Open Package dialog box, which appears, click the Choose File button, select the
S130.zip file, and click Upload. The S130 project appears in the list of customization projects.

3.

Select the unlabeled check box for the S130 project, as shown in the screenshot below, and click
Publish on the form toolbar.

Figure: Selecting the customization project for publishing

4.

In the Compilation dialog box, which appears, click the Publish button, as shown in the
following screenshot.

Figure: Confirming a publishing

5.

When the project is published and the notification Website has been updated appears at
the bottom of the Compilation dialog box, close the dialog box.
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6.

On the Customization Projects form (SM204505), notice that the Published check box is
selected for the S130 project. This means that you have successfully imported and published the
customization project.

The S130 customization project contains the following:
•

The AR-Invoices generic inquiry, developed on the Generic Inquiry form (SM208000; System >
Customization > Manage)

•

The Open Sales Orders by Customer (RD) report (SO615000; Distribution > Sales Orders >
Reports > Audit)

Related Links
Updating Acumatica ERP Locally
Installing Acumatica ERP Locally
Customization Projects
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Introduction to Acumatica ERP User Interface
Acumatica ERP now offers two user interfaces:
•

Modern, introduced in 2017 R2, which is now used by default

•

Classic, which is the user interface used in previous Acumatica ERP versions

The following sections describe the main aspects of working with Acumatica ERP user interface when
you complete this training guide:
1.

Completing the Training in Modern UI

2.

Configuring the Quick Menu for the Training

3.

Completing the Training in Classic UI

4.

Navigating to Forms: Tips

1. Completing the Training in the Modern UI
For completing the training, we recommend that you use the modern user interface, which provides an
enhanced new look and easy navigation in the system. The following sections provide an overview of
the modern UI and explain how to navigate in the system during the completion of the training.
To Configure Workspaces in the Main Menu
In the modern UI, the links to forms and reports are organized in workspaces, each of which
corresponds to a functional area in the system. The main menu displays menu items corresponding to
these workspaces (such as Finance or Banking); you can click any menu item (see the screenshot
below).
You can configure the list of workspaces displayed on the main menu panel by pinning and unpinning
workspaces. Workspaces you can access that are unpinned from the panel are hidden under More
Items.
To pin a workspace to the main menu panel, open the needed workspace, and, on the workspace title
bar, click Pin (see the following screenshot).
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Figure: A workspace unpinned from the main menu

To unpin a workspace from the main menu, on the workspace title bar, click Unpin (see the following
screenshot).

Figure: A workspace pinned to the main menu

To Navigate to a Form from a Quick Menu
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Forms in the modern UI are grouped by workspaces, which are shown on the main menu on the left
side of the screen. When you select a workspace, the system shows its Quick Menu, which has links to
the most commonly used forms and reports of the workspace (see the screenshot below), listed under
categories to further organize them. You can click a form name to navigate to it.

Figure: Navigating to a form from a Quick Menu

To View All Forms in a Workspace
To find any form of a workspace that is not shown on the Quick Menu, you can click the Quick Menu title
bar to switch to All Items mode. In this mode, you can see the links to all forms that are included in
the selected workspace (see the screenshot below).
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Figure: Displaying all items of the Finance workspace

To Add Forms to a Quick Menu
To add a form that currently is not shown on a Quick Menu of a particular workspace, open the needed
workspace, and on the workspace title bar, click the Edit button (see the previous screenshot). In
Configuration mode, select the check boxes next to the needed forms, and then click Exit to apply
your changes and exit Configuration mode.
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Figure: Adding forms to a Quick Menu

The full list of forms used during the completion of this training is provided below in this topic. We
recommend that you be sure all these forms have been added to the applicable quick menus, to
simplify navigation during the completion of the training.
To Review and Open Documents on Substitute Forms
Substitute forms provide a quick and easy way to review the list of records created on the applicable
data entry forms. A substitute form is a generic inquiry that shows the summary information on the
records entered on the particular entry form. Substitute forms are initially brought up instead of the
corresponding entry forms when a user navigates to these forms in the Quick Menu.
For example, if you click Journal Transactions (under the Transactions category) on the Quick Menu
of the Finance workspace, the system opens the Journal Transactions substitute form (GL3010PL),
which shows the list of all transactions in the system (see the screenshot below). The substitute form
may show tabs that filter the documents by their type or status.
To open the Journal Transactions entry form (GL301000) for entering a new batch of transactions from
the Journal Transactions substitute form (GL3010PL), you need to click Add New Record button on the
form toolbar.
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Figure: Viewing the Journal Transactions substitute form

If the training instructions ask you to open a particular document (such as a batch, an Accounts Payable
bill, or an Accounts Receivable invoice), you can find this document on the appropriate substitute form
and then click its reference number link to open this document on the data entry form. Alternatively,
you can open the data entry form itself, select the module or document type (depending on the form),
and in the Reference Nbr. box, click the selector icon and select the document by its reference
number (see the screenshot below).

Figure: Opening a document by its reference number

Configuring the Quick Menu for the Training
Before you start to complete the training, make sure the needed workspaces (listed below) are pinned
to the main menu and menu items (listed below along with the categories of the workspace they should
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be listed under) are shown in the Quick Menus of the corresponding workspaces and add the forms that
are not shown. This will help you access the forms quickly.
The following workspaces should be pinned to the main menu:
•

Customization

•

Sales Orders

•

Receivables

•

System Management

•

User Security

You can temporarily unpin workspaces other than the workspaces listed above from the main menu for
your convenience.
The following items should be included in the Quick Menu of the corresponding workspaces:
•

•

Customization workspace
•

Inquiries > Source Code

•

Profiles > Customization Projects

•

Profiles > Dashboards

•

Profiles > Filters

•

Profiles > Generic Inquiry

•

Profiles > Pivot Tables

•

Profiles > Site Map

Sales Orders workspace
•

•

•

•

Transactions > Sales Orders

Receivables workspace
•

Profiles > Customers

•

Transactions > Invoices and Memos

•

Reports > Customer Summary

System Management workspace
•

Localization > System Locales

•

Localization > Translation Dictionaries

•

System Preferences > Site Preferences

User Security workspace
•

Access Rights > Access Rights by Screen

•

User Management > Users

3. Completing the Training in the Classic UI
The following sections provide a quick overview of the classic UI and explain how to navigate in the
system during the completion of the training.
To Switch Back to the Classic UI
When you have created a new company and signed in to it, the modern user interface is enabled by
default. If you need to switch back to the classic UI, do the following:
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1.

In the top right corner, click the name of the current user, and click My Profile, as shown in the
following screenshot.

Figure: Opening the user profile

2.

On the User Profile form (SM203010), which opens, select the Show Classic UI by Default
check box, and save your changes.
To switch back to the modern UI, again click the name of the current user in the top right corner and click
Switch to Modern UI in the menu (see the screenshot below).

Figure: Switching to the modern UI

To Navigate to Forms in the Classic UI
To help learners to search for particular forms during the training completion in the classic UI, the paths
to forms in this training guide are based on the classic UI. The main menu, at the top of the screen,
shows suites and the modules of the selected suite. The navigation pane, located on the left side of the
screen, shows the forms of the modules grouped by their functions. The path to a particular form is
specified as follows in the training:
Form Title (Form ID; Suite > Module > Tab > Node)
For example, the form with the following path is shown in the screenshot below:
General Ledger Preferences form (GL102000; Finance > General Ledger > Configuration > Setup)
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Figure: General Ledger Preferences form in the classic UI

4. Navigating to Forms: Tips
The following tips apply to the modern and classic user interfaces and will help you to quickly find and
open any form.
How To Search for a Form by Its Title or ID
At any time, you can quickly search for a particular form by typing its title or ID in the Search box:
•

In the modern UI, type the text in the Search box on the top of the screen (see the following
screenshot). The system shows the search results in the Search window, which opens when you
start typing the text in the Search box. Then on the Menu Items tab of the Search window, you
click the link to open the needed form.

Figure: Searching for a form by title in the modern UI
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•

In the classic UI, type the text in the Search box at the top of the navigation pane (see the
following screenshot). To navigate to the needed form, click it in the drop-down list with the
search results.

Figure: Searching for a form by its title in the classic UI

How To Navigate to Forms by Using the Form ID
In the training guide, each form is referred to by its ID. If you are not sure in which area a particular
form is located, instead of searching for the form, you can simply open it by using its form ID. You can
do this in both the modern UI and the classic UI as follows:
1.

In the browser's address bar, change the form ID of the currently opened form to the form ID of
the needed form (see the screenshot below).

Figure: Entering the form ID

2.

Press Enter. The system navigates to the form.
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Acumatica ERP Reporting Tools
Using the following Acumatica ERP reporting tools you can modify existing reports and develop new
ones, which can be delivered online, converted to PDF, or delivered via email:
•

Generic inquiries

•

Report Designer

•

Dashboards

•

Reusable filters

•

Analytical reports

You can distribute generic inquiries, reports, shared reusable filters, analytical reports, and
access rights to these objects as a part of a customization project. For more information on using
customization projects, see the links in the Related Links section of the topic.
Generic Inquiries
The Generic Inquiry is an integrated Acumatica ERP tool that provides non programmers with an easyto-use web-based interface they can use to create inquiries and add them to the system.

Figure: The example of an inquiry form

Report Designer
Acumatica Report Designer is a standalone application that you can use to create, edit, and save
reports suitable for printing, such as customer statement form or invoice form. When the standard
reports do not include needed data or when their layouts do not meet your needs, you can customize
the report or design a new one. With the Report Designer, you can select data, calculate required
values based on the selected data, customize reports layouts, group the selected data, create totals and
subtotals.
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Figure: The example of an executed report

Dashboards
A dashboard is a collection of widgets that are displayed on a single page and are designed to give you
needed information at a glance. With dashboards, you can act on real-time information that you have at
your fingertips.
Dashboards may serve different purposes, and you can create dashboards that display information from
various sources, including Acumatica ERP inquiry and processing forms, wiki articles, announcements,
and event calendars. If the source is an Acumatica ERP form, its data can be displayed in various types
of charts and tables, with the data filtered according to selection criteria. From the dashboard, you can
click any widget to explore the information further.
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Figure: The example of dashboards

Reusable Filters
You can use reusable filters to create additional filtering conditions for Acumatica ERP list forms and
inquiries easily and quickly.

Figure: The example of reusable filters

Analytical Reports
The Analytical Report Manager is an integrated Acumatica ERP utility that provides an easy-to-use webbased interface that you can use to create financial reports based on the following data:
•

General ledger data

•

Project accounting data

The system includes sample reports, which use the predefined account classes, such as the following:
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•

Balance Sheet

•

Statement of Cash Flows

•

Profit and Loss

You can use the Analytical Report Manager to modify these reports and create more financial reports
that you need.

Figure: The example of an ARM report

The creation of analytical reports is outside of the scope of this course.
Related Links
Managing Customization Projects
Managing Generic Inquiries
Acumatica Report Designer Guide
Managing Shared Filters
Managing Analytical Reports
Overview of the User Security Configuration Process
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Part 1: Generic Inquiries
In this part of the course, you will learn step by step how to create and configure a generic inquiry. In
particular, you will learn to:
•

Create, configure, and publish inquiries

•

Replace entry forms with inquiries

•

Expose inquiries by using OData
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Data Access Overview
To design an inquiry, you need to have general knowledge of data access classes (DACs).
In Acumatica ERP, the data is stored in a database. However, users of Acumatica ERP do not access the
database directly. Instead, they access the DACs, as shown in the illustration below.
Similarly, when building inquiries, you retrieve data from the data access classes rather than working
with the database tables directly. In many cases, the data access classes directly correspond to the
database tables; however, this is not necessarily the case for all the tables. The fields of the data
classes correspond to the database columns, but this too is not necessarily the case for all the fields.
For simplicity, we will use the terms data access class, data class, class, and table interchangeably. With
all these terms, we mean the data access class but not the database table.

Figure: Data access workflow

Determining Which Data Access Classes to Use
You usually create an inquiry to get a certain result. Consequently, you know data which you originally
have to use. Thus, you have to explore which classes you can use to access this data.
To find the underlying data access classes, you can explore the related forms. For example,
suppose that you want to find the data field that holds the sales orders numbers. Thus, you have
to open the Sales Orders form (SO301000; Distribution > Sales Orders > Work Area > Enter), click
Customization > Inspect Element on the form title bar (item 1 in the screenshot below), and click
the Order Nbr. element on the form (item 2). The Element Properties dialog-box opens. You are
interested in two elements—that is, Data Class and Data Field (item 3), which correspond to the class
and field you need (item 3).

Figure: Inspecting an element to get its data access class

You can get more information on the Source Code form (SM204570) about the class you need in two
ways:
•

Open the Source Code form from the Element Properties dialog box by clicking Actions > View
Data Class Source (item 4 in the screenshot above). The Source Code form opens in a popup window. The specified data class is shown on the Data Access tab (item 1 in the screenshot
below).
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•

Open the Source Code form (SM204570; System > Customization > Explore) directly. In the
Table Name box on the Data Access tab, select the data class you need.

Notice that the data class name in the Element Properties dialog box (item 3 in the screenshot
above) differs from the data class name on the Source Code form (SM204570; item 1 in the screenshot
below), although both names represent the same data class. PX.Objects.SO.SOOrder is the full name,
and SOOrder is the shortened version shown in the Element Properties dialog box. The full name
of any data access class consists of the namespace PX.Objects.SO, which includes the code of the
module SO, and the class name, SOOrder.
All fields of a data access class are listed on the Data Access tab, as shown in the screenshot below.
To identify the key fields, you need to pay attention to the fields marked with the IsKey or
PXDBIdentity attribute in the source code of the class. Fields that constitute the key of the data
records are marked by the IsKey parameter in the type attribute. One field in a class may be marked
with the PXDBIdentity attribute. This attribute designates the key of the data record, by which
you have to join classes in queries. In such classes with the PXDBIdentity field, you can find other
fields marked with the IsKey attribute, but these fields are used for the user-friendly identifiers in
the user interface, and they do not constitute the actual key of the record. For more information on
the attributes, see the online product documentation supplied with Acumatica ERP (Help > Acumatica
Framework > API Reference > Attributes).
Master classes, such as Customer and InventoryItem, usually have two key fields—that is, one with the
IsKey attribute, and another with PXDBIdentity. For example, the key fields of the InventoryItem
class are InventoryID, which is marked with the PXDBIdentity attribute, and InventoryCD, which
is marked with the IsKey attribute. For such classes, use the PXDBIdentity field to join classes
in queries and the IsKey field in other cases, such as using for inquiry or report parameters. The
PXDBIdentity field is more preferable to use for joining classes in queries than the IsKey field,
because the PXDBIdentity field is also the identity column of the database table. This column is a
part of the database index, thus the queries with the PXDBIdentity fields execute faster than the
queries with the IsKey fields.
Document and transaction classes, such as SOOrder, ARInvoices, and ARPayment, usually have two
or more key fields, which are marked with the IsKey attribute. For example, the key fields of the
ARInvoices class are RefNbr and DocType. You can use these fields to join classes in queries.
On the Data Access tab of the Source Code form (SM204570), click #region OrderNbr to expand
its attributes (item 2 in the screenshot below). Inside, you can find the string IsKey = true, which
means that OrderNbr is included in the key of this class (item 3).
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Figure: Exploring a data access class on the Source Code form

It is a bit more complicated to find the key fields of the Customer class than of the SOOrder class (item
1 in the screenshot below). BAccountID is the key field of the Customer class, but you cannot find the
string IsKey = true, if you expand the #region BAccountID data field (item 2).

Figure: Exploring the Customer class on the Source Code form

Notice that the Customer class inherits the Baccount class (item 3 in the screenshot above). You
can scroll the Customer class on the form and find its parent BAccount class further (item 1 in the
screenshot below). If you expand the #region BAccountID data field (item 2) of the BAccount class,
you can find the string [PXDBIdentity()] (item 3), which means that Baccount is the key field of
the BAccount class and all classes that inherit the BAccount class. Thus, BAccountID is the key field of
the Customer class.
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Figure: Exploring the Customer class on the Source Code form

Similarly, you can explore any element you need for your inquiry. For the key fields of the class,
you have to observe the data class and the database table. To reveal the relationships between the
classes, inspect the fields of the main and related classes and review the structure of the corresponding
database tables.
Some data access classes have virtual data fields, which values are not stored in the database as
values of ordinary data fields. Similarly, an entire class can be virtual—that is, all the data fields
of this class are virtual. For example, the Inventory Transaction Details form (IN404000) uses the
InventoryTranDetEnqResult class, which is virtual, to show summary information about inventory
transactions posted within a selected financial period. If you use a virtual data field in your inquiry or
report, this data field returns no data.

Related Links
To Explore the C# Code of a DAC
Exploring the Source Code

| Lesson 1: Creating a Generic Inquiry | 31

Lesson 1: Creating a Generic Inquiry
In this lesson, you will create the Open Sales Orders by Customer inquiry, which lists sale orders that
meet the following criteria:
•

The type of the sales orders is SO (Sales Order).

•

The status of the sales orders is Open. (Optionally, the user can include sales orders of other
statuses in the inquiry results.)

•

The dates of the sales orders fall within the date range that the user has to specify.

•

The sales orders are filtered by the selected customer, if the user has specified one.

•

The listed sales orders are sorted by date and customer name.

You will go through the whole process of creating this inquiry.
At the end of the lesson you will be suggested to do a practice exercise.
Lesson Objectives
In this lesson, you will learn how to do the following:
•

Select the tables for the inquiry

•

Specify the table relations

•

Configure the inquiry parameters

•

Specify the inquiry conditions

•

Group the inquiry data

•

Sort the inquiry data

•

Configure the grid that displays the results of the inquiry

•

Use calculated values for the result columns

•

Preview and publish the inquiry
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Step 1.1: Creating the Inquiry
You create an inquiry on the Generic Inquiry form (SM208000). Do the following:
1.

Open the Generic Inquiry form (SM208000; System > Customization > Manage).

2.

Create a new inquiry with the following settings:

3.

•

Inquiry Title: SO-OpenByCustomer

•

Arrange Parameters in: 2

Save the inquiry.

Inquiry Title is the inquiry name, which has to be unique among the generic inquiries.
Arrange Parameters in specifies the number of columns in which the inquiry parameters are arranged
on the inquiry form.
At the next step you will select the tables to the inquiry you have created.
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Step 1.2: Selecting the Tables for the Inquiry
To configure the inquiry you created, you will use the sales order class and the customer class. To find
these classes and to reveal the relationships between them, do the following:
1.

To discover the class that provides access to the sales order data, investigate the Sales Orders
form (SO301000; Distribution > Sales Orders > Work Area > Enter).

2.

To discover the class that provides access to the information about the customers the sales were
made to, investigate the Customers form (AR303000; Finance > Accounts Receivable > Work
Area > Manage). Notice that the Customer ID element corresponds to the AcctCD field. AcctCD
is a user-friendly substitute for the bAccountID key field for the user interface, but AcctCD is
not the identity key. In the database terminology, AcctCD is a natural key, and bAccountID is a
surrogate key.

3.

To find the key fields of the classes you discovered, observe them on the Source Code form
(SM204570; System > Customization > Explore). On the Table Name box on the Data Access
tab, select the data class you need.
You can open the Source Code form with the appropriate data class while you are investigating
the Sales Orders and Customers forms. To do that, in the Element Properties dialog box, click
Actions > View Data Class Source.

You can discover that the SOOrder class provides access to the sales order data. The Customer class
provides access to the customers. The CustomerID field of the SOOrder class is the reference to
the customer record—that is, the CustomerID field is the foreign key to the BAccountID field in the
Customer class, as shown in the following diagram.

Figure: The classes and relationships between them

Selecting the Tables for the Inquiry
To add the classes shown in the diagram above to the inquiry, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Tables tab, add a row, select the cell in the Table Name column, and click the magnifier
icon, as shown in the screenshot below.
In the dialog box, which appears, you can select the needed class. On the Most Used tab, which
opens by default, you can find the list of the most used classes, which have the non empty
Display Name attribute. On the All Records tab, all the available classes are listed.

3.

On the Most Used tab, filter the list of classes by customer and double click the row with the
PX.Objects.AR.Customer class, to select the class.
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Figure: The Tables tab with the added classes

4.

Add the next row, and select the PX.Objects.SO.SOOrder class in the Table Name column.
You can look for the class you need straightly in the Table Name column, as shown in the
screenshot below.
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Figure: The Tables tab with the added classes

5.

Save your changes to the inquiry.

PX.Objects.SO.SOOrder and PX.Objects.AR.Customer are the full names of the sales order class and the
customer class, respectively.
Alias contains the class names that you will use to refer to the table while creating the inquiry. You
can type Alias manually or leave it empty, as you did. If you leave Alias empty, the system fills it in
automatically, when you select an other row or save the inquiry. Once you select an other row or save
the inquiry, you cannot change Alias.
Related Links
Generic Inquiry (Tables Tab)
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Step 1.3: Specifying the Table Relations
You have to specify the relationships between the classes you added so that the system can generate a
query. In the Table Relations area of the Relations tab, you specify the relations between the pair of
tables. In the Data Field Links for Active Relations area of this tab, for each pair of related tables,
you specify the links between the columns of these two tables.
You can add two or more tables to your inquiry without having to join them. The most common case of
using a table that is not joined with the others is to select some fields of this table as Schema Field of
some inquiry result columns. For more information on configuring the results grid of an inquiry, see Step
1.7: Configuring the Inquiry Results Grid .

To specify the relations, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Relations tab, in the Table Relations area, add a row and specify the following
settings, as shown in the screenshot below:

3.

•

Parent Table: SOOrder

•

Join Type: Inner

•

Child Table: Customer

On the Relations tab, in the Data Field Links For Active Relation area, add a row and
specify the following settings:
•

Parent Field: CustomerID

•

Condition: Equals

•

Child Field: BAccountID

This links the classes selected in the Table Relations area by their identity keys.
When you select data fields, you can look for the field you need by filtering the list of available
fields, as shown in the screenshot below.
4.

Save your changes to the inquiry.

You selected SOOrder as the parent table, because the required sales data is provided by the SOOrder
class. The Customer class provides additional information, so you selected it as the child table.
An Inner join creates a result by combining the rows of the parent and child tables when there is at
least one match in both tables. For an Inner join, the order of tables does not matter. You could select
the Customer class as the parent table and the SOOrder class as the child table and get the same
result.
A Left join returns all rows from the parent table combined with the child table, even if there are no
matches in the child table. Therefore, the order of classes is important if you use a Left join.
Join types selected in the Join Type column work exactly the same as appropriate SQL JOIN statements.
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Figure: The Relations tab with the configured relationships between the classes

Related Links
Generic Inquiry (Relations Tab)
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Step 1.4: Configuring the Inquiry Parameters
You also need to specify the inquiry parameters for the generic inquiry being designed. The inquiry
parameters will be displayed on the inquiry form above the data, and the user will enter values for
the parameters. For this inquiry, the user can enter the date range and, optionally, the customer. To
configure these parameters, do the following (as shown in the screenshot below):
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Parameters tab, add to the table the following lines, each of which represents an inquiry
parameter:
Is
Required

Name

Scheme Field

Display
Name

From
Schema

Default
Value

Selected

DateFrom

SOOrder.OrderDate

Date From

Selected

8/9/2015

Selected

DateTo

SOOrder.OrderDate

Date To

Customer

Customer.AcctCD

Customer

OrderStatus

<CheckBox>

Open Only

8/15/2015
Selected

Cleared

As the Default Value of the inquiry parameters with the date data type, you can specify an
exact date or select one of the following date-relative parameters:
•

@WeekStart and @WeekEnd: The start and the end of the current week

•

@MonthStart and @MonthEnd: The start and the end of the current month

•

@PeriodStart and @PeriodEnd: The start and the end of the current financial period

•

@QuarterStart and @QuarterEnd: The start and the end of the current quarter

•

@YearStart and @YearEnd: The start and the end of the current year

•

@Today: The current day

For the list of available predefined parameters, see the link in the Related Links section of the
topic.
If you leave the Default Value parameter empty, the Acumatica ERP business date will be
shown in the Date From and Date From date boxes on the inquiry form.
To show an empty date box on an inquiry form, specify NULL as its default value.

3.

Save your changes to the inquiry.

In the parameters area on the inquiry form, the parameters will be arranged in two columns, according
to the value of Arrange Parameters in. In these columns, parameters are ordered top-to-bottom and
left-to-right; and their order equals to the order on the Parameters tab.
Column Span specifies the number of columns in the parameters area on the inquiry form this
parameter will span.
You can also change the size of the parameter element by specifying Control Size (XXS, XS, S, SM, M,
XM, or L). For example, the default size of an date box is S, the default size of an lookup box is M.
If the Is Required check box is selected, the user must provide the parameter to view the inquiry
data.
Default Value specifies the default parameter value. Based on the default values you have entered,
the SO-OpenByCustomer inquiry shows open sales orders for the current week, and the inquiry shows
orders with only the Open status.
Selecting the From Schema check box makes it possible to retrieve the list of values that exists for the
field selected in Schema Field, and select one of these values as the default value.
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Figure: The Parameters tab with the specified inquiry parameters

A data field selected in the Scheme Field column specifies the type of a form element that is assigned
for the parameter on the inquiry form and is used to select its value. Based on the data fields you
selected in the column, the calendar dialog box opens, when the user selects values of the Date From
or Date To parameters. For the Customer parameter, the lookup table opens. For more information on
form elements, see the links in the Related Links section of this topic.
In the Schema Field column, you can select any field of the classes selected on the Tables tab, and
two following system fields:
•

<CheckBox>: This system schema field indicates that on the inquiry form, the parameter is
shown as a check box. If the user selects the check box, the value of the parameter becomes
True. If the user clears the check box, the value of the parameter equals False.

•

<ComboBox>: This system schema field indicates that the parameter is shown as a combo box.
When you define a parameter that is a combo box, you have to specify the list of available combo
box options by selecting the parameter on the Parameters tab and clicking Combo Box Values
on the table toolbar, the Combo Box Values dialog box appears (see the screenshot below).
In the Value column, you define the list of options that the user can see in the combo box on
the inquiry form. In the Label column, you define the list of values that are assigned to the
parameter if the user selects the corresponding option of the Value column.

Figure: The list of <ComboBox> values

Related Links
Generic Inquiry (Parameters Tab)
Parameters (Predefined Parameters > Date-relative Parameters)
Form Elements
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Step 1.5: Specifying the Inquiry Conditions
For the generic inquiry being designed, you also need to specify the inquiry conditions, which determine
the data to be retrieved. The inquiry parameters are usually used in the inquiry conditions, where they
must be specified in square brackets, as with [Customer].
The inquiry is designed to show sales orders with the Open status by default. However, based on the
OrderStatus parameter configured for the inquiry, the user can opt to include sales orders with other
statuses in the results. The couple of the parameters—that is, DateFrom and DateTo—determine the
date range of sales orders. The last one is Customer; optionally, the user can select a customer to filter
the sales orders by the selected customer. Also, the inquiry results must include sales orders with the
SO type only.
Based on above requirements, we can specify the following conditions for each sales order to be listed:
•

The order date is greater than or equal to the DateFrom parameter value—that is, the date is
after or the same as the specified date.

•

The order date is less than or equal to the DateTo parameter value—that is, the date is before or
the same as the specified date.

•

If the user selects a customer in the Customer box, the sales order should be associated with
this customer only.

•

If the user does not select any customer, sales orders of all customers should be selected.

•

The sales order status is Open, unless the user has cleared the Open Only check box, which
includes sales order of other statuses in the inquiry results.

•

The sales order type is SO.

To add these conditions to the inquiry, do the following (as shown in the screenshot below):
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Conditions tab, add to the table the lines with the following settings:
Brackets Data Field

(

((

Condition

From
Schema

Value 1

Brackets Operator

SOOrder.OrderDate

Is Greater Than
or Equal To

[DateFrom]

And

SOOrder.OrderDate

Is Less Than or
Equal To

[DateTo]

And

Customer.AcctCD

Equals

[Customer]

Or

[Customer]

IsNull

[OrderStatus]

Equals

SOOrder.Status

Equals

[OrderStatus]

Equals

SOOrder.OrderType

Equals

)

And

=True
Selected

Selected

And

Open

)

Or

=False

)

And

SO

And

The third and fourth rows (item 1 in the screenshot below) are a pair and specify one condition.
The fourth row is used when the user does not select any customer, so the sales orders of all
customers will be selected. The third row is used when the user selects a customer, so only the
sales order associated with this customer will be selected. These events cannot happen at the
same time. Thus, these rows are enclosed in brackets and joined with the OR operator.
The fifth and sixth rows (item 2 in the screenshot below) are a pair. They are used when the
Open Only check box is selected on the inquiry form, So the OrderStatus value is True; and
only sales orders with the Open status will be selected. Thus, these rows are enclosed in
brackets and joined by the AND operator.
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The seventh row (item 3 in the screenshot below) and the previous two rows (item 2) specify
one condition. The seventh row is used when the user clears the Open Only check box. So the
OrderStatus value is False. The check box cannot be selected and cleared at the same time.
Thus, seventh row (item 3) and the previous two rows (item 2) are in brackets and joined with
the OR operator.

Figure: The Conditions tab with the defined inquiry conditions

3.

Save your changes to the inquiry.

To select an existing value for the Value 1 or Value 2 columns from the database, you have to select
the From Schema check box for the row.
Value 2 is used only with the Is Between condition. For example, if you were to select sales orders
whose numbers are between SO003000 and SO003199, you should specify the following condition:
•

Data Field: SOOrder.OrderNbr

•

Condition: Is Between

•

Value 1: SO003000

•

Value 1: SO003199

Related Links
Generic Inquiry (Conditions Tab)
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Step 1.6: Sorting the Inquiry Data
You need to specify how the inquiry data is sorted—that is, the order in which the results should
be displayed on the inquiry form. In this case, the inquiry results have to be sorted by date and by
customer name. To specify how the data will be sorted, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Sorting tab, review the warning in the tab title, as shown in the screenshot below. Until
you define any sorting condition, the default sorting conditions, which are shown at the bottom
of the screen, are used for the inquiry.

Figure: The Sort Order tab with the default sorting settings

3.

Add a row, and select SOOrder.OrderDate in the Data Field column to sort the inquiry results by
sales order date.
Sort Order specifies whether the results should be ordered in Ascending or Descending order.
The default Acceding sort order is selected automatically when you add a row.
You can press Ctrl+Enter to confirm the row and to be able to add the next row to the table.

4.

Add a second row, and select Customer.AcctName in the Data Field column to sort the inquiry
results by customer's name.

5.

Save the inquiry.
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Step 1.7: Configuring the Inquiry Results Grid
You have to define the list of columns that will be used to show the inquiry results. (Otherwise, when
you run the query, you would see the empty inquiry form with the parameters only.) To configure the
inquiry results grid, do the following, as shown in the screenshot below:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the Results Grid tab, make sure that the Caption column is visible. If the column is hidden,
add it by clicking
in the left column header. For more information on how to hide or display
columns, see the links in the Related Links section of this topic.

3.

4.

Add to the table the following lines, each of which represents a column of the inquiry:
Object

Data Field

Caption

Default Navigation

SOOrder

OrderDate

Selected

Customer

AcctCD

Selected

Customer

AcctName

Selected

SOOrder

OrderNbr

Cleared

SOOrder

OrderWty

Quantity

Selected

SOOrder

OrderTotal

Sales Order Total

Selected

SOOrder

Status

Selected

Save your changes to the inquiry.

These rows you have added to the table define the columns to be used for the results of the inquiry you
are designing.
You could simply add all fields of a data access class to an inquiry. If you were to do that, you would select
this class as Object, select <All Fields> as Data Field, and save the inquiry. All the data fields of the
selected class would be added to the inquiry.

Caption specifies the name of the column header to be displayed on the inquiry form. Some data
fields have got default display names, which are defined in their classes. For example, the name of the
Customer.AcctCD data field is Customer ID. Thus, by default, the column header of this filed on the
inquiry form will be Customer ID. On the other hand, the SOOrder.OrderTotal data field has got no
default display name. The captions you added are for the data fields without default names. In your
inquiries, you can define captions for the columns after you preview the inquiries.
When the Visible check box is selected (as it is by default), the column appears by default in the table
showing the inquiry results. If the check box is cleared, the column is hidden by default in the table
showing the inquiry results, but the user can make this column visible.
The columns of the inquiry results that holds the key fields may contain links to the appropriate
screens. If the Default Navigation check box is cleared and you specify no screen to navigate in the
Navigate To column, the column (which in this case holds the key field) does not contain a link to
an object. This check box is selected by default. If you leave the check box selected, the values in the
column are links to objects. The user can open any of these objects by clicking the link.
The order of columns on the inquiry form matches the order of rows on the Results Grid tab. If
you change the order of columns, the columns size, or the set of columns on the inquiry form, these
settings will be used instead of the settings made on the Results Grid tab of the inquiry.
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Figure: The completed Results Grid tab

Related Links
Generic Inquiry (Results Grid Tab)
To Hide or Display Columns

| Step 1.8: Previewing and Publishing the Inquiry | 45

Step 1.8: Previewing and Publishing the Inquiry
You need to preview the inquiry, to be sure it is what you'd anticipated, and then publish it, so that
users can view the inquiry.
You can preview the inquiry directly from the Generic Inquiry form (SM208000; System >
Customization > Manage). Open the SO-OpenByCustomer inquiry, and on the form toolbar, click View
Inquiry. The inquiry form opens (as shown in the screenshot below).
Notice the following things:
•

The values in the Customer ID column are links, because the Default Navigation check box
was selected by default on the Results Grid tab of the Generic Inquiry form (SM208000). On the
other hand, although OrderNbr is the key field, the values in the Order Nbr. column are not links,
because the Default Navigation check box was cleared and the Navigate To was not defined.

•

The Date, Customer ID, Customer Name, Order Nbr., and Status column headers, whose
Caption you have not defined, appropriately describe the data shown in the column. When you
preview an inquiry, if you don't think the column headers appropriately describe the column, you
can define the needed captions for the columns.

Figure: Previewing the inquiry

To make it possible for any user to view the inquiry easily, you have to publish it. To do that, perform
the following instructions:
1.

On the Generic Inquiry form (SM208000), open the SO-OpenByCustomer inquiry, if it is not
already opened.

2.

In the summary area, in the Site Map Title box, type Open Sales Orders by Customer (as
shown in the screenshot below). This is the name of the inquiry form as it will be displayed on
the site map and on the inquiry form title bar.

3.

In the Site Map Location box, select Distribution > Sales Orders > Reports > Audit. This is the
location of the inquiry form on the site map.

4.

Save your changes to the inquiry.
When you save the inquiry with the defined Site Map Location, the system assigns an identifier
to the inquiry and shows this identifier in the Screen ID box.
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Figure: Configuring the inquiry to be published

You have successfully published the inquiry.
5.

Open the Open Sales Orders by Customer form (Distribution > Sales Orders > Reports > Audit).
Notice that the inquiry name is changed on the form title bar (item 1 in the screenshot below)
and appears in the navigation pane according to selected inquiry location (item 2).

Figure: Previewing the published inquiry

You can also publish the inquiry on the Site Map form (SM200520). To do that, you should add
a new row in the table in the right pane of the form, and specify ScreenID, Title, and Url.
The format of the URL is ~/GenericInquiry/GenericInquiry.aspx?Name={inquiry
title}. For example, for the inquiry you created, you should specify the following URL: ~/
GenericInquiry/GenericInquiry.aspx?Name=SO-OpenByCustomer.

6.

Add the generic inquiry to a workspace in the modern UI as follows:
a.

In the main menu, select Sales Orders.

b.

In the main menu, click configuration menu (three dots in the bottom left corner) and
then click Edit Menu to switch to the Menu Editing mode.

c.

Click Add Menu Item.

d.

In the Select Forms box, type Open Sales Orders by Customer.

e.

Select the check box to the left of the Open Sales Orders by Customer generic inquiry in
the Data Views workspace (see the following screenshot).
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Figure: Adding a generic inquiry to a workspace in the modern UI

f.

Click Add & Close to add the selected generic inquiry to the workspace and close the
dialog box.

g.

In the Inquiries section, select the check box to the left of the Open Sales Orders by
Customer generic inquiry to add it to the quick menu by default.

h.

Click Exit Edit Menu to save you changes and exit the Menu Editing mode.

Notice that the Open Sales Orders by Customer generic inquiry appeared in the Sales Orders
workspace.
Once you have published an inquiry, you can simply edit it by clicking Customization > Edit Generic
Inquiry on the form title bar (item 3 in the screenshot above) while you are viewing the inquiry. The
Generic Inquiry form (SM208000) opens with the inquiry selected.
You can export the inquiry data to MS Excel by clicking the Export to Excel (
form toolbar (item 4).

) button on the inquiry

The Files and Notes columns (item 5) contain files and notes of objects that class selected in the first
row on the Results Grid tab of the Generic Inquiry form (SM208000) of the inquiry. The first row on
the Results Grid tab is the sales order date. The SOOrder class is selected as its Object. Thus, the
Files and Notes columns of the inquiry contain files and notes of sales orders.
When you click icons in the Files and Notes columns, appropriate pop-up windows open. Instead, you can
show notes directly on the inquiry form for any class of your inquiry. To do that, add PX.Data.Note table in
the inquiry, join the table with the class that notes you want to show by the NoteID key field, and add the
Note.NoteText data field in the results grid.
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Step 1.9: Configuring Navigation to a Screen from the Inquiry
Form
You can configure an inquiry column to contain links to a screens you needed. Suppose you were asked
to configure the Open Sales Orders by Customer inquiry so that a user could open in a new browser tab
the Business Accounts form (CR3030PL) with the data of a particular customer by clicking the link in the
Customer Name column. To configure the column to contain this link, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

In the Screens area of the Navigation tab, add a line and select Company > Organization >
Customer Management > Work Area > Manage > Business Accounts, as shown in the following
screenshot.

Figure: Selecting the screen to be used for navigation

3.

In the Navigation Parameters area, add a line and specify the following settings, as shown in
the screenshot below:
•

Filed: AcctCD

•

Parameter: Customer.AcctCD

•

Window Mode: Mew Tab

In the Filed column, you select a key field of the screen, and in the Parameter column, you
select a field of one of the inquiry classes to be associated with this key field.
In the Window Mode box at the bottom of the area, you define the way the screen is opened.
The following modes are available:
•

Same Tab: The screen opens in the same browser tab instead of the inquiry. This is the
default mode.

•

New Tab: The screen opens in a new browser tab.

•

Pop-Up Window: The screen opens in a new pop-up window.
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Figure: Configuring navigation parameters for the screen

4.

On the Results Grid tab, modify the row with the AcctName data filed as follows:
•

Default Navigation: Cleared

•

Navigate To: CR303000 - Business Accounts
If you select the Default Navigation check box, you should clear the Navigate To box.

5.

Save your changes to the inquiry.

6.

On the form toolbar, click View Inquiry to preview the inquiry.

7.

On the inquiry form, which opens, click the name of any customer to make sure that the system
shows the customer's details on the Business Accounts form (CR3030PL) in a new browser tab.
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Step 1.10: Using Calculated Values for Columns in the Results
Grid
You can use formulas to calculate the values of columns in the results grid. To define a formula for a
column you have defined on the Results Grid tab of the Generic Inquiry form (SM208000; System
> Customization > Manage), open the formula editor by clicking
in the Data Field column (item 1
in the following screenshot) of the appropriate row. You can enter the formula directly in the formula
editing area (item 2) or compose it by selecting fields and using operators and functions. For more
information on formulas, see the links in the Related Links section of this topic.

Figure: Opening the Formula Editor

Similarly, you can use formulas in the inquiry conditions in the Value 1 and Value 2 columns.

Suppose that you decided to add the sales order description to its number in the following format:
{order number} {order description}. To make the formula, you will use the IsNull(value,
nullValue) function, which returns one of two values, depending on the value. If value is
Null, the function returns nullValue; otherwise, it returns value. The sales order description
(Customer.OrderDesc) will be compared with NULL. If they are not equal, you will add the order
description to the customer number; otherwise, you will add an empty string.
To add this formula, perform the following steps:
1.

On the Generic Inquiry form (SM208000), open the SO-OpenByCustomer inquiry.

2.

On the Results Grid tab, in the Data Field column, open the formula editor for the OrderNbr
data field (as shown in the screenshot above), and replace OrderNbr with the following formula:

=[SOOrder.OrderNbr] + ' ' + IsNull([SOOrder.OrderDesc], '')
If you run Acumatica ERP on a MySQL database, for generic inquiries, use the Concat() function
instead of + to sum values of the string data type, as follows:

=Concat([SOOrder.OrderNbr], ' ', IsNull([SOOrder.OrderDesc], ''))

3.

Save your changes to the inquiry.

4.

Preview the inquiry.
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Notice that the header of the edited column was changed, because its Caption was not defined
(as shown in the screenshot below).

Figure: Previewing the calculated inquiry column

5.

On the inquiry form title bar, click Customization > Edit Generic Inquiry to open the inquiry
on the Generic Inquiry form (SM208000), and fix the header by setting the Order Nbr. caption
for the column. Then review the inquiry again.

Related Links
Formula Editor
Operators
Functions
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Step 1.11: Grouping the Inquiry Data
You can group an inquiry data by specifying grouping conditions for the inquiry.
Suppose that you have decided to group sales orders of the SO-OpenByCustomer inquiry by date and
status to get the count of sales orders, and their total and average amounts for each day and status.
You will specify these grouping conditions in the duplicated inquiry.
Creating a Copy of the Inquiry
To duplicate the SO-OpenByCustomer inquiry, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the form toolbar, click

3.

Create a new inquiry and specify the following Inquiry Title: SO-SOByStatusAndDate.

4.

On the form toolbar, click

5.

Specify the following settings:

> Copy to copy the inquiry.

> Paste to past the copy.

•

Site Map Title: Sales Orders by Date and Status

•

Records per Page: 10

•

Number Pages: Selected

Records per Page specifies the number of rows to show per page on the inquiry form.
The selected Number Pages check box enables the numbering of pages on the inquiry form.
You can limit the number of rows to show on the inquiry form by specifying this number in the
Select Top box. In this case, the extra rows of the inquiry result will not be shown at all.

6.

Save your changes to the inquiry.

7.

Add the generic inquiry to a workspace in the modern UI as follows:
a.

In the main menu, select Sales Orders.

b.

In the main menu, click configuration menu (three dots in the bottom left corner) and
then click Edit Menu to switch to the Menu Editing mode.

c.

Click Add Menu Item.

d.

In the Select Forms box, type Sales Orders by Date and Status.

e.

Select the check box to the left of the Sales Orders by Date and Status generic inquiry in
the Data Views workspace.

f.

Click Add & Close to add the selected generic inquiry to the workspace and close the
dialog box.

g.

In the Inquiries section, select the check box to the left of the Sales Orders by Date and
Status generic inquiry to add it to the quick menu by default.

h.

Click Exit Edit Menu to save you changes and exit the Menu Editing mode.

Notice that the Sales Orders by Date and Status generic inquiry appeared in the Sales Orders
workspace.
In the classic UI, the Sales Orders by Date and Status generic inquiry is in the same site map location
as the original, because you did not changed its Site Map Location.
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Grouping the Inquiry Data
To group the inquiry data by date and sales order status, do the following:
1.

On the Parameters tab, delete the Customer and OrderStatus parameters. Only the DateFrom
and DateTo parameters should remain, as shown in the screenshot below.

Figure: The Parameters tab with the remained parameters

2.

On the Conditions tab, delete the conditions that use the Customer and OrderStatus
parameters. Only the conditions with the OrderDate and OrderType data fields should remain, as
shown in the screenshot below.

Figure: The inquiry conditions

3.

On the Grouping tab, add two rows with the SOOrder.OrderDate and SOOrder.Status data
fields, as shown in the screenshot below:
You cannot select the attribute fields that defined on the Attributes form (CS205000) as group
conditions.
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Figure: The Grouping tab with the defined grouping conditions

4.

On the Sort Order tab, delete the sorting condition with the Customer.AcctName data field.

5.

On the Results Grid tab, specify the following settings, as shown in the screenshot below:
•

Delete all rows except the rows with the OrderDate, Status, and OrderTotal data fields.

•

Make sure that the Aggregate Function column is visible. If this column is hidden, add
it by clicking
in the left column header. For more information on how to hide or display
columns, see the links in the Related Links section of this topic.

•

Change the row with the OrderTotal data field to show the total amount of sales orders, as
follows:
•

Caption: Total

•

Schema Field: SOOrder.OrderTotal
Schema Field defines the output format of the column values according to the
format of the selected data field.

•
•

Aggregate Function: SUM

Add a new row, and specify the following settings to show the count of sales orders:
•

Object: SOOrder

•

Data Field: <Count>
<Count> returns the number of grouped rows. If you did not group the inquiry data,
this column on the inquiry form would always contain 1 in each row.

•
•

Caption: Sales Orders

Add the next row, and specify the following settings to show the average amount of sales
orders:
•

Object: SOOrder

•

Data Field: =[SOOrder.OrderTotal]
You have to use expression =[SOOrder.OrderTotal] instead of selecting the
OrderTotal data field directly, because you can use a data field for the result grid
once per inquiry. You have already used OrderTotal for the total amount column. If
you select the OrderTotal data field for the average amount column too, the column
will not be shown on the inquiry form.
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You have to specify Object for each row of the Result Grid tab, but the object does
not matter for the calculated rows, which contain expressions in the Data Filed
column. Actually, you can specify any object for such the rows.
•

Caption: Average

•

Aggregate Function: AVG

Figure: The completed Results Grid tab

Aggregate Function defines how the resulting values should be calculated for the grouped
values in the column. If no aggregate function is selected, the following aggregate functions are
applied to the columns that display results on the inquiry form:
•

SUM applies to columns with the numeric data field type. The resulting value in the column
is the sum of the grouped column values.

•

MAX applies to the other columns. The resulting value in the column is the maximum value
of the values in the grouped columns.

The aggregate function must correspond with the type of the field selected in the Data Field
column. Selecting the SUM function for the character data types (such as customer's name, an
address, an email, and similar fields) causes a run-time error.
For the calculated columns, you have to select the appropriate aggregation function manually,
because no one function applies to them by default.

6.

Save your changes to the inquiry.

7.

Preview the inquiry for the date range from 7/1/2015 to 8/15/2015.
Notice that the format of values in the Total column differs from the format of values in the
Average column (see the screenshot below). The values in the Total column are formatted
according to the SOOrder.OrderTotal data field, which you selected in the Schema Field column
on the Results Grid tab of the Generic Inquiry form (SM208000). The values in the Average
column are not formatted at all, because you have not defined any data field in the Schema
Field column according to which the calculated values have to be formatted.
A list of pages is shown in the bottom right corner according to the selected Number Pages
check box. You can navigate a page by clicking its number.
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Figure: Previewing the inquiry

Related Links
Generic Inquiry (Results Grid Tab)
To Hide or Display Columns
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Step 1.12: Exporting the Inquiry
You can export an inquiry as XML. This functionality is useful if you decide to transfer a single inquiry to
another company or application instance.
You can also export the inquiry as a part of customization project. For example, while completing the
course prerequisites, you imported such customization project, which contained the AR-Invoice inquiry.
The customization project is convenient for a set of two and more inquiries, reports, filters and so on.
For a single inquiry, it is easier to export and then import this inquiry as XML.
To export the SO-OpenByCustomer inquiry as XML, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

On the form toolbar, click

> Export as XML to export the inquiry.

The SO-OpenByCustomer.xml file is downloaded. The name of the XML file matches the inquiry
title.
If you were to import this inquiry, on the toolbar of the Generic Inquiry form (SM208000), you
would click

> Import from XML.
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Lesson Summary
In this lesson, you have learned how to create generic inquiries. Below is the summary of the main
steps you should perform to create a generic inquiry:
1.

Investigate the appropriate forms whose data you are going to use in the generic inquiry to
discover the data access classes, their data fields, and relationships between the classes.

2.

Create a new generic inquiry on the Generic Inquiry form (SM208000).

3.

Perform the following steps to configure the inquiry:
a.

Select at least one data access class (table).

b.

Optionally, specify the relationships between the classes.

c.

Optionally, add one or more parameters for the inquiry to allow users to filter the inquiry
data by specifying values of these parameters.

d.

Optionally, specify the inquiry conditions, which determine the data to be retrieved. If you
added any parameters, use the parameters in the conditions.

e.

Optionally, specify sorting conditions for the inquiry data.

f.

Optionally, specify grouping conditions for the inquiry data.

g.

Configure the inquiry results grid.

h.

Add the inquiry to the site map, if necessary.

Now the generic inquiry is ready to use.
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Review Questions
1.

2.

3.

4.

5.

6.

Select only the necessary steps you should perform to configure a new inquiry. Do not select
optional steps.
•

A. Add one or more tables

•

B. Specify the table relationships

•

C. Add the parameters

•

D. Specify the inquiry conditions

•

E. Specify the grouping conditions

•

F. Specify the sorting conditions

•

G. Configure the results grid.

Select all the system fields you can use as the parameters of each inquiry besides the data fields
of the selected tables.
•

A. <CheckBox>

•

B. <ComboBox>

•

C. <DateBox>

•

D. <TextBox>

•

E. <LookupBox>

А column of the inquiry that you have created contains a link. What should you do with the
column on the Results Grid tab to remove this link?
•

A. Clear the Default Navigation check box.

•

B. Clear the Active check box.

•

C. Clear the Navigate To box.

•

D. Clear the Visible check box.

•

E. Select the Default Navigation check box.

Select the aggregation functions that are applied by default to the columns of the result grid of
each inquiry.
•

A. AVG to the numeric columns and MAX to the other

•

B. SUM to the numeric columns and MIN to the other

•

C. COUNT to the numeric columns and MIN to the other

•

D. SUM to the numeric columns and MAX to the other

How can you preview the inquiry you are creating on the Generic Inquiry form (SM208000)?
Select only the necessary steps and do not select optional ones.
•

A. Specify the Site Map Title of the inquiry.

•

B. Specify the Site Map Location of the inquiry.

•

C. Save your changes to the inquiry.

•

D. On the toolbar of the Generic Inquiry form (SM208000), click View Inquiry.

•

E. Find the inquiry on the navigation pane and open it.

Suppose that you have just created an inquiry. Select all the ways you can add an inquiry to the
navigation pane so that users can view the inquiry.
•

A. On the Generic Inquiry form (SM208000), specify the Site Map Title and Site Map
Location for the inquiry.

| Review Questions | 60

7.

•

B. On the Tables tab of the Generic Inquiry form (SM208000), add the PX.SM.SiteMap
class to the inquiry.

•

C. On the toolbar of the Generic Inquiry form (SM208000), click View Inquiry.

•

D. On the Site Map form (SM200520), add the inquiry to the site map.

Suppose that you have been asked to transfer an inquiry to another application instance. Select
all the ways you can do that.
•

A. Manually create the same inquiry in the needed instance.

•

B. Copy the inquiry. Then, in the needed instance, create a new inquiry, specify its title,
and paste the inquiry you have copied.

•

C. Export the inquiry as a part of customization project. Then, in the needed instance,
import this project.

•

D. Save the inquiry as a template. Then, in the needed instance, load this template.

•

E. Export the inquiry as XML file. Then, in the needed instance, import the inquiry from this
file.

Answer Key
1 - A, G; 2 - A, B; 3 - A, C; 4 - D; 5 - C, D; 6 - A, D; 7 - A, C, E.
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Practice Exercise
You have completed Lesson 1: Creating a Generic Inquiry. Now you know how to create and configure a
generic inquiry. Practice doing the following exercise on your own.
In Lesson 1: Creating a Generic Inquiry you have created the Open Sales Orders by Customer inquiry,
which listed sales orders sorted by date and customer.
Your task is to create a copy of this inquiry, and modify this copy named Open Sales Orders by Item so
that it lists inventory items selected on sales orders. For each item, you have to display the item ID,
quantity, unit of measure, item price, and line amount from the sales order. The user should be able to
opt an inventory item to filter the inquiry results. To retrieve the information about inventory items, join
the SOLine class that provides access to the data in the order lines and the InventoryItem class that
provides access to the information about the inventory items, as shown on the diagram below.

Figure: The classes and the relationships between them

We recommend that you complete the exercise on your own and compare your result with the
screenshot below. If you are having difficulties with modifying the inquiry as needed, you can look into
the brief solution steps listed further.

Figure: The modified inquiry that you should do

Modifying the Inquiry
To modify the inquiry, complete the following steps:
1.

On the Generic Inquiry form (SM208000), open the SO-OpenByCustomer inquiry. Copy this
inquiry.

2.

Create a new inquiry, specify its Inquiry Title, as follows: SO-OpenByItem, and save the inquiry.

3.

Paste the previously copied inquiry, and specify the following new Site Map Title: Open Sales
Orders by Item.

4.

Add two classes to the inquiry—that is, PX.Objects.SO.SOLine and PX.Objects.IN.InventoryItem.
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5.

Specify the class relations according to the diagram shown above. Use an inner join and link the
tables by the identity keys.

6.

Add a new optional parameter with the InventoryItem.InventoryCD data field to allow the user
to select an item.

7.

Specify the conditions with the new item parameter, which should be similar to the conditions
with the customer parameter.

8.

Configure the results grid, as follows:

9.

•

Hide the summary order columns: order quantity and order total.

•

Add detailed order columns—that is, the item identity (CD), item name, unit of measure,
quantity, cost, and amount.

Specify the sorting conditions, as follows:
•

Add ascending sorting by order number.

•

Add ascending sorting by inventory item name.

10. Save your changes to the inquiry.
After you complete these steps, preview the inquiry, which should look as shown in the screenshot
above.
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Lesson 2: Configuring an Inquiry as the Entry Point
Sometimes you might need a faster way to access particular information in the system, such as the
contacts of a particular vendor or the customers list. Generally in Acumatica ERP, you can access such
information through the corresponding entry or maintenance form. After you click the magnifier icon
in the appropriate box, the list of records opens in the pop-up window. This sequence of events may
not give you the information you need quickly enough. The entry or maintenance forms are convenient
for entering new data, but once you have entered most data, you may need to view the list of records
instead.
You can create an inquiry form that presents data in a tabular format for any Acumatica ERP entry or
maintenance form (which is called the primary form in this context). Optionally, you can replace the
primary form with the inquiry you have created. Thus, when you click the name of the primary form
in the navigation pane, you will access the form containing the list of records, and after you click the
name of a record in the list, the primary form will open for that record.
During the configuration of the inquiry form, you can set up the form to be accessed in one of the
following ways:
•

You publish the inquiry form as a new form and locate it anywhere on the site map. The user
accesses the inquiry form by clicking the specified name in the navigation pane. You took this
approach in Lesson 1: Creating a Generic Inquiry, publishing the inquiry as a new form.

•

You replace the primary form with the inquiry form. The user accesses the inquiry form by clicking
the name of the primary form in the navigation pane. In this lesson, you will replace a primary
form with an inquiry form.

Replacing a Primary Form with an Inquiry Form
While completing the course prerequisites, you imported and published the customization project that
contains the AR-Invoice inquiry. This inquiry lists all invoices. You will replace the Invoices and Memos
form (AR301000) with the inquiry you have imported. To do that, perform the following steps:
1.

Open the Invoices and Memos form (AR301000; Finance > Accounts Receivable > Work Area >
Enter). Make sure that the primary form opens.

2.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the ARInvoices inquiry, provided for the course, and on the form toolbar, click View Inquiry.
Notice that the values in the Reference Nbr. column are links, because the Default
Navigation check box is selected for this column on the Results Grid tab of the Generic Inquiry
form (SM208000).

Figure: Previewing the AR-Invoices inquiry

3.

Go back to the Generic Inquiry form (SM208000) and open the AR-Invoices inquiry, if it is not
already opened.

4.

On the Entry Point tab, in the Entry Screen box, select Company > Finance > Accounts
Receivable > Work Area > Enter > Invoices and Memos, as shown in the screenshot below.
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Figure: Selecting the entry screen for the inquiry

Notice that the list of available forms does not contain all locations. The list is filtered according
to the classes selected on the Tables tab.
When you select Entry Screen, the system adds this screen to the list of screens on the
Navigation tab and defines navigation parameters for that screen.
5.

On the Entry Point tab, select the Replace Entry Screen with this Inquiry in Menu check
box to replace the primary form with the inquiry form. When you select the check box, the Site
Map Title and Site Map Location boxes in the summary area are filled in automatically.
If you left the Replace Entry Screen with this Inquiry in Menu check box cleared and specify
Site Map Title and Site Map Location manually, the system adds the inquiry (item 2 in the
screenshot below) will be added under the node of the selected site map location (item 1).

Figure: Previewing the inquiry that does not replace the entry screen

6.

Select the Enable New Record Creation check box, as shown in the screenshot below, to allow
users to create new entries from the inquiry form.
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Figure: Configuring the inquiry as the entry point

7.

On the Navigation tab, review the AR301000 - Invoices and Memos screen that the system
added to the list of screens to navigate to when you selected this screen as the entry point.
The Window Mode of the screen that is selected as the entry screen on the Entry Point tab
and replaced with the inquiry is Inline, as shown in the following screenshot. This means that
this screen opens in the same browser tab when a user is adding a new record or viewing the
details of an existing record. You cannot change this mode.

Figure: The entry screen that the system has added to the Navigation tab

8.

Save the inquiry.

9.

Open the Invoices and Memos form (AR301000) again. Make sure that the inquiry form opens.
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Notice that now the values in the Reference Nbr. column are not links although the Default
Navigation check box is still selected for this column on the Results Grid tab of the Generic
Inquiry form (SM208000). If a screen that should be opened by clicking the link in a column is
the primary form that is substituted by the inquiry, the column value is displayed with no link.
You can open such rows by clicking the row and then clicking the Edit action on the inquiry
toolbar or by double-clicking the row.
As a result, you have configured the inquiry form to open instead of the primary form, so users can
initially view invoices data in a tabular format.
Lesson Summary
In this lesson, you have learned how to replace an entry or maintenance form with an inquiry form. To
configure an inquiry as the entry point of a particular screen, on the Entry Point tab of the Generic
Inquiry form (SM208000), you should specify this screen in the Entry Screen box of the inquiry and
select the Replace Entry Screen with this Inquiry in Menu check box. You can also allow users to
create records through such an inquiry directly.
Review Questions
1.

2.

3.

Suppose that you need to replace a primary form with an inquiry. How should you configure this
inquiry on the Generic Inquiry form (SM208000)?
•

A. Specify the Site Map Title, and select the Site Map Location. On the Entry Point
tab, select the Replace Entry Screen with this Inquiry in Menu check box.

•

B. Publish the inquiry in the same node as the primary form.

•

C. On the Entry Point tab, select the Entry Screen and the Replace Entry Screen with
this Inquiry in Menu check box.

•

D. Specify the Site Map Title, and select the Site Map Location. On the Entry Point
tab, select the Entry Screen.

Suppose that you have replaced a primary form with an inquiry. Where will the primary form be
opened if you click a link of one of the items in the table on the inquiry form?
•

A. In a new browser window

•

B. In a new browser tab

•

C. In the same browser tab

•

D. In a pop-up window

What operations you can allow performing from the inquiry form that is configured as the entry
point? Select all the correct statements.
•

A. Creating a new record

•

B. Creating multiple records

•

C. Deleting a record

•

D. Deleting multiple records

•

E. Duplicating a record

•

F. Duplicating multiple records

Answer Key
1 - C; 2 - C; 3 - A, D.
Related Links
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Generic Inquiry (Entry Point Tab, Navigation Tab, Mass Update Fields Tab, Mass Action Tab)
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Lesson 3: Exposing an Inquiry by Using OData
You can expose an inquiry by using the Open Data protocol (OData) so that third-party applications that
support OData can access the data provided by this inquiry.
The Open Data protocol is a general-purpose data access technology that you can use with many
languages and platforms. OData defines an abstract data model and a protocol that can be used to
expose information from any data source. Acumatica ERP supports OData 3.0. For more information on
OData, see the protocol specification in the Related Links section of this topic.
We strongly recommend that you deploy your Acumatica ERP instance (or instances) by using HTTPS, to
pass data safely. For more information, see the links in the Related Links section of this topic.

You can expose a generic inquiry at any time, when you are either creating a new inquiry or modifying
an existing one. In this lesson, you will expose the Open Sales Orders by Customer inquiry you created
in Lesson 1: Creating a Generic Inquiry.
Lesson Objectives
In this lesson, you will learn how to do the following:
1.

Expose a generic inquiry by using OData

2.

Access the exposed generic inquiry through a browser

3.

Access the exposed generic inquiry through an OData client

1. Exposing the Inquiry by Using OData
To expose the inquiry, do the following:
1.

On the Generic Inquiry form (SM208000; System > Customization > Manage), open the SOOpenByCustomer inquiry.

2.

Select the Expose via OData check box.
You can expose only published inquiries, because you can grant access rights to an inquiry only
through the inquiry screen. That means you should specify the Site Map Title and Site Map
Location of any inquiry that you are going to expose. For more information on access rights to
inquiries, see the topics of Part 6: Access Rights to Inquiries, Reports, Dashboards, and Pivot
Tables.

You cannot specify any value for the inquiry parameters when you access this inquiry exposed
through OData. Thus, you have to specify the inquiry conditions that will be used instead of
parameter values.
If you are going to develop an inquiry to expose it through OData, you should specify no
parameters for this inquiry.

3.

On the Conditions tab, perform the following steps, as shown in the screenshot below:
•

Deactivate all the existing conditions except the condition with the SOOrder.OrderType
data field.

•

Add a new row and specify a condition with the following settings:
•

Data Field: SOOrder.Status

•

Condition: Equals

•

From Schema: Selected

•

Value 1: Open

Based on the active conditions, the inquiry lists open sales orders of the SO type.
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Figure: Conditions of the inquiry

4.

Save your changes to the inquiry.

2. Accessing the Exposed Generic Inquiry Through a Browser
You can open the list of the inquiries exposed through OData in your browser. To access this list, you
should enter the following URL in your browser: {InstanceURL}/OData/{CompanyName}. Here,
{InstanceURL} is the URL of your Acumatica ERP application, and {CompanyName} is the login
name of the company for which you configured the inquiry. The login name of the company is the name
you select when you log in to Acumatica ERP. If your application contains only one company, specify the
URL in the following format: {InstanceURL}/OData.
To access the list of exposed inquiries through your browser, do the following:
1.

In your browser, enter the following URL: http://localhost/InstanceName/OData/SalesDemo,
as shown in the screenshot below. Here and in the rest of this lesson, replace localhost/
InstanceName with the actual URL of your application.

2.

When the system asks you to authenticate yourself, provide your login credentials—that is, your
user name (without the company name as follows: admin@SalesDemo) and your password. After
your identity is confirmed, the system will display the list of available inquiries, as shown in the
screenshot below.
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Figure: The list of the exposed inquiries

Even though you can see all exposed inquiries, you can access the data of only the inquiries you
have sufficient access rights to.

You can view the list of fields of the exposed inquiries, as shown in the screenshot below.
To access this list, in your browser, you should enter the following URL: {InstanceURL}/
OData/{CompanyName}/$metadata. If your application contains only one company, omit
{CompanyName} and enter the following: {InstanceURL}/OData/$metadata.
3.

In your browser, enter the following URL to access the list of fields of the exposed inquiries:
http://localhost/InstanceName/OData/SalesDemo/$metadata.

Figure: The list of fields of the exposed inquiries

The field names in the list are changed according to the OData specification. The system generates
the names of the fields for OData entities based on the display names of the Acumatica ERP fields in
invariant culture (that is, the names of the fields in an English locale) as follows:
•

If the display name does not contain any invalid symbols, the name is left unchanged.
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•

If the display name starts with an invalid symbol, an underscore _ symbol is added before
the name. For example, 2Email is converted to _2Email.

•

If the display name contains invalid symbols, these symbols are removed from the name. For
example, Order Nbr. is converted to OrderNbr.

You can access the contents of an exposed inquiry you have sufficient access rights to, as
shown in the screenshot below. To access the inquiry data, in your browser, enter the following
URL : {InstanceURL}/OData/{CompanyName}/{GIName}, where {GIName} is the casesensitive name of the inquiry from the list of exposed inquiries. If your application contains
only one company, omit {CompanyName} and enter the following: {InstanceURL}/OData/
{GIName}.
4.

In your browser, enter the following URL to access the contents of the inquiry: http://
localhost/InstanceName/OData/SalesDemo/SO-OpenByCustomer.

Figure: The data of the exposed inquiry

Acumatica ERP supports JSON and ATOM formats. You can specify a format in the URL by using
the $format option as follows: $format={format}, where {format} can have one of the
following values:
•

json: The data is displayed in JSON format.

•

atom: The data is displayed in ATOM format.

•

jsonverbose: The data is displayed in JSON Verbose format.

By default, the data of an exposed inquiry is displayed in JSON format. However, the default
format in which you get the data of an exposed inquiry also depends on your browser. For
example, in the screenshot above, the data is displayed in the ATOM format by default.
5.

In your browser, enter the following URL to get the inquiry data in JSON format, as shown in the
screenshot below: http://localhost/InstanceName/OData/SalesDemo/SO-OpenByCustomer/?
$format=json.
A question mark starts the list of options in the URL, such as $format, $filter, and
$orderby.
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Figure: The data of the exposed inquiry in the JSON format

You can filter the data of an exposed inquiry. You cannot specify inquiry parameters through
OData, but you can directly filter the data you have accessed.
As an example, you will filter the data of the SO-OpenByCustomer inquiry by customer and
amount to get the sales orders of the USA Bartending School customer (identifier ABARTENDE)
with an amount that is greater than or equal to 12,000.
6.

In your browser, enter the following URL to filter the inquiry data: http://localhost/
InstanceName/OData/SalesDemo/SO-OpenByCustomer/?$format=json&$filter=CustomerID
eq 'ABARTENDE' and SalesOrderTotal ge 12000.
The filtering condition in this URL is $filter=CustomerID eq 'ABARTENDE' and
SalesOrderTotal ge 12000. The $filter option starts the filtering conditions, eq is the
equal operator, and ge is the greater than or equal operator. The and operator joins multiple
conditions in the filter. The & character is used to join multiple URL options, such as $format,
$filter, and $orderby. For more information on OData options and operators, see the
protocol specification in the Related Links section of this topic.

3. Accessing the Exposed Generic Inquiry Through an OData Client
You can access the data of an exposed inquiry by using third-party OData clients, such as Microsoft
Excel and Microsoft Power BI.
In this lesson, the instructions assume that Microsoft Excel 2013 is being used. The details of this
procedure may differ for other versions of Excel.
Microsoft Excel 2007 and earlier versions do not support connecting to OData feed.

To access the inquiry data through Excel, do the following:
1.

Open an Excel workbook.

2.

On the Data ribbon tab, click From Other Sources > From OData Feed. The Data
Connection Wizard opens.

3.

On the Connect to a Data Feed page of the wizard, specify the following settings, as shown in
the screenshot below:
•

Link or File: http://localhost/InstanceName/OData/SalesDemo
The location of the data feed is in the following format: {InstanceURL}/OData/
{CompanyName}. Here, {InstanceURL} is the URL of your Acumatica ERP application,
and {CompanyName} is the company name for which you configured the inquiry. The
company name matches the name you select when you log in to Acumatica ERP.

•

User Name: admin

•

Password: The password you defined for this user name
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Figure: OData connection credentials

4.

Click Next. Excel connects to the Acumatica ERP instance.
The Select Tables page of the wizard, which opens, shows the list of exposed generic inquiries
that are available for you.

5.

Select the SO-OpenByCustomer inquiry, as shown in the screenshot below.

Figure: Exposed inquiry to connect

You can select multiple inquiries, if needed.

6.

Click Next.

7.

In the Save Data Connection File and Finish box, enter a name and description for your data
connection file and click Finish.

8.

On the Import Data page, specify the way you want to see the data and click OK.
The system connects to the application, downloads the data from your Acumatica ERP instance,
and presents the data in the way you selected, as shown in the screenshot below.
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Figure: The data of the exposed inquiry

The sorting order in the resulting Excel file may differ from the sorting order in Acumatica ERP,
because Excel applies sorting after the data is downloaded.
In the Data ribbon tab, you can click Refresh All to update the data.
You can do what you want with the imported data—for example, remove the columns you do not
want to see, or add information from other data sources in separate sheets. When you refresh
the data, the structure of the file is not updated.
Using Predefined Exposed Generic Inquiries
Acumatica ERP includes several predefined generic inquiries exposed through OData; the titles of these
inquiries start with BI. Additionally, the BI role has been added to the system; a user with this role
assigned can access the data of the predefined inquiries. For more information on roles, see the links in
the Related Links section of this topic.
Lesson Summary
In this lesson, you have learned how to expose generic inquiries by using the Open Data protocol.
Below is the summary of the steps you should perform on the Generic Inquiry form (SM208000) to
expose an inquiry by using OData:
1.

Add the inquiry to the site map.

2.

Exclude the parameter from the inquiry conditions. In the inquiry that you expose by the OData
protocol, you cannot use parameters in the inquiry conditions.

3.

Select the Expose via OData check box. As soon as you save the inquiry with the check box
selected, the inquiry becomes immediately available to access by OData clients without restart of
the application.

You accessed exposed generic inquiries through a browser or an OData client. Through a browser, you
accessed the following data of exposed inquiries of the particular company by using the appropriate
URLs:
•

{InstanceURL}/OData/{CompanyName}: The list of all the exposed inquiries
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•

{InstanceURL}/OData/{CompanyName}/$metadata: The list of fields of the exposed

•

{InstanceURL}/OData/{CompanyName}/{GIName}: The data of the exposed inquiry with
the {GIName} name

inquiries

Review Questions
1.

2.

3.

What credentials should you provide to access the inquiries exposed through OData?
•

A. You should not provide any login credentials.

•

B. The user name and the password.

•

C. The user name, the password, and the company name.

In the MyCompany company of the http://localhost/InstanceName instance of
Acumatica ERP, you have exposed the AR-Invoices inquiry by using OData. What URL you should
enter in your browser to access the inquiry data?
•

A. http://localhost/InstanceName/OData/MyCompany/ar-invoices

•

B. http://localhost/InstanceName/MyCompany/OData/AR-Invoices

•

C. http://localhost/InstanceName/OData/MyCompany/AR-Invoices

•

D. http://localhost/InstanceName/MyCompany/OData/ar-invoices

Select all the formats in which you can get the data of an exposed inquiry.
•

A. XML and YAML

•

B. XML and JSON

•

C. YAML and ATOM

•

D. ATOM and JSON

•

C. JSON and YAML

Answer Key
1 - B; 2 - C; 3 - D.
Related Links
OData Support
OData Version 3.0 Specification
Setting Up an HTTPS Service in Web Server (IIS)
Managing Authorization by Using Roles
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Part 2: The Report Designer
In this part, you will learn how to create and configure reports using the Report Designer. In particular,
you will learn how to do the following:
•

Create, configure, and publish reports

•

Use subreports

•

Create tabular reports

•

Define additional filters for reports

•

Use images in reports

•

Color certain report data according to some conditions

•

Save a report as a new version

•

Translate reports

•

Define Excel export settings
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Reviewing Acumatica Report Designer
Acumatica Report Designer provides visual tools that you can use to design custom reports. With the
Report Designer, you can select data for a report, calculate required values based on the selected data,
and customize a report layout.
Installation of the Report Designer
You can install Acumatica Report Designer in one of the following ways:
•

As part of Acumatica ERP. In the Acumatica ERP installation wizard, the Install Report
Designer check box is selected by default, as shown in the screenshot below.

Figure: Acumatica ERP installation wizard

If you did not change this setting while you completed the course prerequisites, you have
successfully installed the Report Designer.
•

As a standalone application.
The Report Designer receives all information required for a report from the Acumatica ERP
application server. If you install the Report Designer as a standalone application, you do not need
to install Acumatica ERP locally to change or develop a report; instead, you can just connect to a
remote server by using an appropriate URL.

Report Designer User Interface
To open the Report Designer, navigate as follows: Start > All Programs > Acumatica > Report
Designer. This opens the main window, shown in the following screenshot.
If you install the Report Designer as a standalone application, you should navigate as follows: Start > All
Programs > Acumatica > Standalone Report Designer > Report Designer.
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Figure: Report Designer main window

The main window of Acumatica Report Designer includes three areas:
•

The left Design area (item 1 in the screenshot above) displays the report layout.

•

The top right area (item 2) provides access to the elements and tools that you can use to design a
report layout and add a report content.

•

The bottom right area (item 3) includes the following tabs:
•

Properties: Displays the properties of a report element selected in the Design area.

•

Fields: Lists all fields of the data access classes selected as the source of data for a report.

For more information on the Report Designer, see the topics in this part as well as the online product
documentation supplied with Acumatica ERP (Help > Acumatica Framework > Report Designer).
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Creating New Reports and Opening Existing Ones
You can create new reports or modify existing reports by using Acumatica Report Designer, as
described below.
Creating a New Report
To create a new report, on the menu bar, select File > New.
You can also create a new report by clicking the

button on the main window toolbar.

Then, you should perform the following main steps, which are described in greater detail in Lesson 4:
Creating a Report:
1.

In the Schema Builder wizard, do the following to select the data for the report:
a.

Load the database schema and select the data classes.

b.

Optionally, specify the relationships between the classes.

c.

Optionally, add one or more parameters for the report, to allow users to filter the report
data by specifying values of these parameters.

d.

Optionally, specify the filtering conditions, which determine the data to be retrieved.

2.

Optionally, specify grouping conditions for the report data.

3.

Optionally, specify sorting conditions for the data of the detail section.

4.

Lay out the report—that is, add to the report layout some visual elements, configure these
elements, specify visibility of the report sections and elements, and so on.

5.

Add the URL of the report to the site map.

Modifying an Existing Report
To modify an existing report, you can open the locally stored file or load the file from the Acumatica ERP
website:
•

To open a locally stored file, on the menu bar, select File > Open, and then select the report file
you want to modify. The reports are in the /Site/ReportsDefault/ folder by default.
You can also open a locally stored file by clicking the

•

button on the main window toolbar.

To open a report file located on the Acumatica ERP website, do the following:
1.

On the menu bar, select File > Open From Server.

2.

In the Open report from server dialog box, which appears, do the following:
•

Type your Acumatica ERP website URL in the following format: http://{domain},
where you replace {domain} with the actual URL to your application. The URL can be
your local website, as shown in the screenshot below (item 1), or an external URL of
Acumatica ERP. You may also need to replace http with https.

•

Type your login and password (item 2). If your application contains more than one
company, type the appropriate company name with the user login in the following
format: {user login}@{company name}. The company name matches the name
you select when you log in to Acumatica ERP. If your application contains only one
company, specify only the user login.

•

Click the Load reports list button to load a list of available reports from the website
(item 3).
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•

Select a report to load (item 4) and click OK.

Figure: Opening an existing report from the website

You can open a report directly from the corresponding report form in Acumatica ERP, if the
ReportDesigner role is assigned to your user. To do that, click Edit Report on the report form
toolbar, and download the file whose name matches the report name. For example, for the
AR670000.rpx report, the AR670000.rps file is downloaded. This downloaded file contains the
website URL, the user login, and the report name. When you open the downloaded file, the Open
report from server dialog box appears with the website URL, user login, and report name filled in
automatically. You need to type only your password and click OK to open the report in the Report
Designer.

The opened report file is displayed in the Design area of the Report Designer. Once you modify the
report, you can save it locally or to the server.
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Defining Report Parameters
The user can specify values of report parameters before run the report on the Report Parameters tab
of the report form.
You can configure one or more parameters for a report, if necessary, on the Parameters tab of the
Schema Builder wizard of the Report Designer. For each parameter, you can specify the following
settings:
•

Name: The parameter name to be used in the report. Once you apply your changes to the report,
the parameters you added are available in the list of available parameters in the Expression
Editor. The parameters start with the @ symbol, as with @SalesPerson.

•

Data Type: The data type of the parameter. Based on this type, the appropriate form elements
will be shown on the Report Parameters tab of the report.

•

View Name: The data field to retrieve data for the parameter when the user selects its values on
the report form.

•

Prompt: The parameter name to be displayed on the report form. A parameter appears on the
Report Parameters tab of the report form if you specify its Prompt value and select the Visible
check box. Otherwise, the user will not see the parameter.

•

Default Value: The value to be selected by default for the parameter on the Report
Parameters tab of the report form. For example, as the default value of the report parameters
with the date data type, you can specify an exact date or select one of the following date-relative
parameters:
•

@WeekStart and @WeekEnd: The start and the end of the current week

•

@MonthStart and @MonthEnd: The start and the end of the current month

•

@PeriodStart and @PeriodEnd: The start and the end of the current financial period

•

@QuarterStart and @QuarterEnd: The start and the end of the current quarter

•

@YearStart and @YearEnd: The start and the end of the current year

•

@Today: The current day

•

Allow Null: The parameter can have the Null value with this check box selected. For example,
if you want to allow the user to execute the report without specifying a date range, select the
Allow Null check box for the appropriate date parameters. You should select this check box for
all parameters that are optional.

•

Is Required: The user has to provide the parameter to run the report if this check box is selected
and the Default Value is not defined for the parameter.

•

Column Span: The number of columns on the Parameters tab of the report form this parameter
will span.
The report ParamsColumns property specifies the number of columns in which the report
parameters are arranged on the Parameters tab of the report form. For each report parameter, in
the Column Span box, you cannot specify the number greater than the value of ParamsColumns.

•

Available values: The list of parameter values, which is available to the user on the report form
to select the parameter value.
For example, the Invoice/Memo report (ar641000.rpx) has two parameters. The first one is
Document Type, which has the following available values, as shown in the screenshot below.
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Figure: Previewing parameters of the Invoice/Memo report (AR641000)

On the report form, the parameter with the list of predefined values is shown as a combo box.
In the Label column of the Available values area, you define the list of options that the user
can see in the combo box (see the screenshot below). In the Value column, you define the list
of values that are assigned to the parameter if the user selects the corresponding option of the
Label column.

Figure: Selecting Document Type for the Invoice/Memo report (AR641000)

The second parameter of the Invoice/Memo report (ar641000.rpx) is Reference Number. The
following expression is specified as View name of this parameter.

=Report.GetFieldSchema('ARInvoice.RefNbr,DocType')
Similarly, you can use the following expression instead of the previous one:
=[ARInvoice.RefNbr,DocType]. In these expressions, the DocType attribute is the name of
the first report parameter.
Based on these expressions, when the user selects Reference Number on the report form,
the lookup table of invoices appears. In this table, the list of invoices is filtered by the selected
document type.
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If you explore the ARInvoice data access class on the Data Access tab of the Source Code form
(SM204570), you can find the filtering condition of the RefNbr data field (item 1 in the screenshot
below). This condition is used to filter invoices in the lookup table when the user select an invoice.
In the where clause, you can find the optional filtering condition by document type (item 2).

Figure: Exploring the ARInvoice class on the Source Code form (SM204570)

Similarly, in your reports, you can filter by subtype other documents, such as sales orders, if their
reference number has the appropriate filtering condition.
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Modifying a Report Layout
A layout of any newly created report consists of three main sections—the page header section (item 2
in the screenshot below), the page footer section (item 4), and the detail section (item 6).
Within the report, you can add group sections, which can be nested. For each group, you have the
group header (item 3) and the group footer (item 5) sections, and the detail section is always nested
into the innermost group. You can also add the report header (item 1) and report footer (item 7)
sections. All these sections are briefly described below:
•

The detail section is the central part of the report, containing its main data. Unlike other sections,
it cannot be deleted. For example, if your report outlines sales orders, you would put a list of
orders in the detail section.

•

The group header and group footer sections are shown above and below, respectively, each group
of the report data. These sections are a good place for information that applies to all data in
the detail section. For example, if you group sales orders by customer, you could place detailed
information about the customer in the group header section and use the group footer section to
calculate subtotals for the customer.

•

The page header and page footer sections are located at the top and bottom of every page of the
report. The page header and footer sections are the best place for information that the reader
may need when reading every page. For example, you can use the page header to display column
headers of a table that is continued from the previous page. You can use the page footer to
display the number of the current page.

•

The report header and report footer sections are the only types of report sections printed once
per report. The report header is the first section of the report on the first page. It also precedes
the page header, making it the best place to display the report name, the company logo, the date
range of the report, and similar information. The report footer finalizes the informative part of the
report and is placed before the page footer on the last page of the report. It is a good place for
totals or conclusions.

Figure: Sections of a report layout

You can easily add the report header, the report footer, the page header, and the page footer sections
to the report layout or delete them. Just right-click any empty place of the report layout, and select
the appropriate command (item 8 in the screenshot above). If a highlighted icon is shown left of a
command, it indicates that the section is included in the report now.

| Modifying a Report Layout | 85

To add both the group header and the group footer sections, right-click any empty place in the report
layout, and select Add New Group (item 9 in the screenshot above). You can also add the group
header and page footer sections by specifying grouping conditions for the report data. See Step 4.4.1:
Defining the Data Groups for the Report of Lesson 4 for an example of specifying grouping conditions
for a report.
To delete any section except for the detail section, right-click the section header and select Delete, as
shown in the screenshot below.
To duplicate any section, right-click the section header and select Duplicate.

Figure: Deletion of a section

You can represent information of different kinds by using visual elements. In the Report Designer, these
elements are listed in the top right area. You can add them to sections of the report layout by dragging
them to the appropriate place. You can resize an element by dragging its borders.
After a visual element is added on the screen, you can do the following:
•

Define the style of an element, and reset the style if desired.

•

Copy and paste the style between visual elements.

•

Define the order of visual elements on the layout by bringing them to the front or sending them to
the back.

•

Cut, copy, and paste visual elements and their content to other areas within the report.

To perform these actions with a visual element, use the commands available in the Report Designer
toolbar, or right-click the visual element and select the relevant command.
In the lessons of this part, you can find details on configuring the following elements:
•

TextBox in Lesson 4

•

PictureBox in Lesson 8

•

Chart in Lesson 5

•

SubReport in Lesson 5

You can easily revert your changes to the report layout by using Undo command as well as revert the
effect of undone actions by using Redo command.
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Formatting Values to Be Displayed on a Report
You can specify a custom format for the numeric and date values of text boxes on the report layout, to
define how these values should be displayed in the printed report.
To format the value of a text box, you have to enter a format specifier in the Format property of the
text box, as shown in the screenshot below.

Figure: Defining the format of a text box value

You can use the following format specifiers, which are described in greater detail in this topic:
•

Format specifiers of any data fields used in a report

•

Standard numeric format specifiers

•

Custom numeric format specifiers

•

Standard date format specifiers

•

Custom date format specifiers

Standard specifiers are applied according to the language selected when the particular user logged in to
Acumatica ERP, as shown in the screenshot below. If your instance of Acumatica ERP does not allow the
user to select any language, the specifiers are applied using the default language. The default language
of the installed application is English (United States).
In the examples of this topic, if a format specifier depends on the language, this language is shown as
follows: en-US.
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Figure: Selecting a language

A list of the languages available at login is specified on the System Locales form (SM200550; System >
Management > Manage), as shown in the screenshot below.

Figure: Viewing the list of available languages

For more information on locales, see the links in the Related Links section of this topic.
Formatting Values According to the Format of a Data Field
To use a data field as a format specifier for a text box, select the Format property of this text box, and
click the
button to open the Expression Editor dialog box. In the dialog box, select the data field to
use as a format specifier, and add .Format to the end of the data field name inside square brackets,
as shown in the following example: =[ARTran.TranAmt.Format].
Formatting Numeric Values
The following table contains descriptions of standard numeric format specifiers and displays the sample
output produced by each format specifier.
To use standard numeric format specifiers, type a format specifier into the Format property of a text
box, such as N.
Format
specifier

Description

Examples

D or d

Result: Integer digits with an optional
negative sign

1234 (D) –>1234

Supported by: Integral types only
Precision specifier: Minimum number of digits

-1234 (D6) -> -001234

| Formatting Values to Be Displayed on a Report | 88

Format
specifier

Description

Examples

F or f

Result: Integral and decimal digits with an
optional negative sign

1234.567 (F, en-US) -> 1234.57

Supported by: All numeric types
Precision specifier: Number of decimal digits
Default precision specifier: 2
N or n

Result: Integral and decimal digits, group
separators, and a decimal separator with an
optional negative sign
Supported by: All numeric types
Precision specifier: Desired number of
decimal places

1234.567 (F, fr-FR) -> 1234,57
-1234 (F1, en-US) -> -1234.0
-1234.56 (F4, fr-FR) -> -1234,5600

1234.567 (N, en-US) -> 1,234.57
1234.567 (N, ru-RU) -> 1 234,57
1234 (N1, en-US) -> 1,234.0
-1234.56 (N3, en-US) ->
-1,234.560

Default precision specifier: 2
P or P

Result: Number multiplied by 100 and
displayed with a percent symbol
Supported by: All numeric types
Precision specifier: Desired number of
decimal places

1 (P, en-US) -> 100.00 %
1 (P, fr-FR) -> 100,00 %
-0.39678 (P1, en-US) -> -39.7 %
-0.39678 (P3, fr-FR) -> -39,678 %

Default precision specifier: 2
The following table contains descriptions of custom numeric format specifiers and displays the sample
output produced by each format specifier.
You can combine custom numeric format specifiers, as shown in the following example: #,#.00.
Format
specifier

Description

Examples

0

Replaces the 0 symbol with the
corresponding digit if one is present;
otherwise, 0 appears in the result string.

1234.5678 (00000) -> 01235

Replaces the # symbol with the
corresponding digit if one is present;
otherwise, no digit appears in the result
string.

1234.5678 (#####) -> 1235

Determines the location of the decimal
separator in the result string.

0.45678 (0.00, en-US) -> 0.46

Inserts a localized group separator character
between each group.

1234567 (#,##, en-US) ->
1,234,567

#

.

,

0.45678 (0.00, en-US) -> 0.46
0.45678 (0.00, fr-FR) -> 0,46

0.45678 (#.##, en-US) -> .46
0.45678 (#.##, fr-FR) -> ,46

.45 (0.0000, fr-FR) -> 0,4500

1234567 (#,##, fr-FR) ->
1.234.567
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For more information on formatting numeric values, see the documentation about custom numeric
format strings in .NET Framework.
Formatting Date Values
The following table contains descriptions of standard date format specifiers and displays the sample
output produced by each format specifier.
To use standard date format specifiers, type the format specifier into the Format property of a text
box, such as d.
Format
specifier

Description

Examples (en-US)

d

Short date pattern

2009-06-15T13:45:30 -> 6/15/2009

D

Long date pattern

2009-06-15T13:45:30 -> Monday, June 15, 2009

f

Full date/time pattern (short
time)

2009-06-15T13:45:30 -> Monday, June 15, 2009
1:45 PM

F

Full date/time pattern (long
time)

2009-06-15T13:45:30 -> Monday, June 15, 2009
1:45:30 PM

g

General date/time pattern
(short time)

2009-06-15T13:45:30 -> 6/15/2009 1:45 PM

G

General date/time pattern
(long time)

2009-06-15T13:45:30 -> 6/15/2009 1:45:30 PM

M or m

Month/day pattern

2009-06-15T13:45:30 -> June 15

t

Short time pattern

2009-06-15T13:45:30 -> 1:45 PM

T

Long time pattern

2009-06-15T13:45:30 -> 1:45:30 PM

Y or y

Year month pattern

2009-06-15T13:45:30 -> June, 2009

The following table contains descriptions of custom date format specifiers and displays the sample
output produced by each format specifier.
You can combine custom numeric format specifiers, as shown in the following example: dddd/MMMM/
yyyy hhtt:mm.
Format
specifier

Description

Examples (en-US)

d

The day of the month, from 1 2009-06-01T13:45:30 -> 1
through 31
2009-06-15T13:45:30 -> 15

dd

The day of the month, from
01 through 31

2009-06-01T13:45:30 -> 01

ddd

The abbreviated name of the
day of the week

2009-06-15T13:45:30 -> Mon

dddd

The full name of the day of
the week

2009-06-15T13:45:30 -> Monday

h

The hour (from 1 to 12),
using a 12-hour clock

2009-06-15T01:45:30 -> 1

2009-06-15T13:45:30 -> 15

2009-06-15T13:45:30 -> 1
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Format
specifier

Description

Examples (en-US)

hh

The hour (from 01 to 12),
using a 12-hour clock

2009-06-15T01:45:30 -> 01

The hour (from 0 to 23),
using a 24-hour clock

2009-06-15T01:45:30 -> 1

The hour (from 00 to 23),
using a 24-hour clock

2009-06-15T01:45:30 -> 01

The minute (from 0 through
59)

2009-06-15T01:09:30 -> 9

The minute (from 00 through
59)

2009-06-15T01:09:30 -> 09

M

The month (from 1 through
12)

2009-06-15T13:45:30 -> 6

MM

The month (from 01 through
12)

2009-06-15T13:45:30 -> 06

MMM

The abbreviated name of the
month

2009-06-15T13:45:30 -> Jun

MMMM

The full name of the month

2009-06-15T13:45:30 -> June

s

The second (from 0 through
59)

2009-06-15T13:45:09 -> 9

ss

The second (from 00 through
59)

2009-06-15T13:45:09 -> 09

t

The first character of the AM/ 2009-06-15T13:45:30 -> P
PM designator

tt

The AM/PM designator

2009-06-15T13:45:30 -> PM

yy

The year (from 00 to 99)

1900-01-01T00:00:00 -> 00

H

HH

m

mm

2009-06-15T13:45:30 -> 01

2009-06-15T13:45:30 -> 13

2009-06-15T13:45:30 -> 13

2009-06-15T13:29:30 -> 29

2009-06-15T01:45:30 -> 45

2019-06-15T13:45:30 -> 19
The year as a four-digit
number

1900-01-01T00:00:00 -> 1900

/

The time separator

2009-06-15T13:45:30 (yyyy/mm/dd) ->
2009/06/15

:

The date separator

2009-06-15T13:45:30 (hh:mm:ss) -> 13:45:30

yyyy

2009-06-15T13:45:30 -> 2009

For more information on formatting date values, see the documentation about custom date and time
format strings in .NET Framework.
Related Links
Locale Preferences
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To Add a New Locale
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Using the Expression Editor
You can use expressions to define values to be displayed in a report, or to set report properties, such as
group conditions and the visibility of sections or elements of the report.
To help you define expressions, the Report Designer provides the Expression Editor dialog box, which
consists of four areas, as shown in the following screenshot:
•

The left area of the dialog box (item 1) displays a list of classes and their fields defined for the
report.

•

The middle area of the dialog box (item 2) lists groups of parameters, operators, functions, and
variables.

•

The right area of the dialog box (item 3) contains the parameters, operators, functions, or
variables in the group you select in the middle area.

•

You use the bottom area of the dialog box (item 4) to compose and edit the expression. You can
double click data fields listed in the left area and items listed in the right area to add them to the
bottom area.

Figure: Expression Editor

To enter an expression by using the Expression Editor dialog box, do the following:
1.

In the bottom area, click where you want to add an item.

2.

In the middle area, expand the hierarchical structure of existing entities, and click a group of
parameters, variables, operators, or functions to display the list of available items in the right
area.

3.

In the right area, double-click the item you want to insert in the bottom area.

4.

In the left area, expand the hierarchical structure of classes defined for the report, and doubleclick a data field to insert it in the bottom area.
You can add as many items and fields in the bottom area as you need. You can use the added
items and fields to edit the expression.

5.

To validate the expression, click the Validate button in the lower left.
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6.

Click OK to save the expression or Cancel to discard your changes.

For more information on using the Expression Editor, see the online product documentation supplied
with Acumatica ERP (Help > Acumatica Framework > Report Designer > Using Expressions).
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Saving Reports
Once you create or modify a report by using Acumatica Report Designer, you can save it locally or on
an Acumatica ERP website.
By default, the opened report file is saved to the place from which it was opened. To save the opened
report quickly, perform one of the following steps:
•

On the menu bar, select File > Save

•

On the main window toolbar, click the

button .

If you perform either of these steps to save a new report, the report will be saved locally, and you will
have to specify the report name and a folder to save the report. We recommend that you save your
reports in the /Site/ReportsCustomized/ folder, especially if you customize existing reports.
The website engine searches sequentially for reports and style template files in the following places:
1.

The server

2.

The /Site/ReportsCustomized/ folder

3.

The /Site/ReportsDefault/ folder

You can choose where to save the report. When you are saving a new report, or when you are not sure
where the opened report was originally saved, do the following:
•

To save the report locally, on the menu bar, select File > Save as, and select the folder in which
you want to save the report. If you save a new report, you have to specify its name.
You can also save the report locally by clicking the
Report Designer.

•

button on the main window toolbar of the

To save the report on an Acumatica ERP website, do the following:
1.

On the menu bar, select File > Save to Server. The Save report on server dialog box
appears.

2.

In the dialog box, type your Acumatica ERP website URL (item 1 in the screenshot below)
and your login and password (item 2).
If your application contains more than one company, you have to type an appropriate
company name with the user login in the following format: {user login}@{company
name}. The company name is the name you select when you log in to Acumatica ERP.

3.

In the Enter report name to save box, specify the report name, if necessary.
This box holds the name of the opened report. If you are saving a new report, the box is
empty. You can type a new name for the report, or you can select an existing report to
replace it with the new one. If you were to select an existing report, you could click the
Load reports list button to load a list of available reports from the website (item 3).

4.

Click OK to save the report.

Figure: Saving a report to a server
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After you have saved your report to the server of an instance or locally, you can use this report for any
company of this instance.
You can save your report to an Acumatica ERP website as a new version, by selecting the Save as new
version check box in the Save report on server dialog box. You can find details on saving a report as
a new version in Lesson 9.
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Running a Report
You can run the report you have created after you publish this report, which entails adding the URL of
the report to the site map in Acumatica ERP. You can find details on publishing a report in Step 4.6:
Publishing and Previewing the Report of Lesson 4.
On the Report Parameters tab of the form of a published report, you can opt to specify the report
parameters before running the report. To execute the report, on the report form toolbar, you should
click Run Report. To return to the report form, you can click the

button on the report toolbar.

From the executed report, you can do the following by clicking appropriate commands in the report
toolbar: print the report, send it via email, and export to Excel or PDF.
You can also do the following with a published report:
•

1. Edit a report

•

2. Save a set of report parameters and settings as a template

•

3. Filter and sort report data

•

4. Define report print settings

•

5. Define the email settings of a report

•

6. Schedule a report

•

7. Use different versions of a report

1. Editing a Report
Once you have published a report saved to the server, you can edit the report by using its report
form, if the ReportDesigner role is assigned to your user. To do that, on the report form toolbar, click
Edit Report and download the file. The file name matches the report name; for example, for the
AR670000.rpx report, the AR670000.rps file is downloaded. This downloaded file contains a website
URL, a user login, and the report name. Open the downloaded file, and the Open report from server
dialog box appears. In the dialog box, the website URL, the user login, and the report name are filled
in automatically. You need to type only your password and click OK to open the report in the Report
Designer.
After you change and save the report, you should reload the report form in Acumatica ERP to get the
changes.
2. Saving a Set of Report Parameters and Settings as a Template
You can save as a template a set of report parameters, additional sorting and filtering conditions, and
print and email settings. To do that, specify the appropriate parameters and settings, and click Save
Template on the report form toolbar. The Enter Template Name dialog box appears. In this dialog
box, specify the template name and click OK. Now you can select this template in the Template box
on the report form to apply this set of parameters and settings to the report. You can change any
parameter or setting of the selected template before running the report.
You can set any template as the default template of a report. When you open the report, the default
template will be applied automatically. To set a template as the default, in the Template box on the
report form, select the template, select the Default check box, and save the template. Only one
template can be assigned as the default for the report. When you save a template as the default, the
Default check box of any previous default template is cleared.
When you save a new template with the cleared Shared check box, the template is saved for the
current user only. To share this template with other users, in the Template box on the report form,
select the template, select the Shared check box, and save the template.
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3. Filtering and Sorting Report Data
On the Additional Sort & Filters tab, you can define additional filtering and sorting conditions to apply
to report data. If needed, you can save these conditions as a template. You can find more information
on this functionality in Lesson 7: Defining Additional Filters for Reports.
4. Defining Report Print Settings
In the Print Settings area of the Print and Email Settings tab of the report form, you can define the
print settings of the report. These settings will be applied when you run the report. You can save these
settings as a template.
By default, each executed report is represented in HTML. Also, only one of its pages is shown on the
form at a time. You can change pages by clicking the arrow buttons on the report toolbar, as shown in
the screenshot below (item 1).

Figure: A report executed with the default print settings

You can view all pages of the executed report at a time. To do that, before you run the report, on the
Print and Email Settings tab of the report form, select the Print All Pages check box.
You can view the executed report as a PDF at any time by clicking the PDF button on the report toolbar
(item 2 in the screenshot above). You can also generate any report as a PDF by default. To do that, on
the Print and Email Settings tab of the report form, select the Print in PDF format check box. In
the PDF version, all pages of the executed report are shown at a time regardless of whether the Print
All Pages check box is selected. You can switch the report back to the HTML version at any time by
clicking the

button on the report toolbar, as shown in the screenshot below.

Figure: A report printed in PDF
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By default, because the Compress PDF file and Embed fonts in PDF file check boxes are selected,
the generated PDF is compressed with embedded fonts. These settings are also applied when you
export the report to a PDF file.
You can also define the visibility of the data deleted from the database in a report by selecting one of
the following values in the Deleted Records combo box:
•

Hide: Hide the deleted data (default setting)

•

Print: Print the deleted data

•

Only: Print only the deleted data

5. Defining the Email Settings of a Report
In the Email Settings area of the Print and Email Settings tab of the report form, you can define
email settings of a report, if you plan to email it. These settings will be applied when you click Send
on the executed report form toolbar, or when the report is sent according to a schedule. You can save
these settings as a template.
You can define the following email settings:
•

Format: The report format (HTML, PDF, or Excel).

•

Email Account: The recipient's email address. The value entered in this box is inserted in the To
box of the email, which is a required email parameter (see the screenshot below). You can specify
multiple email addresses separated by commas or semicolons.

•

CC: The additional address to receive a carbon copy (CC) of the email. You can specify multiple
email addresses separated by commas or semicolons.

•

BCC: The email address to receive a blind carbon copy (BCC) of the email; the address entered in
this box is hidden from the other recipients. You can specify multiple email addresses separated
by commas or semicolons.

•

Subject: The subject of the email. The Subject is a required parameter of the email.

Figure: An email to send a report

You can specify the email settings for a report in the Report Designer. These settings are used instead
of any email settings defined for the report in Acumatica ERP.
To specify the email settings in the Report Designer, open the report, select the report form, and define
the following settings in the MailSettings property group:
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•

ActivitySource: The particular activity to include in the email.

•

Bcc: The email address to receive a blind carbon copy of the email. You can specify multiple email
addresses separated by commas or semicolons.

•

Body: The body of the email.

•

Cc: The additional address to receive a carbon copy of the email. You can specify multiple email
addresses separated by commas or semicolons.

•

Format: The report format (HTML, PDF, or Excel).

•

ParentSource: The particular activity of a business account to include in the email.
You can specify only a business account, such as a customer or a vendor, as the parent source.

•

Subject: The subject of the email.

•

TemplateID: A notification template to use for the email. You can manage existing templates
and create new ones on the Notification Templates form (SM204003; Configuration > Email >
Manage).
In the TemplateID property, you can enter the notification identifier (see the screenshot below).

Figure: A notification template

If the same property is defined in the MailSettings group of the report and in the selected
template, the report property will be used instead of the template property. For example, the
subject, body, and notification template are defined for a report: . In the selected notification
template, the recipient’s email, subject and email body are defined. If you email this report, the
system will get the subject and the email body from the report properties and the recipient’s
email from the notification template.
•

To: The recipient’s email address. You can specify multiple email addresses separated by commas
or semicolons.

For example, the Invoice/Memo report (ar641000.rpx) has the following ActivitySource:
ARInvoice.NoteID (see the screenshot below).
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Figure: Email settings of the Invoice/Memo report (AR641000)

Based on this setting, if the user emails an invoice, the appropriate activity will be added to this invoice,
as shown in the screenshot below.

Figure: An activity created for an invoice after sending an email

ParentSource of the Invoice/Memo report (ar641000.rpx) is Customer.NoteID. Based on this
setting, if the user emails an invoice, the appropriate activity will be added to the customer of the
invoice, as shown in the screenshot below.

Figure: An activity created for a customer after sending an email

6.
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Scheduling a Report
You can schedule report processing to email a report if the Scheduled Processing feature is enabled on
the Enable/Disable Features form (CS100000; Configuration > Common Settings > Licensing).
To schedule a report, on the report form, select a template, which contains a set of report parameters
and email settings, and click Schedule Template on the report form toolbar. The Select Schedule
Name dialog box opens, as shown in the screenshot below. In this dialog box, you should select an
existing schedule and click OK. The report results will be sent on the date and time specified in the
selected schedule to the recipients specified in the report template.
If not a single schedule exists in the system, in the Select Schedule Name dialog box, you have to
select <Setup a schedule first> to create a new schedule.

Figure: The Select Schedule Name dialog box

You can manage schedules on the Automation Schedules form (SM205020; System > Automation >
Manage), as shown in the screenshot below. For each schedule, you have to specify the description,
execution dates, and hours for the schedule.

Figure: A schedule
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To delete a report template from all schedules, on the report form, select the template and click
Schedule Template on the report form toolbar. In the Select Schedule Name dialog box, select
<Remove from schedule> from the drop-down list and click OK.
For more information on schedule processing, see the links in the Related Links section of this topic.
6. Using Different Versions of a Report
You can save the report you are editing as a new version. On the Report Versions tab of the report
form, the user can find report versions and select one of them to execute. You can find information on
using report versions in Lesson 9.
Related Links
Report Form
Schedule Processing
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Lesson 4: Creating a Report
In this lesson, you will create the Invoices Commissionable by Salesperson report, which lists
salespersons' commissions estimated from the commissionable amounts of released invoices. These
commissions are listed on the Salesperson Commissions tab of the Invoices and Memos form
(AR301000). An invoice is included if it meets the following criteria:
•

Its status is Open or Closed, both of which reflect that the invoice is released.

•

The type of the invoice is INV (Invoice).

•

The date of the invoice falls within the date range, if the user has specified one on the report
form.

•

The invoice lists the salesperson, if the user has specified one on the report form.

In the report, the invoices will be grouped by salesperson and sorted by date.
In this lesson, you will go through the whole process of creating this report.
We also recommend that you complete the practice exercise at the end of the lesson.
Lesson Objectives
In this lesson, you will learn how to do the following:
•

Select tables for a report

•

Specify relations between tables

•

Configure report parameters

•

Filter report data

•

Group report data

•

Declare and use variables

•

Configure the report layout

•

Define report settings to export to Excel

•

Publish and execute a report
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Step 4.1: Creating the Report
To create a new report, start the Report Designer as follows: Start > All Programs > Acumatica >
Report Designer. You have opened the Report Designer for the first time, so the blank report form is
displayed by default.
The layout of the created report consists of three main sections—the page header section, the detail
section, and the page footer section—as shown in the screenshot below.

Figure: The created report

Next, you will save the report you created.
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Step 4.2: Saving the Report
Save the created report to your server as follows:
1.

On the menu bar of the Report Designer, select File > Save to Server. The Save report on
server dialog box appears, as shown in the screenshot below.

2.

In the dialog box, specify the following settings:
•

Enter Web service URL to load reports list: The application URL, for example: http://
localhost/InstanceName

•

Login: admin
If your application contains more than one company, type the company name with the user
login as follows: admin@SalesDemo.

3.

•

Password: The password you defined for this login

•

Enter report name to save: AR670000.rpx

Click OK to save the report.

Figure: Saving the report to the server

Now you will select the data for the report.
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Step 4.3: Selecting the Data for the Report
You have to define the rules the system uses to select the necessary data to be displayed in the report.
This data is retrieved from the system database through the appropriate data access classes.
In Acumatica ERP, explore the Invoices and Memos form (AR301000; Finance > Accounts Receivable
> Work Area > Enter) to recognize the classes that provide access to the necessary data. For more
information, see the Data Access Overview topic. During this exploration, you can find the following
classes, as shown in the diagram below:
•

The Customer class provides access to the information about the customers associated with the
invoices.

•

The ARInvoice class provides access to the invoices. The CustomerID field of the ARInvoice class
is the reference to the customer record.

•

The ARSalesPerTran class provides access to the salespersons' commissions. The RefNbr and
DocType fields of the ARSalesPerTran class are the references to the appropriate documents,
including the invoices.
The SalesPersonID field of the ARSalesPerTran class is the reference to the salesperson record.
While you are investigating the Salesperson Commission tab of the Invoices and Memos form
(AR301000), notice that the appropriate data fields of Commission Amt. and Commissionable
Amount are CuryCommnAmt and CuryCommnblAmt, respectively. These data fields provide
access to commission amounts calculated in the currency of the document.
Every amount field in an Accounts Receivable and Accounts Payable document is stored in
two currencies: the document currency and the base currency. Fields that store the amount in
different currencies are usually distinguished by the Cury prefix. Cury means that the field stores
the amount in the currency of the document. Therefore, for the commission amount, there are
two fields in the ARSalesPerTran class: CommnAmt and CuryCommnAmt.
In this lesson, you will prepare the report in the base currency. Therefore, you will use the
CommnAmt field to retrieve the commission amount in the base currency for the report, and the
CommnblAmt field to retrieve the commissionable amount in the base currency.

•

The SalesPerson class provides access to the salesperson the commissions were calculated to.

Figure: The classes and the relationships between them

In your reports, you can use the attribute fields of classes that are defined on the Attributes form
(CS205000; Configuration > Common Settings > Common Settings). You can use these fields to filter
report data, or to represent their values in the report.

To define the data to be selected from the database, the Report Designer provides the Schema Builder
wizard. By using this wizard, you will perform the following tasks:
•

Loading the database schema and selecting the classes

•

Specifying the relationships between the classes

•

Defining the report parameters

•

Filtering the report data
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Step 4.3.1: Loading the Database Schema and Selecting the
Tables
To add to the report the classes you explored, you have to do the following:
1.

Load the database schema

2.

Select the tables for the report

1. Loading the Database Schema
You can load the database schema of all available classes from the application server you use to work
with Acumatica ERP. To connect to the application server, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the menu bar, select File > Build Schema. The Schema Builder wizard appears.

3.

On the Tables tab of the Schema Builder wizard, do the following:
•

Type the connection string (item 1, in the screenshot below) in the following format:
http://{domain}, where you replace {domain} with the actual URL to your
application.

•

Type your Login and Password (item 2). If your application contains more than one
company, type the appropriate company name with the user login in the following format:
{user login}@{company name}. The company name is the name you select when you
log in to Acumatica ERP.
Acumatica Report Designer receives all information required for each report from the
Acumatica ERP application server. You do not need to install Acumatica ERP locally to develop
any report; instead, you can just connect to a remote server by using an appropriate URL.

•

Click the Load schema button (item 3). The Report Designer connects to the application
server and loads the schema. When the schema is retrieved, the list of all data access
classes defined in your application appears (item 4).
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Figure: Loading the schema of the data access classes

2. Selecting the Tables for the Report
When you load the database schema, you can select the classes you found for the report. On the
Tables tab of the Schema Builder wizard, do the following (see the screenshot below):
1.

In the list of available data access classes (item 1), select Customer (PX.Objects.AR.Customeer).

2.

Click the

3.

Repeat Steps 1 and 2 for each of the following classes:

button (item 2) to move the class into the list of selected classes (item 3).

•

ARInvoice (PX.Objects.AR.ARInvoice)

•

ARSalesPerTran

•

SalesPerson
To remove a class from the list of selected classes (item 3), select the class by name and click the
button. To remove all the classes from the list of selected classes, click the

4.

button.

Click the Apply button to apply your changes to the report (item 4). You have to apply your
changes to be able to use these changes further.
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Figure: Selecting the data access classes

You have selected the tables for the report. In the next step, you will specify the relationships between
the tables.

Step 4.3.2: Specifying the Relationships Between the Tables
In the Schema Builder wizard, you specify the relationships between the classes so that the system
can generate a query. In the Enter the report table relations here area of the Relationships tab,
you specify the relationships between a pair of tables. In the Enter the data field links for the active
relation area of this tab, for each pair of related tables, you specify the links between them. To specify
the relationships, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the menu bar, select File > Build Schema. The Schema Builder wizard appears.

3.

On the Relationships tab of the Schema Builder wizard, add the lines with the following
settings to link the ARSalesPerTran and ARInvoice classes:
•

•

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARSalesPerTran

Inner

ARInvoice

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

RefNbr

Equal

RefNbr

DocType

Equal

DocType

In the Enter the report table relations here area, you select the classes to be linked.
In the Enter the data field links for the active relation area, you link the classes of the row
selected in the Enter the report table relations here area, as shown in the screenshot below.
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To add the first row to the Enter the data field links for the active relationarea, you click
anywhere in the area, and the empty row appears.
•

If you need to delete any class relationships and data field links, you can click the relevant
row in the area, and press Delete. If you delete a row in the Enter the report table
relations here area, the appropriate rows in the Enter the data field links for the active
relation area are deleted automatically.

•

In the Enter the data field links for the active relation area, you can use formulas in
the Parent Filed and Child Field columns of a particular row by clicking the row and then
clicking the Parent Formula and Child Formula buttons respectively. You can find an
example of using formulas in these columns in Lesson 8: Using Images and QR Codes

.
4.

Add the lines with the following settings to link the ARInvoice and Customer classes:
•

•

5.

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARInvoice

Inner

Customer

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

CustomerID

Equal

BAccountID

Add the lines with the following settings to link the ARSalesPerTran and SalesPerson classes:
•

•

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARSalesPerTran

Inner

SalesPerson

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

SalesPersonID

Equal

SalesPersonID

Figure: Configuring the classes relationships

6.

Apply your changes to the report.

You have specified the relationships between the tables. In the next step you will define the report
parameters.
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Step 4.3.3: Defining the Report Parameters
You can specify parameters for the report you are creating. The user will be able to define the values
for the parameters before run the report. For this report, the user can specify the date range and the
salesperson. To configure these parameters, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the menu bar, select File > Build Schema. The Schema Builder wizard appears.

3.

On the Parameters tab of the Schema Builder wizard, click Add to add three parameters with
the following settings to the parameters list:
•

•

•

The settings of the first parameter are the following:
•

Name: DateFrom

•

Data Type: DateTime

•

Prompt: Date From

•

Default Value: =[@QuarterStart]

•

Allow Null: Selected

The settings of the second parameter are the following:
•

Name: DateTo

•

Data Type: DateTime

•

Prompt: Date To

•

Default Value: =[@QuarterEnd]

•

Allow Null: Selected

The settings of the third parameter are the following:
•

Name: SalesPerson

•

View Name: =[SalesPerson.SalesPersonCD]

•

Prompt: Salesperson

•

Allow Null: Selected

Based on the DateTime data type that you have selected for the Date From and Date To
parameters, the calendar dialog box will open when the user selects their values on the report
form. Based on the default values that you have selected for these parameters—that is,
@QuarterStart and @QuarterEnd, the report shows salespersons' commissions for the current
quarter by default.
Based on the key field you have selected as the View Name of the Salesperson parameter, a
user can select a salesperson in the appropriate lookup table on the report form.
You can select a value or specify an expression in the View Name or Default Value in the
Expression Editor, which you can open by clicking the

button at the right of the boxes.

Based on the selection of the Allow Null check box for all the parameters, a user can execute
the report without specifying a date range and a salesperson.
For all the parameter that you have added, you left the Visible check box selected, which is its
default value, because with the cleared check box the parameters will not appear on the Report
Parameters tab of the report form.
Once you apply your changes to the report, the parameters you added are available in the list
of parameters in the Expression Editor. The parameter names start with the @ symbol, as with
@SalesPerson.
If you were to delete a parameter, you would select it in the parameters list, and click Remove.

| Step 4.3.4: Filtering the Report Data | 112

Figure: Adding the parameters of the report

4.

Apply your changes to the report.

For more information on report parameters, see the Defining Report Parameters topic of this course.
You have defined the report parameters. In the next step you will specify the filtering conditions for the
report.

Step 4.3.4: Filtering the Report Data
For the report you are designing, you also have to specify the filtering conditions, which determine the
data to be retrieved.
The report is being designed to show salespersons' commissions for released invoices. Optionally, the
user can specify the date range of the invoices to be included in the report. The user can also select a
salesperson to view the commissions for only that salesperson.
Based on these specifications, you can specify the following conditions for each commission to be listed:
•

If the user has selected a date in the Date From box, the invoice date must be greater than or
equal to the DateFrom parameter value—that is, after or the same as the specified date.

•

If the user has selected a date in the Date To box, the invoice date must be less than or equal to
the DateTo parameter value—that is, before or the same as the specified date.

•

If the user has selected a salesperson in the Salesperson box, the commission must be
associated only with the selected salesperson.

•

The invoice type must be INV, which corresponds to the Invoice type.

•

The status of the invoice must be N or C (Open or Closed, respectively), which means that the
invoice is released.

To add these conditions to the report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the menu bar, select File > Build Schema. The Schema Builder wizard appears.

3.

On the Filters tab of the Schema Builder wizard, add the rows with the following settings, as
shown in the screenshot below:
Braces Data Field

(

Condition

Value 1

Braces Operator

ARInvoice.DocType

Equal

INV

And

ARInvoice.Status

Equal

N

Or
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Braces Data Field

(

(

(

Condition

Value 1

Braces Operator

ARInvoice.Status

Equal

C

)

ARInvoice.DocDate

GreaterOrEqual

@DateFrom

@DateFrom

IsNull

ARInvoice.DocDate

LessOrEqual

@DateTo

IsNull

And
Or

)

And
Or

@DateTo
)

And

ARSalesPerTran.CommnAmt Greater

0

And

SalesPerson.SalesPersonCD Equal

@SalesPerson

Or

@SalesPerson

IsNull

)

And

In the Data Field column, you can specify an expression if you select an appropriate row and
click the Data Field Formula button to open the Expression Editor.
The second and third rows (item 1 in the screenshot below) are a pair and specify one
condition. The N value of ARInvoice.Status corresponds to the Open status, and the C value of
ARInvoice.Status corresponds to the Close invoice status. The invoice cannot have both statuses
at the same time. Thus, these rows are enclosed in brackets and joined with the Or operator.
The fourth and fifth rows (item 2) are a pair and specify one condition. The fifth row is used
when the user does not select any date in the Date From box. The fourth row is used when the
user selects a date in the Date From box. These events cannot happen at the same time. Thus,
these rows are enclosed in brackets and joined with the Or operator.
The sixth and seventh rows (item 3) are a pair and specify one condition. The seventh row is
used when the user does not select any date in the Date To box. The sixth row is used when the
user selects a date in the Date To box. These events cannot happen at the same time. Thus,
these rows are enclosed in brackets and joined with the Or operator.
Based on the condition specified in the eighth row (item 4), you are excluding the data with the
zero commission amounts from the report results.
The ninth and tenth rows (item 5) are a pair and specify one condition. The tenth row is used
when the user does not select any salesperson, so the commissions of all the salespersons will
be selected. The ninth row is used when the user selects a salesperson, so only the commissions
associated with this salesperson will be selected. These events cannot happen at the same time.
Thus, these rows are enclosed in brackets and joined with the Or operator.
To delete any filter condition you have defined, click the relevant row in the table, and press
DELETE.
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Figure: Defining the filter conditions

4.

Click OK to apply your changes to the report and to close the Schema Builder wizard.

5.

On the toolbar of the Report Designer main window, click the
button to save your changes to
the report. By default, the report will be saved to the same place, because in Step 4.2: Saving
the Report you saved the report to the server.
You can also save the report by pressing CTRL+S.

You have specified the filtering conditions for the report.
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Step 4.4: Configuring the Report Layout
You have defined the rules to select the necessary data to display in the report. Now you will configure
the visual presentation of this data by performing the following tasks:
•

Defining the data groups for the report

•

Defining sorting rules

•

Selecting style templates

•

Adding elements to the report layout

•

Making a link for values of a text box

Step 4.4.1: Defining the Data Groups for the Report
You can use data groups to structure and logically group data in a report. For this report, you will group
commissions by salesperson. To configure this grouping condition, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the Properties tab, select the report1 Report object (item 1 in the screenshot below) from
the drop-down list to select the report form.
You can also select the report form by performing one of the following steps:

3.

•

Click the top left box under the toolbar on the report form (item 2). The black square will
appear in the box.

•

Right-click any place of any section on the report layout and select Select report1.

On the Properties tab, select the Groups property, and click the
Group Collection Editor dialog box.

button (item 3) to open the

Figure: Specifying the grouping conditions

4.

In the Group Collection Editor dialog box, click Add (item 1 in the screenshot below) to add a
new group.

5.

Select the created group, and specify the following settings:
•

KeepTogether: FirstDetail

•

PrintEmpty: False
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•

(Name): SalesPerson

The KeepTogether property defines whether the entries of the group should be printed on the
same page. The following values are available for this property:
•

WholeGroup means that all entries of the group are printed on the same page with the
group header section, if possible.

•

FirstDetail means that at least one entry of the group is printed on the same page with the
group header section.

•

None, the default value, means that entries of the group can be printed separately with the
group header section.

Based on the FirstDetail value you selected for the KeepTogether property, the report may be
larger (in terms of number of pages) but easier to read than it would be with the None value,
but it will be shorter than with the WholeGroup value.
The PrintEmpty property specifies whether an empty group section is printed. Based on the
False selection, any group without entries will not be printed.
6.

In the Grouping property of the SalesPerson group, click the
GroupExp Collection Editor dialog box.

button (item 2) to open the

Figure: Adding a new group

7.

In the GroupExp Collection Editor dialog box, click Add to add a new grouping expression. As
the Data Field value, type: SalesPerson.SalesPersonCD, as shown in the screenshot below.
Based on this expression, the nested data records will be grouped.
If you used the Expression Editor to define the grouping expression, the value you selected for
Data Field would be =[SalesPerson.SalesPersonCD]. This expression is also correct.

The group you are adding to the report is ordered in ascending order by default, based on the
Sort Order value. You could change this sort order by selecting the Descending value.
Click OK to apply the settings you made and close the GroupExp Collection Editor dialog box.
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Figure: Specifying the grouping expression

8.

In the Group Collection Editor dialog box, click OK to apply the grouping conditions and close
the dialog box.

9.

Save your changes to the report.

You have added the SalesPerson group to the report. The appropriate group header and group footer
are shown on the report layout, as shown in the screenshot below.

Figure: Viewing the created group
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Step 4.4.2: Defining Sorting Rules for the Report
You can specify how the report data is sorted—that is, the order in which the results should be
displayed in the detail section of the report. At first, the report data is sorted according to the sorting
rules of the group sections, and then the data of the detail section is sorted according to the sorting
rules of the report.
You sorted the report by salesperson in ascending order when you defined the grouping rules. Now you
will sort the list of each salesperson's commissions by invoice date. To specify this sorting rule, do the
following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the Properties tab, select report1 Report from the drop-down list to select the report form.

3.

Select the Sorting property, and click the
dialog box.

4.

In the dialog box, click Add to add a new sorting expression. In its Data Field, select
ARInvoice.DocDate, as shown in the screenshot below. Based on this expression and the default
value of Sort Order, the data of the detail section will be sorted by invoice date in ascending
order.

button to open the SortExp Collection Editor

Figure: Specifying the sorting expression

5.

Click OK to apply the settings you made and close the SortExp Collection Editor dialog box.

6.

Save your changes to the report.

You have specified the sorting rules to the report.

Step 4.4.3: Selecting Style Templates
Style templates are extremely useful for quick and uniform formatting of text displayed in a report. In
the Site/ReportsDefault/ folder, you can find the following files with default style templates:
•

TemplateReport.rpx: Contains styles that you can use for reports

•

TemplateForm.rpx: Is intended for printable pages

These template files are also available on the server.
You can use existing styles, as well as define your own custom styles required for the application. To define
your own style, create a new report, select the report form, specify the style collection in the StyleSheet
property, and save this report locally or on the server. Then you can use this report as a style template.

You can also manually adjust the style of elements in the properties of the Style group.
To specify a style template file for the report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the Properties tab, select report1 Report from the drop-down list to select the report form.
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3.

In the StyleTemplate property, click the

button and select the TemplateForm.rpx file.

To select the template file from the server, you can just enter the name of the template file as the
value of the StyleTemplate property.

4.

Save your changes to the report.

You have specified the file containing the style templates for the printable page. Next, you will add
elements on the report layout and apply style templates to them.
For more information on applying the style templates, see the links in the Related Links section of this
topic.
Related Links
Report Designer — Recommendations (Recommended Predefined Styles)

Step 4.4.4: Adding Elements to the Report Layout
You have defined the sections of the report layout and configured the sorting rules. Now you will
visually lay out the report. To do that, you will add to the report layout some of the elements listed in
the top right area of the Report Designer and configure these elements.
You will configure the following sections:
1.

The page header section

2.

The group header section

3.

The detail section

4.

The group footer section

5.

The page footer section

1. Configuring the Page Header Section
You will use the page header section to print the following common information on each page:
•

The report name

•

The company name

•

The user who printed the report

•

The print date

•

The number of printed pages

•

The date range specified by the user (if applicable)

To configure the page header section and add appropriate elements to the report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the page header section, to add a text box to print the report name, click TextBox in the
elements list (as shown in the following screenshot) and then click the place where you want to
put the box. You can move elements on the report layout by dragging them. Place the text box
in the top right corner of the page header section.
You can also add an element to the report layout by performing one of the following steps:
•

Drag the element from the elements list to the needed location.

•

Select a section to add the element and then double click the element in the list. The element
will be added in the top left corner of the selected section.
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Figure: Placing a text box on the report layout

3.

Configure the added text box as follows:
•

The height of any new added text box is 16 pixels. Enlarge the text box height by 8 pixels
by dragging the handle at the bottom of the box so that the text box height becomes 24
pixels, as shown in the following screenshot. The spacing between lines of the regular grid
of the report layout is 8 pixels by default.
You can also specify the text box height on the Properties tab in the Size > Height
property.

Figure: Changing the size of the text box

Similarly, you can change a size of any element of the report layout, including the height of
any section.
•

Double-click the text box you added, and type inside Invoices Commissionable by
Salesperson. You have defined the Value property of the text box through the report
layout directly.

•

In the Style > Text Align property, select Right.

•

In the StyleName property, select Report Name. The list of styles shown in the
StyleName property depends on the style template you have selected for the report.

•

Adjust the text box width so that its entire text is visible in the box.
You can remove any element from the report layout. To do that, select the element by clicking it,
and press Delete.

4.

Add 12 text boxes with the following values, as shown in the screenshot below:
•

Company: (item 1 in the screenshot below)

•

=Report.GetDefUI('CompanyBAccount.AcctName') (item 2)

GetDefUI(object field) is an application function you can use to get the value of
the object field parameter. Based on the value you entered, the text box shows the
company name.
•

User: (item 3)

•

=Report.GetDefUI('AccessInfo.DisplayName') (item 4)
Based on this value, the text box shows the name of the user who executed the report.
You can use the fields of the AccessInfo class to get information as follows:
•

AccessInfo.DisplayName: The user login

•

AccessInfo.CompanyName: The company name
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•

AccessInfo.BusinessDate: The Acumatica ERP business date

•

AccessInfo.BranchID: The branch identifier

•

Print Date: (item 5)

•

=Today() (item 6)

Today() is a date and time function that returns the current date according to the system
date on the local computer; you can use the @Today predefined parameter and get the
same result. Based on this value, the text box shows the print date of the report.

If you also want to print the time, you should use the Now() date and time function, and
set the Format of the text box to g, which is a standard format specifier. The Now() and
Today() functions use user's time zone. You can also use the NowUTC() and TodayUTC()
functions to get date and time in the UTC standard.

•

Pages: (item 7)

•

=[PageCount] (item 8)

PageCount is a global variable that returns the page count value for the current report.
Based on this value, the text box shows the number of pages of the report. For more
information on variables, see the links in the Related Links section of this topic.
•

Start Date: (item 9)

•

=IsNull(@DateFrom, '___/___/______') (item 10)

IsNull(value, nullValue) is a shortcut function that returns the value argument
if it does not equal NULL. If the value argument equals NULL, the function returns the
nullValue argument. Based on the function you entered, the text box shows the date
that the user has selected in the Date From box. If the user has not specified the Date
From parameter, the text box shows the string ___/___/______.
•

End Date: (item 11)

•

=IIf(@DateTo=NULL, '___/___/______', @DateTo) (item 12)

IIf(expression, truePart, falsePart) is a shortcut function that returns the
truePart argument if the expression evaluates to True. Otherwise, if expression
evaluates to False, the function returns the falsePart argument. Based on the function
you entered, the text box shows the date that the user selected in the Date To box, if any.
Otherwise, the text box shows the string ___/___/______.
For more information on functions, see the links in the Related Links section of this topic.

Figure: Previewing the page header section

5.

Select all the text boxes you added in the previous step (as shown in the following screenshot),
and in the StyleName property, select Report Params.

| Step 4.4.4: Adding Elements to the Report Layout | 122

Figure: Selecting multiple elements

Notice that the values you entered in the text boxes, which start with =, are enclosed in square
brackets on the report layout, as with [=Today()]. If you select any of these text boxes, you
cannot find these square brackets in their Value on the Property tab. These brackets indicate
that the text box value is not just a string constant; it is an expression.
In the rest of this document, we will refer to a layout element by the value that the element
displays. For expressions, we will omit square brackets and the equal symbol and speak of, for
example, the Print Date: text box, the Today() text box, or the PageCount text box.

6.

Decrease the height of the header section so that there are 16 pixels of empty space at the
bottom of the section, as shown in the following screenshot.

Figure: Previewing the page header section

7.

Save your changes to the report.
If the designer shows a red X on a visual element, as shown in the screenshot below, this means that the
element overlaps on the layout with some other element. You have to adjust the layout and move or resize
the elements as needed. Overlapping elements will not cause a run time error in the report; but only one of
these elements will be shown in the printed report.

Figure: Identifying overlapping elements

2. Configuring the Group Header Section
You will use the group header section to print the following information for each group:
•

The name and identifier of the salesperson whose commissions are listed in the detailed section

•

The column headers for the data of the detail section

To configure the group header section and add appropriate elements to the report, do the following, as
shown in the screenshot below:
1.

On the group header section, to print the salesperson's identifier and name, add the text boxes
with the following values:
•

Salesperson: (item 1 in the screenshot below)

•

=[SalesPerson.SalesPersonCD] (item 2)

•

=[SalesPerson.Descr] (item 3)
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2.

Select all the text boxes you added in the previous step and enlarge their height by 8 pixels. In
the StyleName property, select Report Name.

3.

Add text boxes with the following values to print column headers:
•

Invoice Date (item 4)

•

Invoice Nbr. (item 5)

•

Customer ID (item 6)

•

Customer Name (item 7)

•

Sales (item 8)

•

Commission (item 9)

•

Comm % (item 10)

4.

Select all the text boxes you added in the previous step, and then in the StyleName property,
select Heading1BCColored.

5.

Decrease the height of the group header section so that there are 8 pixels of empty space at the
bottom of the section.

Figure: Previewing the group header section

6.

On the Properties tab, select groupHeaderSection1 from the drop-down list to select the page
header section.
You can also select the section by performing one of the following steps:

7.

•

Click the section header on the report layout.

•

Click any empty place of the section on the report layout.

•

Right-click any element of the section, such as a text box, and select Select
groupHeaderSection1

In the PrintOnEveryPage property of the page header section, select True.
Based on this setting, the group header section is printed on each page of the report. This can
make the report easier to read because if the user specifies a broad date range, the data of
the detail section can span several pages. You have also selected the FirstDetail value for the
KeepTogether property of the group section in Step 4.4.1: Defining the Data Groups for the
Report; thus, the data of the detail section can span two pages regardless of the date range.
With the group header printed on each page, the report will become more readable.

8.

Save your changes to the report.

3. Configuring the Detail Section
You will use the detail section to print the following commission information for each salesperson:
•

The invoice date and number

•

The applicable customer's identifier and name
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•

The applicable commissionable amount, commission amount, and commission percent

To configure the detail section and add appropriate elements to the report, do the following:
1.

To print detailed information in the detail section, add text boxes with the following values:
•

=[ARInvoice.DocDate] (item 1 in the screenshot below)

•

=[ARInvoice.RefNbr] (item 2)

•

=[Customer.AcctCD] (item 3)

•

=[Customer.AcctName] (item 4)

•

=[ARSalesPerTran.CommnblAmt] (item 5)

•

=[ARSalesPerTran.CommnAmt] (item 6)

•

=[ARSalesPerTran.CommnPct] (item 7)

Figure: Previewing the detail section

2.

Select all the text boxes you added in the detail section, and then in the StyleName property,
select Normal.

3.

Select the ARSalesPerTran.CommnPct text box on the report layout (item 7 in the screenshot
above). In the Format property, type 0.00.
Based on this format specifier, the values of the text box will be formatted as shown in the
following examples:
•

23.45678 -> 23.46

•

0.4 -> 0.40

•

.45 -> 0.45
If it is hard for you to find the property at a glance on the Properties tab, you can arrange the list
of properties by categories or alphabetically by clicking

or

respectively on the tab toolbar.

For more information on formatting values, see the Formatting Values to Be Displayed on a
Report topic of this course.
4.

Decrease the height of the detail section so that no empty space remains at the bottom of the
section.

5.

Save your changes to the report.

4. Configuring the Group Footer Section
You will use the group footer section to display the following subtotals for the salesperson:
•

The total commissionable amount

•

The total commission amount

•

The average commission percent

To configure the group footer section and add appropriate elements to the report, do the following:
1.

Add a text box to the group footer section (item 1 in the screenshot below), and specify the
following settings:
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•

Value: =SUM([ARSalesPerTran.CommnblAmt])

•

Format: N

This text box shows the total commissionable amount for the salesperson.
2.

Add the next text box (item 2), and specify the following settings:
•

Value: =SUM([ARSalesPerTran.CommnAmt])

•

Format: #,#.00

This text box shows the total commission amount for the salesperson.
Based on this format specifier, the values of the text box will be formatted as shown in the
following examples:

3.

•

123456789 -> 123,456,789.00

•

123.456789 -> 123.46

•

.123456789 -> .12

Add the last text box (item 3), and specify the following settings:
•

Value: =AVG([ARSalesPerTran.CommnPct])

•

Format: =[ARSalesPerTran.CommnblAmt.Format]

This text box shows the average commission percent for the salesperson.
4.

Select all the text boxes you added in the group footer section and enlarge their height to 24
pixels by dragging the handle at the bottom of any box. You can also manually specify the
Size > Height property of each text box.

5.

With all the text boxes still selected, in the StyleName property, select Report Name.

6.

Decrease the height of the group footer section so that there are 8 pixels of empty space at the
bottom of the section.

7.

Save your changes to the report.

Figure: Previewing the group footer section

5. Configuring the Page Footer Section
You will use the page footer section to print the following common information at the bottom of each
page:
•

The number of the current page

•

A notification that there is at least one additional page in the report

To configure the page footer section and add appropriate elements to the report, do the following:
1.

Add a text box to the group footer section (item 1 in the screenshot below), and specify the
following settings:
•

Value: Continued...

•

VisibleExpr: =[PageIndex]<[PageCount]
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2.

Add another text box (item 2), and specify the following settings:
•

Value: =[PageOf]

The VisibleExpr property holds the expression that specifies the visibility of the text box value
in the executed report; this value overrides the value of the Visible property, if it was set
explicitly. If the expression returns True, the value is visible. Based on the expression you have
entered, the text box value is visible in the executed report if the number of current page is
less than the number of pages of the report. Thus, all report pages contain the Continued...
notification except the last page.
You can also define the visibility of a section by specifying its VisibleExpr property, or hide the
section from the executed report by selecting False in the section's Visible property.

3.

Select all the text boxes you added in the report footer section, and in the StyleName property,
select Normal.

4.

Decrease the height of the detail section height so that no empty space remains at the bottom of
the section.

5.

Save your changes to the report.

Figure: Previewing the page footer section

Notice that the default value of the ProcessOrder property of the page footer section is Always. The
ProcessOrder property is commonly used for sections and particular text boxes. Once this property
has been specified for a section, the property is applied to every text box in this section unless it is
overridden for a text box.
The ProcessOrder property specifies when the text box value is processed during the report
generation. A text box value can be processed when the data is read from the database (WhileRead),
when the report is printed (WhilePrint), or in both cases (Always). In most cases, when a value is just
read from the database and then displayed in the report, WhileRead is enough. However, if the value
being calculated depends on data that will be known only at the report rendering stage, the WhilePrint
mode should be specified.
For example, you have added two text boxes to the page footer section. The visibility of the
Continued... notification depends on the page number and page count, which are calculated by the
PageIndex and the PageCount global parameters, respectively. Both numbers for each page will
be known only at the report rendering stage. Similarly, the page number, which is calculated by the
PageOf global variable, will be known only at the report rendering stage. Page numbers are typical
data fields that require the WhilePrint processing mode. Thus, Always, which is the default value for the
page footer section, is an appropriate setting. If you select the WhileRead setting for the page footer
section, the Continued... notification will be printed on every page, and the page number will never
be printed.
Now that you have configured the page header section (the last available section of the report), you
have configured the report (see the screenshot below).
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Figure: Previewing the report layout
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Step 4.4.5: Making a Link for a Text Box
You can configure a text box so that its value will contain a link to a form or report in Acumatica ERP
or to any external object. The user can click the link to get the appropriate information. For example,
the value of a text box that holds the customer's name or identifier can be a link to the form for the
appropriate customer. In this case, the user could view more information about the customer by clicking
the customer name or identifier in the generated report.
You will configure the report you are creating so that the user will be able to do the following:
•

Open the Salesperson form (AR205000) for the salesperson by clicking the salesperson's name

•

Open the Invoices and Memos form (AR301000) for the invoice by clicking its number

•

Open the Customer Details report (AR651000) for the customer by clicking the customer's name

Perform the following steps:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

To specify a link to the Salesperson form (AR205000), do the following:
a.

In the group header section, select the SalesPerson.Descr text box.

b.

In the NavigateMethod property of this text box, select Server.

By default, the server method is used to navigate to a specific object referenced by the data
access class of the field specified in the text box. For the SalesPerson.Descr text box, this class
is SalesPerson.
3.

To specify a link to the Invoices and Memos form (AR301000) manually, do the following:
a.

Log in to the SalesDemo company of Acumatica ERP.

b.

Open the Invoices and Memos form (AR301000; Finance > Accounts Receivable > Work
Area > Enter), open an invoice, and copy its URL, which should be similar to the following
link.

http://localhost/InstanceName/Main.aspx?
CompanyID=SalesDemo&ScreenId=AR301000&DocType=INV&RefNbr=AR003628
c.

In the Report Designer, in the detail section, select the ARInvoice.RefNbr text box.
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d.

Make sure that the value of the NavigateMethod property of the text box is Client,
which is the default navigation method.

e.

Select the NavigateUrl property of the text box and click the
button to open the
Expression Editor. In the Expression Editor, past the URL you copied in Acumatica
ERP. This URL contains elements that are specific to the application, company, and
document selected. In the code below, these elements are shown enclosed in curved
brackets.

{application URL}Main.aspx?{company
name}&ScreenId=AR301000&DocType={document
type}&RefNbr={document number}
f.

Remove from the URL the Acumatica ERP URL ({application URL}) and the company
name ({company name}), because the URL has to be correct for any application and
company; therefore, the system sets them automatically. An ampersand & is used as the
connection symbol between elements in the URL. If you exclude the company name, you
will have to delete the ampersand that follows it as well.

Main.aspx?ScreenId=AR301000&DocType={document
type}&RefNbr={document number}
g.

In the URL, replace the document type ({document type}) and the document number
({document number}) with the appropriate data fields. Thus, the URL will be correct
for any row of the detail section. You also have to start the URL with an equal sign (=),
because you can use data fields in expressions only. Connect the data fields and the
parts of the URL with a plus sign (+), and enclose each piece of the divided URL in single
quotes. The URL will look as shown below.

='Main.aspx?ScreenId=AR301000&DocType='
+[ARInvoice.DocType]+'&RefNbr='+[ARInvoice.RefNbr]
You have specified the URL.
h.

Click Validate to validate the formula.
If the validation passes successfully the Validate button becomes unavailable and its
caption is changed to Validated.

i.
4.

Click OK to close the Expression Editor.

To specify a link to the Customer Details report (AR651000), do the following:
a.

In the detail section, select the Customer.AcctName text box.

b.

In the NavigateMethod property, select Server.

c.

In the NavigateReport property, select the AR651000.rpx file.
To select a report from the server, you can just enter the name of the report file as the
value of the NavigateReport property.

To find out the name of a report file, in Acumatica ERP, you can open the Site Map form
(SM200520). In the table in the right pane, find the report. The Url column holds the URL
to the report form, such as: ~/Frames/ReportLauncher.aspx?ID=AR651000.rpx.
The report file name is at the end of this URL.
In the NavigateParams property, you have to specify the appropriate external
parameter to be transferred to the report selected in the NavigateReport property,
which is the Customer Details report. The names and types of these external parameters
have to match the names and types of the Customer Details report parameters.
To find out the names and types of report parameters, you can open the report in the
Report Designer, open the Schema Builder wizard, and review the Parameters tab.
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d.

Select the NavigateParams property and click the
ExternalParameter Collection Editor dialog box.

e.

In the dialog box, click Add to add a new external parameter, and specify the following
settings, as shown in the screenshot below:
•

Name: CustomerID

•

ValueExpr: =[Customer.AcctCD]

button to open the

Figure: Adding an external parameter

f.
5.

Click OK to apply the settings you made and close the ExternalParameter Collection
Editor dialog box.

Save your changes to the report.

You can define whether clicking a link causes the system to navigate to the page in the same window
or to open a new one. You can specify one of the following settings in the Target property of the text
boxes that hold the links:
•

To navigate in the same window: main

•

To navigate in a new window: _blank
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Step 4.5: Using Variables
You can use variables to calculate values based on the expressions defined for them, to store these
values, and to make them available in all sections of the report.
Suppose that you need to calculate the number of commissionable invoices for each salesperson in the
detail section, and show this number in the group footer section with the subtotals. To do this, you will
add a variable to the report. Do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the report layout, click the header of the detail section to select this section.
You are going to add the variable to the detail section, because your purpose is to calculate the
number of invoices that are listed in the detail section.

3.

In the Variables property, click the
dialog box.

4.

In this dialog box, click Add to create a new variable, and specify the following settings, as
shown in the screenshot below:
•

Name: InvCount

•

ResetGroup: SalesPerson

•

ValueExpr: =$InvCount+1

button to open the ReportVariable Collection Editor

Based on the setting you entered for the ValueExpr property, the value of the $InvCount
variable increases by 1 for each new row of the detail section.
Based on the setting you selected for the ResetGroup property, the value of the $InvCount
variable resets to 0 when a new salesperson's group begins.
You can also reset the value of a variable to 0 by specifying an expression in the ResetExpr
property. When this expression returns True, the variable is reset to 0.

Figure: Adding a new variable

5.

Click OK to close the dialog box and add the variable to the report. When you use this variable in
expressions, you precede its name with a dollar sign ($) as follows: $InvCount.

6.

Add a text box to the group footer section, as shown in the screenshot below, and specify the
following settings:
•

Value: ='Invoices count: ' + $InvCount

•

StyleName: Report Name

•

Size > Height: 24px
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Figure: Changing the size of the text box

7.

Save your changes to the report.

You have declared the variable in the detail section and used this variable in the page footer section.
If you were to declare the same variable in multiple sections, the variable would be shared between
them. If the variable is modified in one section, the new value of the variable will be passed to the next
section where the variable is used. The variable is initiated in the topmost section where it is used. Then
the variable is sequentially modified in the following sections in the order these sections are printed in the
report.

For more information on using variables, see the online product documentation supplied with Acumatica
ERP (Help > Acumatica Framework > Report Designer > Using Variables).
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Step 4.6: Publishing and Previewing the Report
You have to publish the report, which entails adding the URL of the report to the site map in Acumatica
ERP to make it possible for users to run the report. To do that, complete the following steps:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

On the Site Map form (SM200520; System > Customization > Manage), in the left pane, select
Company > Finance > Accounts Receivable > Reports > Audit.
In the table in the right pane, add a new row, and specify the following settings, as shown in the
screenshot below:
•

ScreenID: AR.67.00.00

•

Title: Invoices Commissionable by Salesperson

•

Url: ~/Frames/ReportLauncher.aspx?ID=AR670000.rpx
If you have saved your report both to the server and locally with the same name, Acumatica ERP
opens the report from the server. In this case, if you need to modify this report, you have to open it
from the server.

Figure: Adding the report to the site map

3.

Save your changes to the site map.

4.

Add the report to a workspace in the modern UI as follows:
a.

If you are in the classic UI, switch to the modern UI.

b.

In the main menu, click Receivables.

c.

In the main menu, click configuration menu (three dots in the bottom left corner) and
then click Edit Menu to switch to the Menu Editing mode.

d.

Click Add Menu Item.

e.

In the Select Forms box, type Invoices Commissionable by Salesperson.

f.

Select the check box to the right of the Invoices Commissionable by Salesperson report.

g.

Click Add & Close to add the selected report to the workspace and close the dialog box.

h.

In the Other section of the workspace, find the Invoices Commissionable by Salesperson
report, and, on the report pop-up toolbar, click Edit (the pencil icon).

i.

In the Category box of the Form Parameters dialog box, select Reports.

j.

Click OK to move the report to the Reports section and close the dialog box.
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k.

In the Reports section, select the check box to the left of the Invoices Commissionable
by Salesperson report to add it to the quick menu by default.

l.

Click Exit Edit Menu to save you changes and exit the Menu Editing mode.

Notice that the Invoices Commissionable by Salesperson report appeared in the Reports section
of the Receivables workspace.
5.

Open the Invoices Commissionable by Salesperson report form (AR670000; Finance > Accounts
Receivable > Reports > Audit).

6.

On the Report Parameters tab, specify the report parameters, if needed.

7.

On the form toolbar, click Run Report to execute the report. To return to the report form, click
the

button on the form toolbar, as shown in the screenshot below.
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Figure: Previewing the executed report
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Lesson Summary
In this lesson, you have learned how to create reports by using the Report Designer. Below is the
summary of the main steps you should perform to create a report:
1.

Investigate the appropriate forms whose data you are going to use in the report to discover the
data access classes, their data fields, and relationships between the classes.

2.

Create a new report.

3.

Select the data for the report, which entails performing the following steps in the Schema
Builder wizard:
a.

Load the database schema.

b.

Select the data classes.

c.

Specify the relationships between the classes, if necessary.

d.

Add one or more parameters for the report, if necessary, to allow users to filter the report
data by specifying values of these parameters.

e.

Specify the filtering conditions, if necessary, which determine the data to be retrieved.

4.

Specify grouping conditions for the report data, if necessary.

5.

Specify sorting conditions for the data of the detail section, if necessary.

6.

Lay out the report—that is, add to the report layout some visual elements, configure these
elements, specify visibility of the report sections and elements, and so on.

7.

Add the URL of the report to the site map.

In the lesson, you also selected a style template for the report in the StyleTemplate of the report
form. You applied this style template to the report elements by selecting styles in the StyleName
property of elements. You added a variable to the report section and used this variable in the other
sections of the report. You added TextBox elements to the report layout, and configured some of them
so that their values contained links to forms and reports of Acumatica ERP.
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Review Questions
1.

2.

3.

4.

5.

6.

Each Acumatica ERP reports is a XML-based file with this extension.
•

A. .rpx

•

B. .xml

•

C. .rpt

•

D. .xhtml

What can you do with a report, if the ReportDesigner role is not assigned to your user.
•

A. Run the report in Acumatica ERP.

•

B. Open the report to edit by clicking the Edit Report command on the toolbar of the
report form in Acumatica ERP.

•

C. Edit the report in the Report Designer.

What report sections are available in Acumatica Report Designer? Select all that apply.
•

A. Report Total

•

B. Page Title

•

C. Group Header

•

D. Sub Report

•

E. Detail

•

F. Group Body

•

G. Page Footer

Suppose that your Acumatica ERP instance has multiple companies, and your login is admin.
Select the format of the login you should enter in the Login box of the Schema Builder wizard
of the Report Designer to load the schema of all available classes of the Company company from
the application server.
•

A. admin

•

B. admin/Company

•

C. admin@Company

•

D. admin:Company

Suppose that your Acumatica ERP instance has a single company—that is, Company—and
your login is admin. Select the format of the login you should enter in the Login box of the
Schema Builder wizard of the Report Designer to load the schema of all available classes of the
Company company from the application server.
•

A. admin

•

B. admin/Company

•

C. admin@Company

•

D. admin:Company

What types of joins you cannot use on the Relationships tab of the Schema Builder wizard?
Select all that apply.
•

A. Inner

•

B. Left

•

C. Cross

•

D. Outer

•

E. Full
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7.

8.

9.

Suppose that you have added a new parameter to the report, but it does not appear on the
Reports Parameters tab of the report form. What is the possible reason?
•

A. The View Name of the parameter is undefined.

•

B. The Prompt of the parameter is undefined.

•

C. You have specified no default value.

•

D. The Allow Null check box is selected for the parameter.

•

E. The Visible check box is cleared for the parameter.

•

F. You have not used the parameter in the filter conditions of the report.

•

G. The Required check box is cleared for the parameter.

How can you add both the group header and the group footer sections to the report? Select all
that apply.
•

A. Right-click any empty place on the report layout and select Add New Group.

•

B. Select Edit > Add New Group on the menu bar of the Report Designer.

•

C. Specify the grouping condition in the Groups property of the report.

•

D. None of the above.

Suppose you are developing a report that lists sales orders grouped by date. How can you
arrange the report data so that group sections will be sorted by date in descending order?
•

A. Select the SortOrder property of the grouping condition by the date as Descending.

•

B. Specify the Value property of the text box that holds sales order date in the group
section as =Sort([SOOrder.OrderDate], Desc).

•

C. Create a sorting condition by the sales order date and select SortOrder for this
condition as Descending.

•

D. None of the above.

10. How can you add to the report layout an element from the element list in the top right area of
the main window of Acumatica Report Designer? Select all that apply.
•

A. Click the element in the list, and then click the place on the report layout where you
want to put the element.

•

B. Drag the element from the list to the needed location.

•

C. Right-click the element in the list, and select the section to add the element.

•

D. Select a section to add the element, and then double-click the element in the list.

11. How can you change the size of a TextBox element you added to the report layout? Select all
that apply.
•

A. Select the text box, and drag any of handles on its borders.

•

B. Specify the height and width of the text box manually on the Properties tab in the
Excel Cell > Height and Excel Cell > Width properties respectively.

•

C. Specify the height and width of the text box manually on the Properties tab in the
Size > Height and Size > Width properties respectively.

•

D. None of the above.

12. How can you select the report form to access the list of report properties? Select all that apply.
•

A. Select the report1 Report object from the drop-down list on the Properties tab.

•

B. Select Edit > Select Report Form on the menu bar of the Report Designer.

•

C. Click the top left box under the toolbar on the report form.

•

D. Right-click any place of any section on the report layout, and select Select report1.
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13. How can you select a section of a report to access the list of its properties? Select all that apply.
•

A. Select the section from the drop-down list on the Properties tab.

•

B. Click the section header on the report layout.

•

C. Click any empty place of the section on the report layout.

•

D. Right-click any empty place on the report layout, and select the needed section.

•

E. Right-click any element of the section, such as a text box, and select Select {section
name}.

14. Suppose that you are customizing a report that uses the ARInvoice data class to display the
invoice number. You want to configure the text box that holds the invoice number so that its
value will contain a link to the Invoices and Memos form (AR301000). A user will be able to open
the appropriate invoice by clicking its number on the report. How can you do that? Select all that
apply.
•

A. Specify the Value property of the text box as <a href="Main.aspx?
ScreenId=AR301000&DocType=+[ARInvoice.DocType]+&RefNbr=
+[ARInvoice.RefNbr]">[ARInvoice.RefNbr]</a>.

•

B. Specify the NavigateMethod property of the text box as Server.

•

C. Specify the NavigateMethod property of the text box
as Client and the NavigateUrl property as ='Main.aspx?
ScreenId=AR301000&DocType='+[ARInvoice.DocType]+'&RefNbr='+[ARInvoice.RefNbr].

15. How can you reset the value of a variable to 0?
•

A. Select one of the report groups in the ResetGroup property of the variable to reset the
variable value for each new group.

•

B. Specify an expression in the ResetExpr property of the variable to reset the variable
value when the expression returns True.

•

C. Specify the ValueExpr property of the variable as =0.

•

D. None of the above.

16. What should you do to publish a report you have just created? Select only the steps that you
must perform.
•

A. Specify the Title property of the report.

•

B. Add a new node with the report URL, title, and screen identifier on the Site Map form
(SM200520).

•

C. Specify the access rights to the report.

•

D. Restart the website.

Answer Key
1 - A; 2 - A, C; 3 - C, E, G; 4 - C; 5 - A; 6 - D; 7 - B, E; 8 - A, C; 9 - A; 10 - A, B, D; 11 - A, C; 12 - A,
C, D; 13 - A, B, C, E; 14 - B, C; 15 - A, B; 16 - B.
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Practice Exercise
Now that you have completed Lesson 4: Creating a Report, you know how to create and configure a
report. To check your knowledge, perform the following exercise on your own.
While completing the course prerequisites, you imported and published the customization project that
contains the Open Sales Orders by Customer (RD) report (SO615000; Distribution > Sales Orders >
Reports > Audit). The report is saved to the server with the name SO615000.rpx.
This report lists the details of open sales orders for specified date range and the customer (if one
has been specified). The inquiry you created in Lesson 1: Creating a Generic Inquiry presents the
same information. The only difference is that the report data is grouped by customer, as shown in the
screenshot below. The report with this grouping provides details about open orders in a format that
meets users' needs better than the inquiry does.

Figure: Open Sales Orders by Customer report

Your task is to make the report more readable and usable. You should modify the report layout so that
the report further groups inventory items by sales order, as shown in the screenshot below.
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Figure: Customized version of the report with order details

You also have to add a check box parameter that allows the user to determine whether order details are
visible, as shown in the screenshots below.

Figure: The customized version of the Open Sales Orders by Customer report
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Figure: Customized version of the report with order details excluded

To calculate the order amount, you will use the SOOrder.LineTotal data field, which contains the sum
of all order lines, and SOOrder.DiscTtl, which holds the discount amount applied to the order (see the
diagram below). The order amount is LineTotal minus DiscTtl.

Figure: The classes and the relationships between them

We recommend that you complete the exercise on your own and compare your results with the
screenshots above.
If you have difficulties modifying the report, refer to the brief steps listed below.
Modifying the Report
To modify the report, perform the following steps:
1.

In the Report Designer, open the SO615000.rpx report from the server.

2.

In the Schema Builder wizard, add a new parameter to the report with the following settings:
•

Name: Details

•

Data Type: Boolean

•

Prompt: Print Order Details

•

Default Value: True

3.

Add a grouping condition by the Customer.AcctCD data field.

4.

Configure the header section of the new order group as follows (see the screenshot below):
•

Add text boxes with the order number, the order date, and the order description to the
section.

•

Add a text box with the order amount, which is calculated as SOOrder.LineTotal minus
SOOrder.DiscTtl. Specify the text box visibility, which depends on the value of the
@Details parameter—that is, the text box is visible if @Details equals False. Based
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on this setting, the order amount will be printed when the user clears the Print Order
Details check box.
•
5.

6.

7.

Configure the detail section as follows:
•

Delete the text boxes with the order date and the order number.

•

Specify the section visibility, which depends on the value of the @Details parameter—
that is, the detail section is visible if the Print Order Detail check box is selected and
@Details equals True.

Configure the footer section of the new order group as follows:
•

Add the following text boxes with subtotal amounts: the line total SOOrder.LineTotal, the
discount total SOOrder.DiscTtl, and the order amount, which is SOOrder.LineTotal minus
SOOrder.DiscTtl. Specify the Format of the order amount text box based on the format of
any data fields used in the expressions in its value. For example, you can use the following
format specifier: =[SOOrder.LineTotal.Format].

•

When the detail section is hidden, this group footer section will be hidden too, because the
default value of the PrintForEmptyGroup property is False.

•

Add a variable with the following settings to calculate the total amount of orders for each
customer:
•

Name: OrderAmount

•

ResetGroup: Customer

•

ValueExpr: =$OrderAmount+[SOOrder.LineTotal]-[SOOrder.DiscTot]

Configure the footer section of the customer group as follows:
•

8.

Set the PrintForEmptyGroup property of the section to True. This will cause the group
header to be printed when the detail section is hidden and the group contains no rows.

Change the value of the existing text box to show the value of the variable you added to
the footer section of the order group. Specify the Format of this text box based on the
format of any data fields used in the expressions in its value. For example, you can use the
following format specifier: =[SOOrder.LineTotal.Format].

In the page header section, modify the values of the text boxes that hold column headers, which
should depend on the value of the @Details parameter as follows:
•

When the user selects the Print Order Details check box, show the Inventory Item,
Quantity, and Amount column headers. To show this column headers, use the IIf
function.

•

When the user clears the Print Order Details check box, show the Sales Order and
Order Amount column headers.
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Figure: The modified report layout
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Lesson 5: Using Subreports
You can include data from other reports in the current report by using subreports. You can add one
subreport or multiple subreports to a single master report.
In this lesson, you will create a subreport with a chart that shows each salesperson's commissions by
financial period. Then you will add this subreport to a master report—the Invoices Commissionable by
Salesperson report you created in Lesson 4: Creating a Report.
Lesson Objectives
In this lesson, you will learn how to do the following:
1.

Create a subreport

2.

Configure the subreport layout

3.

Configure a chart element

4.

Add a subreport to a master report

1. Creating the Subreport and Selecting Its Data
To create the subreport that shows salesperson's commissions by financial period, you have to use
the ARInvoice and ARSalesPerTran classes, as shown in the diagram below. The ARInvoice class
provides access to the invoices, which belong to financial periods. ARSalesPerTran provides access to
the salespersons' commissions. The RefNbr and DocType key fields are references between the classes.

Figure: The classes and the relationships between them

To create the subreport and select the data, do the following:
1.

Start the Report Designer as follows: Start > All Programs > Acumatica > Report Designer.
When you open the Report Designer, a blank report form is displayed by default.

2.

On the menu bar, select File > Build Schema to open the Schema Builder wizard.

3.

On the Tables tab of the Schema Builder wizard, load the schema, and add the ARInvoice
(PX.Objects.AR.Customer) and ARSalesPerTran data access classes to the subreport, as shown in
the screenshot below.
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Figure: The data access classes selected for the subreport

4.

Apply your changes to the subreport.

5.

On the Relationships tab of the Schema Builder wizard, add the lines with the following
settings to link the ARInvoice and ARSalesPerTran classes, as shown in the screenshot below:
•

•

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARInvoice

Inner

ARSalesPerTran

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

RefNbr

Equal

RefNbr

DocType

Equal

DocType

Figure: The relationships between classes

6.

Apply your changes to the subreport.
The subreport has to show the data for the master report. The parameters of the master report
are the date range and the salesperson. If the user specifies the date range, the master report
shows the invoices that dates fall within this date range. Thus, the subreport has to show
commissions for the same date range and you have to add the date range parameters to the
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subreport. To be able to show the subreport for each salesperson, you also have to add the
salesperson parameter.
7.

On the Parameters tab of the Schema Builder wizard, add the needed parameters with the
following settings to the parameters list, as shown in the screenshot below:
Name

Data Type

Allow Null

DateFrom

DateTime

Selected

DateTo

DateTime

Selected

SalesPersonID

Integer

Cleared

The master report shows commissions of all salespersons, if the user does not specify any
salesperson. The subreport will show commissions of the certain salesperson for each group of
the master report. That is why you did not select the Allow Null check box. Even though the
salesperson parameter of the master report is optional, you have to specify the salesperson for
the subreport in the master report regardless of the user's choice.

Figure: The subreport parameters

8.

Apply your changes to the subreport.
The subreport has to show the same commission amounts as the master report. Therefore, their
filter conditions will be almost the same with corrections for names of the parameters and the
classes selected for the subreport.

9.

On the Filters tab of the Schema Builder wizard, specify the following filter conditions (see the
screenshot below):
Braces

(

(

(

Data Field

Condition

Value 1

Braces

ARInvoice.DocType

Equal

INV

And

ARInvoice.Status

Equal

N

Or

ARInvoice.Status

Equal

C

ARInvoice.DocDate

GreaterOrEqual

@DateFrom

@DateFrom

IsNull

ARInvoice.DocDate

LessOrEqual

)

And
Or

)
@DateTo

Operator

And
Or
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Braces

(

Data Field

Condition

Value 1

Braces

Operator

@DateTo

IsNull

)

And

ARSalesPerTran.
CommnAmt

Greater

0

And

ARSalesPerTran.
SalespersonID

Equal

@SalesPersonID

Or

@SalesPersonID

IsNull

)

And

Figure: The filter conditions of the subreport

10. Click OK to apply your changes to the subreport and to close the Schema Builder wizard.
11. Save to the server the subreport with the AR670050.rpx name.
2. Configuring the Subreport Layout
The layout of your newly created report consists of the page header section, the page footer section,
and the detail section. You will use the subreport in the master report only, and you need to show the
chart only in the master report. Thus, you do not need the page header and the page footer sections in
the subreport.
You have to group commission amounts by salesperson and by financial period. The chart you are going
to add in the subreport will contain the total commission amounts of each group. You can represent
these totals only in the report header or report footer section.
To modify the subreport layout, do the following, as shown in the screenshot below:
1.

On the subreport layout, delete the page header and page footer sections, and add the report
header section. To do that, click any empty place on the subreport layout, and select the
appropriate command in the shortcut menu. For more information on adding and deleting
sections, see Modifying a Report Layout topic.

2.

Add the grouping conditions by salesperson and by financial period as follows:
a.

On the Properties tab, select the report1 Report object from the drop-down list to select
the subreport form.

b.

Select the Groups property, and click the
Editor dialog box.

button to open the Group Collection
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c.

In this dialog box, add a new group.

d.

In the Grouping property of the created group, click the
GroupExp Collection Editor dialog box.

e.

In this dialog box, add two grouping expressions, one with the
ARSalesPerTran.SalespersonID data field and the other with the
ARInvoice.FinPeriodID data field.

button to open the

Based on these expressions, the subreport data will be grouped by salesperson and then
by financial period.
f.

Click OK to apply the settings you made and to close the GroupExp Collection Editor
dialog box.

g.

In the Group Collection Editor dialog box, click OK to apply the grouping conditions
and close the dialog box.

3.

Select the subreport form, and type 500px in the Width property.

4.

Add a text box to the group header section and specify its Value as
=[ARInvoice.FinPeriodID].
You will show the financial period defined in this text box in the chart that you will add later.

5.

For the group header section, specify the following settings:
•

Height: 16px

•

Visible: False
You do not need to show the group header section in the master report. Actually, you have
to hide all the subreport sections except for the report header section that will contain the
chart.

6.

7.

For the detail section, specify the following settings:
•

Height: 0px

•

Visible: False

Add a text box to the group footer section and specify its Value, as follows:
=Sum([ARSalesPerTran.CommnAmt]).
You will show the total commission amount calculated in this text box in the chart that you will
add later.

8.

9.

For the group footer section, specify the following settings:
•

Height: 16px

•

Visible: False

Save your changes to the subreport.
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Figure: The subreport layout

You have almost configured the subreport layout. Now you will add a chart to the report header section
of the subreport.
3. Adding a Chart to the Subreport Layout
To add a chart to the report header section of the subreport, do the following:
1.

Click Chart in the elements list (in the top right area of the Report Designer), and then click
on the place in the report header section where you want to put the chart. Enlarge the chart by
pulling its handles so that the chart fills the whole space of the section.

2.

Select the chart and enter the following settings to specify title and hide the legend for the
chart:

3.

•

Title > Text: Commissions by Financial Period

•

Legend > Enable: False

Select the Series property of the chart, and click the
button to open the MSChartSeries
Collection Editor dialog box. In this dialog box, click Add to add a new chart series, and
specify the following settings, as shown in the screenshot below:
•

ChartType: Column

•

AxixLabel: =[ARInvoice.FinPeriodID]

•

YValue: =SUM([ARSalesPerTran.CommnAmt])

Based on these settings, the chart will show commission amounts for each financial period in
separate columns.
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Figure: The new chart series

4.

Click OK to apply the settings you made and to close the MSChartSeries Collection Editor
dialog box.

5.

Save your changes to the subreport.

You have configured the subreport completely.

Figure: Preview of the subreport layout

4. Add the Subreport to the Master Report
Now you will add the subreport you created to the group header section of the master report. Do the
following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

Click SubReport in the elements list (in the top right area of the Report Designer), and then
click on the place in the group header section where you want to put the subreport (see the
screenshot below).

3.

Specify the subReport1 element size according to the size of the report header section of the
AR670050.rpx subreport. This is the only visible section in the subreport, and the chart fills the
whole space of this section, so the subReport1 element will fill the same space in the master
report. Specify the size of the subReport1 with the following settings:
•

Size > Width: 500px

•

Size > Height: 120px
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Figure: Layout of the master report

4.

In the ReportName property of the subReport1 element, type AR670050.rpx to specify the
subreport, which has been saved to the server.
If you save a subreport locally, you can click the
select this locally stored file.

5.

button in the ReportName property, and

Select the Parameters property of subReport1, and click the
button to open the
ExternalParameter Collection Editor dialog box, where you have to define parameters to be
transferred to the subreport. In this dialog box, add the following parameters, as shown in the
screenshot below:
•

Add the first parameter with the following settings:
•

Name: DateFrom

•

Nullable: True

•

Type: DateTime

•

ValueExpr: =@DateFrom

The date range parameters of the master report are optional. Therefore, you have to allow
the Null value to be transferred to the subreport if the user does not specify the date
range. This is why you set Nullable to True.
•

Add the second parameter with the following settings:
•

Name: DateTo

•

Nullable: True

•

Type: DateTime

•

ValueExpr: =@DateTo

Based on these settings, you transfer to the subreport the date range that the user
specifies for the master report.
If you use the Expression Editor to define ValueExpr, the value you selected will be
=[@DateTo]. This is the correct expression too.
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•

Add the third parameter with the following settings:
•

Name: SalesPersonID

•

Type: Integer

•

ValueExpr: =[SalesPerson.SalesPersonID]

You have to transfer the current salesperson from the group header section of the master
report to the subreport to show appropriate commission amounts in the chart. In the
filtering conditions of the subreport, the @SalesPersonID parameter is compared
with the SalespersonID data field of the ARSalesPerTran class. Thus, you transfer to the
subreport the identity of the current salesperson, whose commissions are listed in the
detail section of the master report.
The names and types of the parameters you are defining for the subReport1 element that holds
a subreport have to match the names and types of the parameters defined for the subreport.
However, you can define fewer parameters for a subReport1 element than a subreport has. In
this case, the default values, if any, of these skipped parameters of the subreport will be applied.

Figure: External parameters

6.

Click OK to apply the settings you made and close the ExternalParameter Collection Editor
dialog box.

7.

Save your changes to the master report.
You have added the subreport with the chart that shows each salesperson's commissions by
financial period in the Invoices Commissionable by Salesperson report. Now you can execute and
preview the report.

8.

Log in to the SalesDemo company of Acumatica ERP.

9.

Open the Invoices Commissionable by Salesperson form (AR670000; Finance > Accounts
Receivable > Reports >Audit), and run the report.
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Figure: The executed master report

You can declare a variable in a subreport and use this variable in a master report. For example,
you have added the $Test variable to the subreport. You added this subreport to the master report
with the subReport1 element. Now you can use the $Test variable of the subreport in the master
report as $subReport1_Test.

Lesson Summary
In this lesson, you have learned how to create subreports. To add a report as the subreport to a master
report, you should save the subreport to the same instance of Acumatica ERP where the master report
is. Then you should add the SubReport element to the layout of the master report. In this element,
you should select the subreport and specify the parameters to be transferred to this subreport, if
necessary. The names and types of these parameters have to match the names and types of the
subreport parameters.
You also added the Chart element to the report layout and configured this element.
Review Questions
1.

What chart types are not available for the Chart element in Acumatica Report Designer? Select
all that apply.
•

A. Table

•

B. Bar

•

C. Article

•

D. Range

•

E. Pyramid
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2.

3.

Select all the statements that are not applicable for transferring parameters to subreports.
•

A. The parameter names should match.

•

B. The number of parameters should match.

•

C. The parameter data types should match.

•

D. The order of parameters should match.

Suppose that you are going to add the subreport you have just created to an existing and
published master report. Select only the step or steps that must be performed.
•

A. Save the subreport to the instance of Acumatica ERP where the master report is.

•

B. Publish the subreport by adding the URL of the subreport to the site map.

•

C. Add the SubReport element to the layout of the master report.

•

D. Select the subreport in the ReportName property of the SubReport element.

•

E. Add the collection of parameters for the SubReport element to be transferred to the
subreport.

Answer Key
1 - A, C ; 2 - B, D; 3 - A, C, D.
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Lesson 6: Creating Tabular Reports
A tabular report is a report that displays information from the database in a format consisting of
multiple columns and rows. You can use a tabular report, for example, to see a breakdown of your sales
by salesperson and inventory item. In this case, the rows would be salespersons' names, the columns
would be inventory item names, and the cell at the intersection of each row and column would be the
total sales amount of the item by salesperson.
In this lesson, you will create a tabular report that shows the sum total (a cost) of invoiced items
sold by each salesperson. Each row of this report will contain an item, each column will contain a
salesperson, and the cell at their intersection will show the total sales sum of the item sold by the
salesperson. The total sales sum will be calculated from released invoices for the date range, which the
user can specify.
Lesson Objectives
In this lesson, you will learn how to create a tabular report. In particular you will do the following:
1.

Create the tabular report and select its data

2.

Specify the grouping conditions for the report

3.

Configure the layout of the report

4.

Publish and preview the report

1. Creating the Tabular Report and Selecting the Data
To create a tabular report that shows the amounts of invoiced items sold by each salesperson, you
have to use the ARTran, InventoryItem, and SalesPerson classes, as shown in the diagram below. The
ARTran class provides access to the invoice details. SalesPerson provides access to the salesperson
whose sold the item. The SalesPersonID field is a reference between the ARTran and SalesPerson
classes. InventoryItem provides access to the item that was included in the invoice. The InventoryID
joins the ARTran and InventoryItem classes.

Figure: The classes and the relationships between them

To create the tabular report and select the data, do the following:
1.

Start the Report Designer as follows: Start > All Programs > Acumatica > Report Designer.
When you open the Report Designer, a blank report form is displayed by default.

2.

On the menu bar, select File > Build Schema to open the Schema Builder wizard.

3.

On the Tables tab of the Schema Builder wizard, load the schema, and add the ARTran,
InventoryItem, and SalesPerson data access classes to the report, as shown in the screenshot
below.
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Figure: The data access classes of the report

4.

Apply your changes to the report.

5.

On the Relationships tab of the Schema Builder wizard, add the lines with the following
settings to link the ARTran and SalesPerson classes, as shown in the screenshot below:
•

•

6.

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARTran

Inner

SalesPerson

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

SalesPersonID

Equal

SalesPersonID

Add the lines with the following settings to link the ARTran and InventoryItem classes:
•

•

Enter the report table relations here area:
Parent Table

Join Type

Child Table

ARTran

Inner

InventoryItem

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

InventoryID

Equal

InventoryID
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Figure: The relationships between classes

7.

Apply your changes to the report.

8.

On the Parameters tab of the Schema Builder wizard, add two parameters with the following
settings to the parameters list (as shown in the screenshot below):
Name

Data Type

Prompt

Default Value

Allow Null

DateFrom

DateTime

Date From

=[@QuarterStart]

Selected

DateTo

DateTime

Date To

=[@QuarterEnd]

Selected

Based on the default values you entered, the report shows the data for the current quarter by
default.

Figure: The report parameters

9.

Apply your changes to the report.

10. On the Filters tab of the Schema Builder wizard, specify the following filter conditions (as
shown in the screenshot below):
Brackets

Data Field

Condition

Value 1

(

ARInvoice.DocDate

GreaterOrEqual

@DateFrom

Brackets

Operator
Or
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Brackets

(

Data Field

Condition

Value 1

Brackets

Operator

@DateFrom

IsNull

)

And

ARInvoice.DocDate

LessOrEqual

@DateTo

IsNull

ARTran.TranType

Equal

INV

And

ARTran.Released

Equal

1

And

Or

@DateTo
)

And

Based on the condition specified in two last rows of the table above with the ARTran.TranType
and ARTran.Released data fields, the report will contain only the data of released invoices.

Figure: The filter conditions

11. Click OK to apply your changes to the report and close the Schema Builder wizard.
12. Save the report with the AR680000.rpx name to the server.
2. Specifying the Grouping Conditions for the Report
To calculate the total sales sum of each inventory item sold by each salesperson, you have to group the
report data by salesperson and item. Do the following
1.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form.

2.

On the Properties tab, select the Groups property, and click the
Collection Editor dialog box.

3.

In the Group Collection Editor dialog box, add a new group and specify its (Name) as
SalesPerson.

4.

In the Grouping property of the SalesPerson group, click the
Collection Editor dialog box.

button to open the Group

button to open the GroupExp

In the GroupExp Collection Editor dialog box, add a grouping expression and specify its Data
Field as SalesPerson.SalesPersonID.
Based on this expression, the report data will be grouped by salesperson.
5.

Click OK to apply the settings you made and close the GroupExp Collection Editor dialog box.

6.

In the Group Collection Editor dialog box, add the second group and specify its (Name) as
Item.
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7.

In the Grouping property of Item group, click the
Editor dialog box.

button to open the GroupExp Collection

In the GroupExp Collection Editor dialog box, add a grouping expression and specify its Data
Field as InventoryItem.InventoryID.
Based on this expression, the report data will be grouped by inventory item.
8.

Click OK to apply the settings you made and close the GroupExp Collection Editor dialog box.

9.

In the Group Collection Editor dialog box, click OK to apply the grouping conditions and close
the dialog box.

10. Save your changes to the report.
3. Configuring the Tabular Report Layout
To modify the report layout, do the following:
1.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form, and specify the following settings:
•

StylesTemplate: TemplateForm.rpx

•

TabularReport: True

•

TabularFreeze: 272px

•

Width: 368px

Based on the value of TabularFreeze, the red line has appeared on the report layout, as shown
in the screenshot below. The line passes through all the group headers, the group footers, and
the detail sections of the tabular report. You should use the topmost group section for columns
of the tabular report and place columns to the right of the red line. A new column will be created
for each new group of the data of this group section.
For example, if you group the report data by customer, you can use the customer's name as the
header of report columns and place a text box with the appropriate data field right of the red
line.
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Figure: The tabular report layout

2.

Configure the page header section as follows (see the screenshot below):
•

Add a text box and specify the following settings to show the report name:
•

•

•

Value: Items Sold by Salesperson

Add text boxes with the following values to show the report parameters:
•

Value: Start Date:

•

Value: =IsNull(@DateFrom, '___/___/______')

•

Value: End Date:

•

Value: =IsNull(@DateTo, '___/___/______')

Select Report Params for the StyleName property of the text boxes added in the previous
step.

Figure: The page header section

3.

Configure the group header section for salespersons, which will contain the column headers, as
follows (see the screenshot below):
•

Click groupHeaderSection1 (Header of SalesPerson) to select the section, and specify
the following settings for the section properties:

| Lesson 6: Creating Tabular Reports | 161

•

PrintOnEveryPage: True.
Based on this setting, the group header section for salespersons will be printed on
every page.

•
•

StyleName: Bottom Line

Add the first text box left of the red line, and specify the following settings:
•

Value: Inventory Item

•

Size: 272px, 40px
This settings sets Width, which is the first attribute of the Size parameter, to 272px
and the Height, which is the second attribute of the Size parameter, to 40px,
respectively.

•

Add the second text box right of the red line, and specify the following settings:
•

Value: =Replace(CStr([SalesPerson.Descr]), ' ', '#010;')

•

Size: 96px, 40px

A new column will be created automatically for each salesperson's group because the text
box is right of the red line.
Based on the Value you entered, the column header will consist of each salesperson's
name. The first name and the last name will be separated by carriage return symbol. The
Replace() function you entered replaces the space with the #010; symbol, which is
the ASCII code of the carriage return (which begins a new line). Because the Replace()
function can be applied only to strings, you have to use the CStr() function. The CStr()
function converts its argument into a string.
You can place two or more text boxes or other elements right of the red line. All these
elements will be duplicated for each group of the group header section.

Figure: The group header section for each salesperson

4.

Configure the group header section for items, which will contain the list of items and the total
sales sum for each item by each salesperson who sold the item, as follows (see the screenshot
below):
•

Click groupHeaderSection2 (Header of Item) to select the section, and select Normal
as the StyleName of the section:

•

Add the first text box left of the red line, and specify the following settings:

•

•

Value: =[InventoryItem.Descr]

•

Size > Width: 272px

Add the second text box on the right of the red line and specify the following settings:
•

Value: =SUM([ARTran.TranAmt])

•

Size > Width: 96px
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Figure: The group header section of the item

5.

6.

7.

For the detail section (which will hold no elements), specify the following settings to hide the
section:
•

Height: 0px

•

Visible: False

For the group footer section of items (which will contain no elements), specify the following
settings to hide the section:
•

Height: 0px

•

Visible: False

Configure the group footer section for salespersons, which will contain the total sales sum of
invoiced items for each salesperson, as follows (see the screenshot below):
•

Click groupFooterSection1 (Footer of SalesPerson) to select the section, and select
Top Line as the StyleName of the section:

•

Add the first text box left of the red line, and specify the following settings:

•

•

Value: Total:

•

Size: 272px, 24px

Add the second text box right of the red line, and specify the following settings:
•

Value: =SUM([ARTran.TranAmt])

•

Size: 96px, 24px

Figure: The group footer section of salespersons

8.

Delete the page footer section.

9.

Save your changes to the report.
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Figure: The tabular report layout

You have configured the tabular report.
4. Publishing the Tabular Report
You have to add the URL of the tabular report to the site map in Acumatica ERP to give users the ability
to run the report. Complete the following steps:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

On the Site Map form (SM200520; System > Customization > Manage), in the left pane, select
Company > Finance > Accounts Receivable > Reports > Audit.

3.

In the table in the right pane, add a new row to the table, and specify the following settings:

4.

•

ScreenID: AR.68.00.00

•

Title: Items Sold by Salesperson

•

Url: ~/Frames/ReportLauncher.aspx?ID=AR680000.rpx

Save your changes to the site map.
Now you can run the Items Sold by Salesperson report.

5.

Add the report to a workspace in the modern UI as follows:
a.

If you are in the classic UI, switch to the modern UI.

b.

In the main menu, click Receivables.

c.

In the main menu, click configuration menu (three dots in the bottom left corner) and
then click Edit Menu to switch to the Menu Editing mode.

d.

Click Add Menu Item.

e.

In the Select Forms box, type Items Sold by Salesperson.

f.

Select the check box to the right of the Items Sold by Salesperson report.

g.

Click Add & Close to add the selected report to the workspace and close the dialog box.

h.

In the Other section of the workspace, find the Items Sold by Salesperson report, and,
on the report pop-up toolbar, click Edit (the pencil icon).

i.

In the Category box of the Form Parameters dialog box, select Reports.
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j.

Click OK to move the report to the Reports section and close the dialog box.

k.

In the Reports section, select the check box to the left of the Items Sold by Salesperson
report to add it to the quick menu by default.

l.

Click Exit Edit Menu to save you changes and exit the Menu Editing mode.

Notice that the Items Sold by Salesperson report appeared in the Reports section of the
Receivables workspace.
6.

Open the Items Sold by Salesperson report form (AR680000; Finance > Accounts Receivable >
Reports >Audit).

7.

On the Report Parameters tab, specify the report parameters, if needed.

8.

On the form toolbar, click Run Report to execute the report.

Figure: The executed report

Lesson Summary
In this lesson, you have learned how to create tabular reports. To configure the tabular report, You
specified the TabularReport parameter of the report as True. With the TabularFreeze parameter,
you divided the detail section and the group sections of the report with a vertical line into two areas.
You defined two groups for the report. You used the topmost group to define the report columns, and
the other group to define the row headers and column values. In the right area of the report, whose
contents are duplicated for each group, you placed the text boxes with the column headers, column
values, and column totals.
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Review Questions
1.

2.

3.

To create a tabular report, you should set that report property to that value.
•

A. ReportFormat to Tabular

•

B. TabularReport to True

•

C. TabularColumns to True

•

D. ReportType to Tabular

The TabularFreeze property divides a tabular report into two areas with a vertical red line.
What sections does the line pass through?
•

A. Detail

•

B. Page header, Detail, and Page footer

•

C. Group header, Detail, and Group footer

•

D. Group header and Group footer

How many elements that you have placed to the right of the red line of the tabular report will be
duplicated for each new group?
•

A. The first

•

B. The first and the second

•

C. All

Answer Key
1 - B; 2 - C; 3 - С.
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Lesson 7: Defining Additional Filters for Reports
A user can define additional filtering and sorting conditions for a report directly in Acumatica ERP
without using the Report Designer.
In this lesson, you will apply additional conditions to a report and specify a list of data fields to sort and
filter the report data.
Lesson Objectives
In this lesson, you will learn how to do the following:
1.

Specify additional sorting and filtering conditions

2.

Extend the list of properties to sort and filter report data

3.

Limit the list of sorting and filtering properties

1. Specifying Additional Sorting and Filtering Conditions
In Acumatica ERP, users can specify additional filtering and sorting conditions of a report on the
Additional Sort and Filters tab of the report form; an example is shown in the screenshot below.
Once you define additional filtering and sorting conditions of any report, you can save them as a template.

Figure: Viewing the additional sorting and filtering conditions

The Additional Sorting Conditions table lists the default sorting conditions of the report. The user
can specify additional sorting conditions. Also, the user can delete or change the default sorting
conditions. The next time the user opens the report, the default sorting conditions will be restored.
In the Additional Filtering Conditions table, the user can specify additional filtering conditions.
However, the user cannot see, delete, or modify the default filtering conditions.
To become familiar with these capabilities, log in to the SalesDemo company of Acumatica ERP, open
the Invoices Commissionable by Salesperson report form (AR670000; Finance > Accounts Receivable
> Reports > Audit), open the Additional Sort and Filters tab to view the default sorting conditions
(shown in the previous screenshot), and then run the report with the following settings (shown in the
screenshot below):
•

Date From: 1/1/2016

•

Date To: 6/30/2016

•

Salesperson: SP0002 - Michal Bujacek
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Figure: Executing the report with the default sorting and filtering conditions

Next, you will try to modify the filtering and sorting conditions of the report to see how these changes
affect the report data. Do the following:
1.

On the Additional Sort and Filters tab of the Invoices Commissionable by Salesperson report
(AR670000), perform the following instructions, as shown in the screenshot below:
•

In the Additional Sorting Conditions table, delete the sorting condition by invoice date
(which is there by default).

•

Add a row to this table, and specify the following settings, to show the largest commission
amounts first:

•

•

Property: AR Salesperson Comission.CommnAmt

•

Condition: Descending

In the Additional Filtering Conditions table, add a row, and specify the following
settings, to exclude from the report results commissions that are less than or equal to $10:
•

Property: AR Salesperson Comission.CommnAmt

•

Condition: Is Greater Than

•

Value: 10

Figure: Customizing the sorting and filtering conditions

2.

Run the report and view the results, as shown in the screenshot below.
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Figure: Running the report with customized sorting and filtering conditions

Keep in mind that sorting conditions are applied to only the data of the detail section of a report,
while filtering conditions can affect the data of the whole report.

By default, the user can select in the Property column any data field you used in the text boxes, or in
the sorting or filtering conditions of the report. You can extend or limit this list of available properties,
as described further in this topic.
2. Extending the List of Properties to Sort and Filter the Report Data
To extend the list of properties that the user can use to define sorting and filtering conditions of the
report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the menu bar, select File > Build Schema; the Schema Builder wizard appears.

3.

On the Viewer Fields tab of the wizard, do the following to add properties, as shown in the
screenshot below:
•

In the Name column of the first row, select Customer.Status.

•

In the Name column of the second row, select ARInvoice.Released.

Figure: Executing the report with customized sorting and filtering conditions

4.

Click OK to apply your changes to the report and close the Schema Builder wizard.

5.

Save your changes to the report.
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6.

Log in to the SalesDemo company of Acumatica ERP.

7.

Open the Invoices Commissionable by Salesperson report form (AR670000).

8.

On the Additional Sort and Filters tab, find in the list of properties the ones that you have
added, as shown in the following screenshot.

Figure: Reviewing the properties used to sort and filter the report data

3. Limiting the List of Sorting and Filtering Properties
To limit the list of properties that the user can use to define sorting and filtering conditions of the
report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form. In the ViewerFieldsMode property, select OnlySpecified. Based on this setting,
only the data fields specified on the Viewer Fields tab of the Schema Builder wizard will be
available for selection on the Additional Sort and Filters tab of the report form.
On the Viewer Fields tab of the Schema Builder wizard, you could add to the list of available
properties all the data fields used in the report. To do that, you would click the Load used fields
button.

3.

Save your changes to the report.

4.

Log in to the SalesDemo company of Acumatica ERP.

5.

Open the Invoices Commissionable by Salesperson report form (AR670000).

6.

On the Additional Sort and Filters tab, find that the list of available properties.
Notice that the list of available properties exactly matches the list you defined on the Viewer
Fields tab of the Schema Builder wizard, as shown in the following screenshot. Also notice
that the default sorting condition of the report by invoice date has been removed because the
ARInvoice.DocDate data field is not in the list of viewer fields.
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Figure: Reviewing the properties used to sort and filter the report data

Lesson Summary
In this lesson, you have learned how to sort and filter report data directly in Acumatica ERP.
With the Report Designer, you configured the list of properties used for sorting and filtering the report
data in Acumatica ERP. You extended the list of these properties with the Schema Builder wizard and
limited this list by changing the default value of the ViewerFieldsMode property of the report.
Review Questions
1.

2.

3.

On the Additional Sort and Filters tab of a report form, you can sort and filter the report data.
Select all activities you cannot perform.
•

A. Change or delete the default sorting conditions

•

B. Specify additional sorting conditions

•

C. Modify or delete the default filtering conditions

•

D. Specify additional filtering conditions

Suppose that MergeWithUsed (the default value) is selected as the value of the
ViewerFieldsMode property of a report. What data fields can a user select as the properties
of filtering and sorting conditions on the Additional Sort and Filters tab of the form of this
report? Select all that apply.
•

A. Any data field used in the text boxes on the report layout

•

B. Any data field used in the sorting conditions of the report

•

C. Any data field used in the filtering conditions of the report

•

D. Any data field listed on the Viewer Fields tab of the Schema Builder wizard

•

E. Any data field of the classes added to the report

Suppose that OnlySpecified is selected as the value of the ViewerFieldsMode property of a
report. What data fields can a user select as the properties of filtering and sorting conditions on
the Additional Sort and Filters tab of the form of this report? Select all that apply.
•

A. Any data field used in the text boxes on the report layout

•

B. Any data field used in the sorting conditions of the report

•

C. Any data field used in the filtering conditions of the report

•

D. Any data field listed on the Viewer Fields tab of the Schema Builder wizard

•

E. Any data field of the classes added to the report

•

F. None of the above
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Answer Key
1 - C; 2 - A, B, C, D; 3 - D.
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Lesson 8: Using Images and QR Codes
You can use images in your reports. You can add locally stored images in a report, show images from
the database, and generate a barcode or QR code.
In this lesson, you will create a report that lists stock items with the images uploaded for these items.
You can upload images to a stock item, as shown in the screenshot below, or to any other object or
entity,such as an employee or an invoice.

Figure: Stock item with uploaded files

You can upload files of various formats, as shown in the screenshot below. Thus, for the report, you
have to filter files to show only images.

Figure: List of uploaded files

Lesson Objectives
In this lesson, you will learn how to do the following:
•

Upload locally stored images to a report

•

Show images uploaded to the report

•

Show images stored in the database

•

Generate a QR code

Creating the Report and Selecting the Data
To create the report that lists stock items with uploaded images, you have to use InventoryItem,
UploadFile, NoteDoc, and UploadAllowedFileTypes classes, as shown in the diagram below. The
InventoryItem class provides access to the stock items. UploadFile provides access to the uploaded
files. The NoteDoc class links the InventoryItem and UploadFile classes by using the NoteId and FileId
fields, respectively. The UploadAllowedFileTypes class provides access to the file extensions that the
user can upload. You will use this class to filter images among the files uploaded to items.
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Figure: The classes and relationships between them

To create the report and select the data, do the following:
1.

Start the Report Designer; a blank report form is displayed by default.

2.

Open the Schema Builder wizard.

3.

On the Tables tab of the wizard, load the schema, and add the InventoryItem, UploadFile
(PX.SM.UploadFile), NoteDoc, and UploadAllowedFileTypes data access classes to the report.

4.

Apply your changes to the report.

5.

On the Relationships tab, specify the relationships between the added classes as follows:
a.

Add the lines with the following settings to link the InventoryItem and NoteDoc classes:
•

•

b.

Parent Table

Join Type

Child Table

InventoryItem

Inner

NoteDoc

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

NoteId

Equal

NoteId

Add the lines with the following settings to link the NoteDoc and UploadFile classes:
•

•

c.

Enter the report table relations here area:

Enter the report table relations here area:
Parent Table

Join Type

Child Table

NoteDoc

Inner

UploadFile

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

FileId

Equal

FileId

Add the lines with the following settings to link the UploadFile and
UploadAllowedFileTypes classes:
•

•

Enter the report table relations here area:
Parent Table

Join Type

Child Table

UploadFile

Inner

UploadAllowedFileTypes

Enter the data field links for the active relation area:
Parent Field

Link Condition

Child Field

FileExt

Equal

FileId
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To specify the expression in the Parent Field column, select the row and click the
Parent Formula button, as shown in the screenshot below.
You can specify an expression in the Child Field column by clicking the Child
Formula button.

The UploadFile.Name field holds the names of uploaded files. The file name ends with
an extension, as with filename.png. The UploadAllowedFileTypes.FileExt
field holds file extensions, such as .png. You cannot compare these fields directly. Thus,
you have to use the Right(str, length) text function. This function returns a string
containing the number of characters specified by the length argument from the right
side of a string specified by the str argument.
Based on the expression you specified for Parent Field, you can compare file extensions.
This allows you to link the UploadAllowedFileTypes and UploadFile classes selected in the
Enter the report table relations here area.

Figure: The relationships of the classes

6.

Apply your changes to the report.

7.

On the Filters tab of the Schema Builder wizard, specify a filtering condition with the following
settings:
•

Data Field: UploadAllowedFileTypes.IsImage

•

Condition: Equal

•

Value1: 1

Based on this condition, the report will show the images uploaded to stock items and won't show
other files. If a user uploads images with a new extension, the files with this extension will be
shown in the report automatically.
If you had to filter files by only one extension, you could do it without the UploadAllowedFileTypes
class. Instead, you might filter the report data by comparing the =Right([UploadFile.Name],
3) expression with the extension you need directly. For example, you might specify the following
settings for the condition you add on the Filters tab:
•

Data Field: =Right([UploadFile.Name], 3)

•

Condition: Equal

•

Value1: pdf
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8.

Click OK to apply your changes to the report and close the Schema Builder wizard.

9.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form.

10. Add a new grouping condition to the report with the following settings:
•

(Name): Item

•

KeepTogether: FirstDetail

•

Grouping > Data Field: InventoryItem.InventoryCD

Based on this condition, the report data will be grouped by stock item.
11. Save the report to the server with the IN660000.rpx name.
Configuring the Report Layout
To modify the report layout, do the following:
1.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form, and specify the following settings:
a.

In the EmbeddedImages property, click the
dialog box.

b.

In the dialog box, click the New image ... button, as shown in the screenshot below, and
select the report_header.png file, which is provided with this course and contains the
report name. (The Name and Mime Type of the selected file are defined automatically.)

button to open the Embedded Images

You can add images of the following types to the collection of embedded images: bmp, gif,
jpg, and png.

Figure: List of embedded images

c.

2.

Click OK to add the image you selected to the embedded images collection of the report
and to close the Embedded Images dialog box. Now you can use this image in the
report.

Configure the page header section as follows (see the screenshot below):
a.

Click the section header to select the section, and specify its Height as 64px.

b.

Adjust the width of the text box with the report name and the width of the picture box
with the company logo so that their combined width will equal the width of the report.

c.

Add a picture box and specify the following settings to print the embedded image with the
report name you have uploaded to the report:
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•

Source: Embedded
Based on this setting, the image will be taken from the list of embedded images of
the report.

•

Value: report_header
You can also show images uploaded to the site folder. If you were to do that, for the
image box, you would select Source as External and specify the URL of the image in the
Value property. For example, you have uploaded the MyImage.png file to the /Site/
Images/ folder. In the Value property, you should specify the following URL: Images/
MyImage.png.

d.

Adjust the width of the picture box with the embedded image so that it will equal the
report width and leave its height as is.

e.

Under the picture you have added, add text boxes with the following values to print
column headers:

f.

•

Value: QR-Code

•

Value: Item CD

•

Value: Item Name

•

Value: Images

Select all the text boxes added in this step, and enter 24px as their Size > Height.

Figure: Page header section

The group header section will contain the item whose images are listed in the detail section and
the QR code of this item.
3.

Configure the group header section as follows (see the screenshot below):
•

Click the section header to select the section, and specify its Height as 64px.

•

Add a picture box and specify the following settings to show the QR code of the item:
•

Source: Barcode

•

BarcodeType: QRCode
Based on these settings, the image will be a QR code.

•

Value: ='http://localhost/InstanceName/Main.aspx?
ScreenId=IN202500&InventoryCD='+[InventoryItem.InventoryCD]
Make sure that you has inserted the copied link fully, as the screenshot below shows.
Based on this value, each item group will contain the QR code that links to the
appropriate item. Notice that the link contains the application URL explicitly.
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Figure: The settings of the QR code

•

QRCodeSettings > CodeSize: 64
The default CodeSize of any QR code image is 50. If the length of the string you
specified as the Value is too long, the QR code will disappear from the image
preview on the report layout. If the user runs this report, the QR code will be
invisible too. The larger the string whose value you specified for the barcode, the
larger the CodeSize you should specify to make the image visible.
If you do not see the QR code on the report layout, the user will not see this QR code
in the executed report either.

•
•

•

Size: 64px, 64px

Add the first text box and specify the following settings:
•

Value: =[InventoryItem.InventoryCD]

•

Size > Height: 24px

Add the second text box and specify the following settings:
•

Value: =[InventoryItem.Descr]

•

Size > Height: 24px

Figure: Group header section

4.

The detail section will contain a list of the images uploaded to the item. Configure the section as
follows (see the screenshot below):
•

Click the section header to select the section, and specify its Height as 88px.

•

Add a picture box and specify the following settings:
•

Source: Database

•

Value: =[UploadFile.Name]

•

Sizing: Scale
Based on this setting, the image will be scaled to the size of the picture box so that
one of dimensions of the image and the picture box—height or width—should be
equal, the whole image should be visible, and the image proportion should remain.
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With the Fit sizing, the image fills the whole space of the picture box, and the image
proportion can be changed.

•

Size: 240px, 88px

Figure: Detail section

5.

Specify the following settings for the group footer section, which will contain no elements, to
hide the section:
•

Height: 0px

•

Visible: False

6.

Delete the page footer section.

7.

Save your changes to the report.

Figure: Final report layout

You have configured the report.
Publishing the Report
To add the URL of the created report to the site map in Acumatica ERP, do the following:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

On the Site Map form (SM200520; System > Customization > Manage), in the left pane, select
Company > Distribution > Inventory > Reports > Audit.

3.

In the table in the right pane, add a new row in the table, and specify the following settings:
•

ScreenID: IN.66.00.00

•

Title: List of Stock Items

•

Url: ~/Frames/ReportLauncher.aspx?ID=IN660000.rpx
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4.

Save your changes to the site map.

5.

Now you can execute the List of Stock Items report.
Open the List of Stock Items report form (IN660000; Distribution > Inventory > Reports
>Audit). On the form toolbar, click Run Report to preview the report, as shown in the
screenshot below.

Figure: Generated report

Lesson Summary
In this lesson, you have learned how to use images in reports. You uploaded an image to a report by
using the EmbeddedImages property of the report. You added the PictureBox elements to the report
layout to show this uploaded image and to show images stored in the database. You also configured a
picture box to show a QR code, which contained links to an Acumatica ERP form.
Review Questions
1.

2.

Select all the images you can show in a report.
•

A. An image uploaded to the report

•

B. An image uploaded to the site folder

•

C. Any image from the Internet

•

D. An image from the database

•

E. An image from the Partner Portal

•

F. A barcode

How can you add a QR code in your report. Select all that could apply.
•

A. Add to the report an image with this QR code as an embedded image and select this
image as the value of an picture box.

•

B. Select Barcode as the source of an picture box, select QRCode as the barcode type of
this picture box, and specify the text of the QR code as the value of the picture box.

•

C. Select Database as the source of an picture box, and as the value of this picture box,
specify the QRCode expression with the text of the QR code, such as: QRCode('The
text of the QR code').
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3.

Suppose that you have added a picture box with an image to your report. You also selected
Scale as the Sizing property of the picture box. When you execute the report, what will happen
with the image of this picture box? Select all the correct statements.
•

A. The image can be increased

•

B. One of dimensions of the image—height or width—equals the same dimension of the
picture box.

•

C. The image fills the whole space of the picture box.

•

D. The whole image is visible.

•

E. The image proportion is remain.

•
Answer Key
1 - A, B, D, F; 2 - A, B; 3 - A, B, D, E.
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Lesson 9: Using Alternative Colors in Report Data
You can use alternative colors—that is, different than the colors used by default, to mark report data
according to some conditions.
Suppose you have to modify the Customer Summary report (AR650500; Finance > Accounts Receivable
> Reports > Audit), which is shown in the screenshot below. You need to highlight customers' balances
that are greater than or equal to 10,000.

Figure: Customer Summary report

Lesson Objectives
In this lesson, you will learn how to do the following:
1.

Use color for report data according to some conditions

2.

Save a report as a new version

1. Using Color for the Report Data
To use color for report data based on the customer's balance amount, do the following:
1.

Start the Report Designer, and open the AR650500.rpx report from the server.
You can also open the report through Acumatica ERP by performing the following steps:

2.

•

Open the Customer Summary report (AR650500; Finance > Accounts Receivable > Reports >
Audit).

•

On the report form toolbar, click Edit Report. The system will suggest that you download the
AR650500.rps file.

•

Download and open the AR650500.rps file. The Open report from server dialog box
appears.

•

In the dialog box, type your password and click OK to open the report in the Report
Designer.

In the groupHeaderSection1 section, select the Sum([ARBalances.CurrentBal]) text box,
as shown in the screenshot below.
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Figure: Customer Summary report layout

This text box holds the following expression, which calculates each customer's current balance:
=Sum([ARBalances.CurrentBal]).
In the VisibleExpr property of the text box, type the following expression:
=Sum([ARBalances.CurrentBal])<10000. Based on this expression, the text box will be visible
when the customer's current balance is less than 10,000.
3.

Right-click the text box, and select Copy; then right-click the text box again, and select Paste
to duplicate the text box.
You can also duplicate the text box by selecting it on the report layout and then, on the main
window toolbar, clicking the

button and the

button sequentially.

A copy of the text box will be inserted in the same place and will overlap with the original text
box, as shown in the screenshot below.

Figure: Duplicated text box

4.

In the VisibleExpr property of the duplicated text box, modify the expression as follows:
=Sum([ARBalances.CurrentBal])>=10000. Based on this expression, the duplicated text box
will be visible when the customer's current balance is greater than or equal to 10,000.
In the Style > Color property, select Red to makes the color of the values of the duplicated text
box red.

You have customized the report.
2. Saving a Report as a New Version
You can save your report to the server as a new version, which allows you to revert your changes
quickly, if needed.
To save your changes to the report as a new version, perform the following steps:
1.

On the menu bar of the Report Designer, select File > Save to Server. The Save report on
server dialog box appears.

2.

To save the modified report as a new version, select the Save as new version check box, as
shown in the screen hot below.

3.

In the Version description text box, type the following: Current Balances >= 10,000 are
red.
The version description is an optional parameter.
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Figure: New version of the report being saved

4.

Click OK to save your changes to the report.

5.

Log in to the SalesDemo company of Acumatica ERP, and open the Customer Summary form
(AR650500; Finance > Accounts Receivable > Reports > Audit).
If you opened the report for editing from its report form in Acumatica ERP, you have to reload the
report form to get the changes you made.

6.

On the Report Version tab, find the version you saved, as shown in the screenshot below.

Figure: A new version of the report

The Active check box is selected for the version that will be used when the user runs the report.
Each new version is saved as active.
If you were to make a version active, you could perform one of the following steps:
•

Select the version on the Report Version tab, and click Activate on the tab toolbar.

•

Select the Active check box of the needed version.
When you click Edit Report on the form toolbar, the active version will be opened for editing. To
edit an inactive version, you can select it on the Report Version tab, and click Edit Version on
the tab toolbar.

7.

On the form toolbar, click Run Report to run the report and preview the changes you made, as
shown in the screenshot below.
Figure: The customized Customer Summary report
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Lesson Summary
In this lesson, you have learned how to use various colors to mark report data according to some
conditions. You duplicated the text box, whose color should depend on the text box value, and changed
its Style > Color property. Then, you configured the VisibleExpr property of both text boxes—the
original and the copy, which are overlapped—so that only one of them is visible at the moment.
You also saved the report to the server as a new version.
Review Questions
1.

2.

3.

How can you save the report as a new version? Select all that apply.
•

A. In the Report Designer, select the Save as new version check box when you save the
report to the server.

•

B. In Acumatica ERP, duplicate the report as a new version on the Report Versions tab of
the report form.

•

C. In the Report Designer, save the report locally with the different name.

•

D. In the Report Designer, specify a new version in the Version property of the report.

How cannot you activate a report version? Select all that apply.
•

A. In Acumatica ERP, on the Report Version tab of the report form, select the needed
version and click Edit Version on the tab toolbar. Open the report in the Report Designer
by opening the downloaded file, and save the report.

•

B. In Acumatica ERP, on the Report Version tab of the report form, select the needed
version and click Activate on the tab toolbar.

•

C. In Acumatica ERP, on the Report Version tab of the report form, select the needed
version and click Run Report on the form toolbar.

•

D. In Acumatica ERP, on the Report Version tab of the report form, select the Active
check box of the needed version.

Select all the correct sentences about the report versions.
•

A. You may enter a description for each version.

•

B. You cannot change the description of an existing version.

•

C. Only a report developer can switch report versions.

•

D. When a user runs a report, the active version of the report is executed.
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•

E. If you save a report as a new version, this version will replace the active one.

•

F. You can edit an inactive version of the report.

Answer Key
1 - A; 2 - A, C; 3 - A, D, F.
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Lesson 10: Translating Reports
Acumatica ERP provides built-in localization functionality. You can translate your report so that the user
can execute this report and get the result in the language selected during the login to Acumatica ERP.
The value of the Localizable property determines the multiple language support of a report. You can
specify this property for the whole report as well as for each element, such as a text box. The default
value of this property is True. This means that multiple languages are supported for reports and report
elements by default.
In this lesson, you will go through the whole process of translation of the List of Stock Items report
(IN660000) you created in Lesson 8: Using Images and QR Codes. The translation process will occur in
Acumatica ERP. You will not need the Report Designer, because you did not change the default value of
the Localizable property of the report or its elements.
When Acumatica ERP is first installed, its default language is English (United States). To translate the
report, you have to add at least one extra language to the system. In this lesson, the second language
will be Russian. You can perform the lesson tasks with this language, or you can choose another one;
the translation process will not differ.
Lesson Objectives
In this lesson, you will learn how to do the following:
•

Add additional languages to the system

•

Translate a report

Adding a Language to the System
The languages available in the system are listed on the System Locales form (SM200550). To add a new
language, do the following, as shown in the screenshot below:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

Open the System Locales form (SM200550; System > Management > Manage).

3.

Add a new string and specify the following settings:
•

Locale Name: ru-RU

•

Locale Name in Locale Language: Русский

•

Description: Russian

•

Sequence: 2

•

Active: Selected

Because the Active check box is selected, the user will be able to select this active language
during a login to Acumatica ERP. (You could translate your report into an inactive language, but
the user could not select this inactive language when logging in to Acumatica ERP.)

Figure: Specifying a list of available languages

4.

Save your changes to the locales.
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5.

Sign out of Acumatica ERP. Notice that the language combo box has appeared in the top right
corner of the login page of Acumatica ERP, as shown in the screenshot below. The languages in
this combo box are sorted according to their Sequence values.

Figure: Selecting a language during login

Translating the Report
To localize the report, you have to translate its source strings. Source strings include form names,
element labels, parameters, predefined values of parameters, and constant strings of variables and
formulas. To translate the report, do the following:
1.

On the Acumatica ERP login page, in the language combo box, select the Русский language, and
log in to the SalesDemo company.

2.

Open the List of Stock Items report form (IN660000; Distribution > Inventory > Reports
>Audit). The report does not have any parameters, so you will not translate the report
parameters. Run the report. Further in this lesson, you will use this executed report to find its
strings.

3.

Open the Translation Dictionaries form (SM200540; System > Management > Manage) in a new
browser tab. On this form, you can collect, filter, and then translate any strings of the Acumatica
ERP forms including reports.

4.

To collect the strings used in the system, on the form toolbar, click Collect Strings. This
operation may take a significant amount of time.
When you localize the system for the first time, or after you update your instance or publish any
report, you should collect all the strings used in the system for translation to get the new strings.
When the strings are collected, you can start translating the report.

5.

Specify the following settings to select the strings to translate, as shown in the screenshot
below:
•

Language: Русский
In this combo box, you should select the language you are going to translate the report
into.
You can select two or more languages, if you want to translate the report into multiple
languages simultaneously.

•

Show Only Unbound: Selected
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If you translate an Acumatica ERP form, you can select this form in the Show Used in
UI combo box. This filters the string in the Default Values area of the Collected tab
according to the selected form.
Reports and generic inquiries are not the forms you can select in the Show Used in UI
combo box, so their strings are unbound. You have to select the Show Only Unbound
check box. Based on this selection, all unbound strings will be shown in the Default
Values area of the Collected tab.
You can filter unbound strings by selecting some options of the Unbound Resources To
Display box.
In the Default Values area of the Collected tab, the strings selected for translation are listed.
You can type translations in the columns with language names (such as Русский) as their
headers, as shown in the screenshot below.
In the Key-Specific Values area of the Collected tab, the occurrences of the string selected
in the Default Values area are listed. If the string was found in many forms, you can translate
only its occurrences in the needed forms in this area.

Figure: Selecting the strings to translate

6.

To find the strings of your report, in the Default Values area of the Collected tab, click the
button to open the Filter Settings dialog box.
In the Filter Settings dialog box, specify the following settings, as shown in the screenshot
below, to use an additional filter:
•

Property: Source Value
Based on this setting, the strings of the Default Values area of the Collected tab will be
filtered by values of the Source Value column.

•

Condition: Contains

•

Value: List of Stock Items
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Figure: Filtering the report strings

To define the Value of the filter, you can use the generated report you opened in Step 1 (see
the screenshot below). Keep in mind that you can translate only the static text labels of the
report, but not the report data. For example, you can find on the Translation Dictionaries form
(SM200540) and translate the Item Name column header, but you cannot translate the Acer
Laptop Computer string, which is the data retrieved from the database.

Figure: Getting strings from the executed report

Click OK to apply your filtering condition and close the Filter Settings dialog box.
When the filter is applied, only one string remains in the Default Values area, as shown in the
screenshot below. According to the entries shown in the Key-Specific Values area, this string is
used in the List of Stock Items report (IN660000), which you are translating, and in the site map
for the same report.
7.

In the Русский column of the Default Values area, type the following value to translate the
string for both instances: Список Товаров.
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Figure: Translating the report string

8.

Save your translation.

9.

Repeat Steps 6 to 8 to find and translate the following strings:
•

QR-Code: QR-Код

•

Item CD: Код Товара

•

Item Name: Название Товара

•

Images: Изображения

You have translated the report.
10. Open the Список Товаров report form (IN660000; Distribution > Inventory > Reports >Audit),
and run the report to preview your translation (see the screenshot below).

Figure: Previewing the translated report
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Lesson Summary
In this lesson, you have learned how to translate a report. You added a new language on the System
Locales form (SM200550). On the Translation Dictionaries form (SM200540), you collected all the
strings used in the system. Among collected strings, you selected the strings of the report and
translated them.
Review Questions
1.

2.

3.

Select all the correct statements about translating reports.
•

A. You need the Report Designer to localize a report.

•

B. You can translate a report into any language from the list of languages on the System
Locales form (SM200550).

•

C. You can translate a report into multiple languages simultaneously.

How can you localize a report on the Translation Dictionaries form (SM200540)? Select only the
steps that you must perform.
•

A. Select the Language.

•

B. Select the Show Localized check box.

•

C. Select the report in the Show Used in UI box.

•

D. Select the Show Only Unbound check box.

•

E. Filter the report strings among the unbound strings, which appear on the Collected tab.

•

F. Translate the report strings.

On the Translation Dictionaries form (SM200540), you are trying to find and translate the strings
of a report but cannot find any. What are the possible reasons? Select all that could apply.
•

A. The value of the Localizable property of the report is False.

•

B. You have not selected the Show Only Unbound check box.

•

C. You have filtered the list of unbound strings by selecting some options of the Unbound
Resources To Display box.

Answer Key
1 - B, C; 2 - A, D, E, F; 3 - A, B, C.
Related Links
Translation Process
Managing Locales and Languages

| Lesson 11: Defining Excel Export Settings for Reports | 192

Lesson 11: Defining Excel Export Settings for Reports
The user can export executed reports to MS Excel. By default, the Excel Mode property of any report
is Auto, which is the minimum setting you need to export a report to Excel. Some reports are exported
readably by using this default setting. Otherwise, you can define exactly how a report should be
exported. In this lesson, you will configure the Invoices Commissionable by Salesperson report, which
you created in Lesson 4: Creating a Report and modified in Lesson 5: Using Subreports, to export it to
Excel.
Lesson Objectives
In this lesson, you will learn how to define Excel export settings for a report.
Exporting the Report to Excel with the Default Settings
To export the report to Excel, do the following:
1.

Log in to the SalesDemo company of Acumatica ERP.

2.

Open the Invoices Commissionable by Salesperson form (AR670000; Finance > Accounts
Receivable > Reports > Audit). Run the report.

3.

On the form toolbar, click Export > Excel to export the executed report to Excel with the
default settings, as shown in the following screenshot. (The exported report may look different
depending on the Excel version.)

Figure: The report exported to Excel with the default settings

Defining Excel Export Settings
To define the export settings to Excel for the report, do the following:
1.

In the Report Designer, open the AR670000.rpx report from the server.

2.

On the Properties tab, select the report1 Report object from the drop-down list to select the
report form.
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3.

In the Excel Mode property, select Manual. Based on this setting, you can set up manually how
the report should be exported.

4.

On the menu bar, select View > Excel Grid > Show Columns to show the Excel column grid.
By default, the width of all columns are the same, as shown in the screenshot below.

Figure: Default Excel column grid

In the right top corner of each element, notice two numbers divided by a colon. The first number
is the row to which the element content will be exported. This number is specified by the value
of the Excel Cell > Row property. By default, this value is 1. By changing this number, you
can define the order of elements within each exported section, but you cannot change the order
of sections. For example, in the report exported to Excel, you can print the company name
above the report name, but you cannot print the salesperson's name above any field of the page
header section. The second number is a column to which the element content will be exported.
This number is specified by the value of the Excel Cell > Column property. By default, this
value is 1.
You can generate the list of columns automatically according to the number and width of
elements of any section. The best way is to use the most populated section to get enough
columns.
5.

Right-click the detail section header and selected Generate Excel Columns in the shortcut
menu. The Report Designer generates the Excel column grid, as shown in the following
screenshot.
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Figure: Modified Excel column grid

If you need to refresh the Excel columns grid, on the menu bar, you can select View > Excel
Grid > Hide Columns, and then select View > Excel Grid > Show Columns.

You can also manually adjust the list of Excel columns generated for the report or define it from
scratch. To do that, you can select the report form, and in the Excel Columns property on the
Properties tab, click the
button to open the Int32 Collection Editor dialog box, which is
shown in the screenshot below. In this dialog box, you can adjust the number, order and size of
columns to export to Excel.
The number of the first 0 column corresponds to the A column of the Excel grid. You can specify
the width of each column by its Value property. The column width corresponds to the element
width in pixels in approximately a 1:6 ratio. For example, the width of a column with a Value of
10 is approximately equal to the width of a text box with a Size > Width of 60px.

Figure: List of columns to export
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After you specify the list of columns to export, you can define the row and column position of all
report elements.
6.

On the menu bar, select Edit > Adjust Excel Layout. The Report Designer changes the row and
column position of all the report elements depending on how they fit the Excel columns.
This functionality works accurately for simple report layouts but may work inaccurately for
some complicated layouts. Anyway, we recommend you to initially try this way of automatically
assigning the row and column position for report elements because you can always adjust them
manually.
Similarly, you can define the row and column position of elements of any particular section by right
clicking the section header and selecting Adjust Excel Layout in the shortcut menu.

7.

Adjust the position of each element content to export to Excel, as shown in the screenshot
below. The number on the left of each colon is Excel Cell > Row. The number on the right
of each colon is Excel Cell > Column. For example, for the Invoice Commissionable by
Salesperson text box, specify the following settings:
•

Excel Cell > Row: 1

•

Excel Cell > Column: 7

Figure: The modified report layout to export

8.

Specify the following additional settings:
•

For the group header section, in the Excel Margin > Top property, type 1 . Based on this
setting, one extra empty row will be printed before each group header section.

•

For the subReport1 element, in the Excel Visible property, select False . Based on this
setting, the subreport will not be exported in Excel.
The export of the SubReport, Chart, Line and ImageBox elements to Excel is not
supported. To export contents of the Panel element to Excel, you should specify the position
—a row and a column—of each element inside the panel.

•

For the page footer section, in the Excel Visible property, select False. Based on this
setting, the section will not be exported in Excel.
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You have configured the export settings.
9.

Save your changes to the report.

10. In Acumatica ERP, open the Invoices Commissionable by Salesperson report form (AR670000;
Finance > Accounts Receivable > Reports > Audit), and run the report. Then export the report to
Excel and preview how the report looks with the settings you made (see the screenshot below).

Figure: The report exported to Excel with the custom settings

Lesson Summary
In this lesson, you have learned how to define MS Excel export settings for a report if you are not
satisfied with the report exported with the default settings. You selected the Manual value for the Excel
Mode property. You created the list of columns to export. For each report element, you specified the
Row and Column values of the Excel Cell property group to arrange elements in the created columns.
Review Questions
1.

2.

Can you export to Excel the report with the default Excel export setting?
•

A. No, you cannot.

•

B. Yes, you can if the report has no more than three sections.

•

C. Yes, you can if the layout of your report contains only text box elements.

•

D. Yes, you can.

To customize the MS Excel export format of a report, you should set that report property to that
value.
•

A. Export Format to Excel
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3.

4.

•

B. Excel Mode to Manual

•

C. Export Type to Excel

•

D. Excel Format to Manual

Select the elements whose contents are exported to Excel.
•

A. SubReport

•

B. Chart

•

C. Line

•

D. ImageBox

•

E. None of the above

How can you define the set of rows for the report layout to export it to Excel? Select all that
apply.
•

A. Specify the collection of columns manually.

•

B. Export the set of columns of an Acumatica ERP report.

•

C. Generate the list of columns automatically according to the width of elements of any
selected section.

•

D. Export the set of columns of an Excel file.

Answer Key
1 - D; 2 - B; 3 - E; 4 - A, C.
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Part 3: Filters
In Acumatica ERP, forms often use tables, which are a convenient way to present data. However, when
a table spans multiple pages, it may be quite difficult to find needed information. Filters give you a way
to display only those records that you want to see at the moment.
All Acumatica ERP filters are form-specific—that is, if a filter is designed for one form, you cannot apply
the filter to another form.
In Lesson 7: Defining Additional Filters for Reports, you learned how to filter report data. In this part,
you will learn how to configure and manage reusable filters, which are used to filter data in the table
part of processing and inquiry forms.
As a result of completing the lesson of this part, you will be able to create filters for an inquiry form and
manage them.
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Reviewing Reusable Filters
Reusable filters in Acumatica ERP are filters that you can set up on processing and inquiry forms to
filter the table data both in the current user session and when you open the form in the future. You can
create and apply these filters any time you want to, and save them for future use.
Filter Tabs
By adding a reusable filter to a processing or inquiry form and saving the filter, you add a tab with the
filter applied to the form. You can see the following tabs on the Acumatica ERP processing and inquiry
forms after you have applied a reusable filter:
•

The All Records tab shows all records of the type shown on the form without any filter applied.
Once any filter is available for the form (whether it is created by the user or shared with the
user), this tab appears automatically as the first tab.

•

The Filter Applied tab, which appears if you are defining a filter but have not yet saved it, shows
the data with the unsaved filter applied. If you do not save the new filter before your user session
ends, the system deletes the filter.

•

The names of any other tabs are the name of each respective reusable filter defined and saved for
the form.

Filter Clauses
When you create a filter you add one filter clause or multiple filter clauses. Each filter clause contains
a form element (such as a box or check box) associated with the particular form, a condition (logical
operation), and the value or values of the selected element. You can use And and Or operators and
parentheses to group clauses into logical expressions.
A reusable filter may contain active and inactive clauses. When a filter is applied, the active clauses are
applied to the table, and the inactive clauses are ignored.
User-Relative and Date-Relative Filter Clauses
Filter clauses can be user-relative and date-relative. These clauses contain special parameters as a
value.
User-relative clauses are clauses for which the system filters data relative to the user that is currently
signed in. You can configure user-relative clauses by using one of three predefined user-relative
parameters. You can use the @Me parameter for the user-relative properties with the Equal or Does
Not Equal conditions. You can also filter data by the workgroup or workgroups the signed-in user is a
member of by using the @MyGroups parameter for the Workgroup property, with the Is In or Is Not
In conditions. Similarly, you can use the @MyWorktree parameter to include in the list of the user's
workgroups the subordinate workgroups according to the structure of the company tree.
Date-relative clauses contain a date and date-relative parameters, which relate to the current date. For
example, you can use the @Today parameter to relate a clause to the current day. Other date-relative
parameters relate a clause to a current week, month, quarter, and year. You can modify the daterelative parameters by adding or subtracting integers. For example, the @WeekStart - 1 expression
returns the first day of the previous week, and the @Today + 2 expression returns the day after
tomorrow.
Shared Filters
Shared filters are a type of reusable filters that are available for every user of your instance. You use
the Filters form (CS209010; System > Customization > Manage) to create, modify, and delete the
shared filters.
For more details on reusable filters in Acumatica ERP, see the links in the following section.
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Related Links
Reusable Filters
Reusable Filter Settings Reference (the Filter Settings Dialog Box)
Creation of Ad Hoc and Reusable Filters
Filter Settings Reference (Parameters of Shared Filters)
Shared Filters
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Lesson 12: Using Reusable Filters
You can create reusable filters for any processing or inquiry form to filter the data of the table shown
on the form. Once you create a reusable filter for a particular form, you can reuse it anytime you open
that form in the future. Reusable filters are shown as tabs on the form. You can create reusable filters
for your personal use or share them with other users.
In this lesson, you will create reusable filters for the AR-Invoices inquiry and manage them. In Lesson
2: Configuring an Inquiry as the Entry Point, you set up this inquiry as the entry form of the Invoices
and Memos form (AR301000).
Lesson Objectives
In particular, in this lesson, you will learn how to do the following:
•

Create reusable filters

•

Share reusable filters

•

Modify reusable filters

•

Delete reusable filters

•

Manage shared reusable filters
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Step 12.1: Creating Reusable Filters
For the AR-Invoices inquiry, you will create four filters. Each filter will show data that meets one of the
following criteria:
•

Open invoices

•

Documents of the current user

•

Documents for the current quarter

•

Documents for the previous quarter

To create the first filter, a reusable filter that will display only open invoices, do the following:
1.

Create the first reusable filter that will display only open invoices. Do the following:
a.

Sign in to the SalesDemo company of Acumatica ERP.

b.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area). The
AR-Invoices inquiry, which you set up to be the entry form of this form, opens.

c.

On the table toolbar, click Filter Settings (
the Filter Settings dialog box.

), shown in the screenshot below, to open

Figure: Opening the Filter Settings dialog box

d.

In the Filter Settings dialog box, add two rows with the following settings, as shown in
the screenshot below.
Property

Condition

Value

Status

Equals

Open

Type

Equals

Invoice

In the Property column, you could select any column of the table the filter will be
applied to. In this case, you selected Status because you need to display on the form only
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documents with the Open status; you also selected Type because you need to display on
the form only invoices.
In the Condition column, you could select the logical operation that applies to the value
of the selected property. In this case, you selected Equals in both clauses because you
want to filter the selected properties by the exact values.
e.

Click Save to save the filter for future use.

f.

In the Enter the filter name here box of the dialog box that appears, type the name of
the new filter as Open Invoices, and click OK to save the filter.

g.

Select the Default check box to use this filter as the default filter for the form.
In the future, when you open the form, the default filter will be applied automatically.

Figure: Defining filter settings

h.

Click OK to close the dialog box and apply the filter.
When you close the dialog box, on the Invoices and Memos form, two tabs appear, as
shown in the following screenshot.

Figure: Reviewing the Open Invoices filter tab

2.

Create a filter that displays the current user's documents as follows:
a.

On the table toolbar of the Invoices and Memos form, click Filter Settings (
the Filter Settings dialog box.

b.

In the Filter Settings dialog box, click New to create a new filter and clear the filter
table.

c.

Add a row with the following settings.

) to open
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Property

Condition

Value

Owner

Equals

@Me

Owner is a column of the table. Any column of the table, even a hidden one, could be
selected as the property.
d.

Save the filter with the following name: My Documents.
In the following screenshot, you can see the settings of the My Documents filter.

Figure: Reviewing the settings of the My Documents filter

3.

Create the third filter, which will list documents for the current quarter, as follows:
a.

In the Filter Settings dialog box, create a new filter.

b.

Add a row with the following settings.

c.

Property

Condition

Value

Value2

Date

Is Between

@QuarterStart

@QuarterEnd

Save the filter with the following name: Current Quarter.
In the following screenshot, you can find the settings of the Current Quarter filter.

Figure: Reviewing the settings of the Current Quarter filter

4.

Create the fourth filter that lists documents for the previous quarter. Do the following:
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a.

In the Filter Settings dialog box, create a new filter.

b.

Add a row with the following settings.

c.

Property

Condition

Value

Value2

Date

Is Between

@QuarterStart - 1

@QuarterEnd - 1

Save the filter with the following name: Previous Quarter.
In the following screenshot, you can find the settings of the Previous Quarter filter.

Figure: Reviewing the Previous Quarter filter settings

After you have created and saved all four filters, the tabs that correspond to each filter appear on the
Invoices and Memos form; see the following screenshot.

Figure: Reviewing the form with filter tabs

You can find examples of reusable filters on the Tasks form (EP404000; Organization > Communication >
Tasks).
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Step 12.2: Sharing Reusable Filters
To make two of your reusable filters available to other users of the system, you will share them.
To share the Current Quarter and Previous Quarter filters, do the following:
1.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area).

2.

On the Current Quarter tab, click Filter Settings ( ) on the table toolbar. The Filter
Settings dialog box opens with the Current Quarter filter selected.

3.

In the dialog box, select the Shared check box.

4.

Click Save to save the filter.

5.

In the filter name box, select Previous Quarter.

6.

Select the Shared check box, and save the filter.

7.

In the filter name box, select Open Invoices.

8.

Select the Shared check box, and save the filter.

9.

Click OK to close the dialog box.

Now other users of the system can view the Current Quarter and Previous Quarter filters on the
Invoices and Memos form.

| Step 12.3: Modifying a Reusable Filter | 207

Step 12.3: Modifying a Reusable Filter
You can modify a reusable filter on the form it was applied to if the filter is not shared. (Modification of
shared reusable filters is described in Step 12.5: Managing Shared Reusable Filters.)
Now you will modify a reusable filter. Do the following:
1.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area).

2.

On the Open Invoices tab, click Filter Settings ( ) on the table toolbar. The Filter Settings
dialog box opens with the Open Invoices filter selected.

3.

In the Filter Settings dialog box, clear the Default check box.

4.

Click Save to save the filter.

5.

In the Filter Name box, select Current Quarter.

6.

Add a line with the following settings to the filter conditions, as shown in the screenshot below.
Property

Condition

Value

Status

Equals

On Hold

The Current Quarter filter is shared, and thus the Save button is unavailable. (That is, you
cannot save changes to this filter.) You can, however, click Save As and save the filter with
another name.
7.

Click Save As, and save the filter with the following name: Documents On Hold for Current
Quarter.

Figure: Modifying the filter settings

8.

Click OK to close the dialog box.

You have modified the reusable filter and created a copy of the shared filter.
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Step 12.4: Deleting Reusable Filters
You can delete reusable filters on the form they were applied to as long as the filters are not shared.
(The management of shared filters, including their deletion, is described in Step 12.5: Managing Shared
Reusable Filters.)
Now you will delete a reusable filter that is not shared. Do the following:
1.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area).

2.

On the Documents On Hold for Current Quarter tab, click Filter Settings ( ) on the table
toolbar. The Filter Settings dialog box opens with the Documents On Hold for Current Quarter
filter selected.

3.

Click Remove to delete the filter.

4.

Click OK to close the dialog box.

You have deleted the reusable filter.
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Step 12.5: Managing Shared Reusable Filters
You can create, modify, and delete shared reusable filters on the Filters form (CS209010); you cannot
modify or delete these filters on the form they are applied to.
Now you will manage shared reusable filters. Do the following:
1.

Modify the settings of a shared reusable filter as follows:
a.

On the Filters form (CS209010; System > Customization > Manage), in the Filter ID
box, click the magnifier icon and type Current to find Current Quarter, as shown in the
screenshot below. Select this option.
You can also search for a filter by typing the screen identifier of the form the filter is
applied to.

Figure: Searching for an existing shared filter

b.

c.

d.

Change the filter settings to the following:
•

Name: Current Year

•

Is Default: Selected.

Change the filter condition settings to the following:
•

Value: @YearStart

•

Value2: @YearEnd

Save your changes to the filter.
Notice that the Filter ID has been changed and now is equal to the filter name.

e.
2.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area). Notice
that the Current Year tab is opened by default.

Stop sharing the Open Invoices filter. Proceed as follows:
a.

On the Filters form (CS209010), select the Open Invoices filter.

b.

On the form toolbar, click Make Filter Not Shared. In the warning dialog box that
appears, click OK.
The filter is no longer shared; it is no longer shown on the Filters form (CS209010),
where you can manage only shared filters.

c.

Save your changes to the filter.
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d.
3.

On the table toolbar, click Filter Settings ( ) to open the Filter Settings dialog box,
and make sure that the Shared check box is cleared for the Current Year filter.

Delete a shared filter as follows:
a.

On the Filters form (CS209010), select the Previous Quarter filter.

b.

On the form toolbar, click Delete.

c.

In the dialog box, click OK to confirm the deletion of the filter.

d.

Open the Invoices and Memos form. Notice that the Previous Quarter tab disappeared.
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Lesson Summary
In this lesson, you have learned how to filter the data in the tables of processing or inquiry forms. You
used the Filter Settings dialog box to create several reusable filters for an inquiry form. You opened
this dialog box by clicking Filter Settings ( ) on the table toolbar of the inquiry form, and managed
these filters on this form. Also, you shared some reusable filters with other users and managed these
shared filters on the Filters form (CS209010).
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Review Questions
1.

2.

3.

Can you edit the filter for the All Records tab of the table on an Acumatica ERP form?
•

A. Yes, you can.

•

B. Yes, you can, if this filter is not shared.

•

C. No, you cannot.

Will the system create a new reusable filter after you have specified filter settings and clicked
OK in the Filter Settings dialog box without saving the filter?
•

A. Yes, the system will create a filter.

•

B. Yes, the system will create a filter, but the filter will be deleted when your user session
ends.

•

C. No, the system will not create a filter.

Can you edit a shared reusable filter in the Filter Settings dialog box?
•

A. Yes, you can.

•

B. Yes, you can, but you can save only a copy of the reusable filter with a different name.

•

C. No, you cannot.

Answer Key
1 - C; 2 - B; 3 - B.
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Part 4: Dashboards
A dashboard is a collection of widgets displayed on a single page to give you needed information at a
glance.
In this part of the course, you will learn how to create and configure dashboards. In particular, you will
learn how to do the following:
•

Create dashboards

•

Add widgets to a dashboard

•

Manage widgets

•

Set up a dashboard as the home page
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Reviewing Dashboards
By using dashboards, each of which is a collection of widgets on a page, users can view the information
they are most likely to need and can quickly access further details. With Acumatica ERP dashboards,
users can monitor current financial, operational, and organizational information, and analyze real-time
trends in their scope of responsibility. You can create personalized dashboards to display exactly the
information you need, depending on your role and responsibilities.
Types of Widgets
A widget is a small component of a dashboard that delivers a particular type of information. You can
add the following types of widgets to any dashboard:
•

Charts: Charts are graphical representations of data from Acumatica ERP forms. You can use
charts of various types, such as bar charts and line charts.

•

Data tables: Tables are data from an Acumatica ERP form arranged into rows and columns.

•

Embedded pages: Embedded pages are documents or images that are stored on external
resources, such as cloud storage.

•

Power BI tiles: Charts, scorecards, and other analytical information can be represented on
Power BI dashboards designed by your organization.

•

Scorecard KPIs: Scorecard KPIs display parameters that are important for the business
processes of your organization and that should be monitored on a daily basis.

•

Trend card KPIs: Trend card KPIs display parameters whose dynamic change is important for
the business processes of your organization.

•

Wiki pages: Wiki pages display reference articles, procedures, business plans, and other content
that is frequently referenced by users of Acumatica ERP.

Location of Dashboards
You can create dashboard pages and place them in the site map where they are most convenient
for users who could use the dashboards in their daily work. In the modern UI, dashboards that you
add to the system appear in the Dashboards workspace, which is predefined in the system. You can
add a dashboard to any other workspace manually in Menu Editing mode. For details on configuring
workspaces, see the links at the end of this topic.
Work with Dashboards
From a widget created from an inquiry form, you can open the source inquiry form and drill down
to view the underlying data. By viewing a widget created from a processing form, you can monitor
whether there are new entities to be processed by using the relevant source form.
If additional filtering conditions have been specified during the creation of the widget (such as a range
of dates), the system applies this filter to the form that was used as a data source when you open a
form by clicking the widget.
Access Rights to Dashboards
Dashboards are visible to users depending on their access rights to these dashboards. An administrator
can configure specific access rights to dashboards for different roles. Users who will work with
dashboards can be given any of the following access rights capabilities:
•

Managing dashboard pages: Users with this capability can create new dashboard pages, delete
dashboard pages, set up access rights to dashboard pages, and populate the dashboard pages
with widgets. With regard to access rights to dashboards, these are the most powerful users.
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•

Configuring an original dashboard: Users with this capability can modify widgets on an original
dashboard and reset all user copies to the original settings. These users are regarded as
dashboard owners.

•

Viewing dashboards: Users with this capability can only view information on a dashboard.
These users are the least powerful dashboard users because they cannot modify widgets on a
dashboard.

•

Personalizing a dashboard: Users with this capability can view and modify widgets on their copy of
a dashboard.

Related Links
Dashboards
Dashboard Pages
To Add a Link to a Workspace
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Lesson 13: Creating and Managing Dashboards
In this lesson, you will create a public dashboard and a personal dashboard, add widgets to these
dashboards, manage these widgets, and set up the public dashboard as a default home page and the
personal dashboard as your home page.
Lesson Objectives
In this lesson, you will learn how to do the following:
•

Create a dashboard that is visible to all employees

•

Add a chart widget to a dashboard

•

Change the type of a chart widget

•

Add a scorecard KPI widget to a dashboard

•

Change the settings of a scorecard KPI widget

•

Add a trend card KPI to a dashboard

•

Embed an external webpage to a dashboard

•

Arrange widgets on a dashboard

•

Set up a dashboard as a default home page

•

Create a dashboard for a particular user role

•

Add a table widget to a dashboard

•

Add a chart widget to a dashboard

•

Add an article widget to a dashboard

•

Create a custom widget and add it to a dashboard

•

Set up a dashboard as your personal home page

•

Set up a dashboard as a personal page for any user
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Step 13.1: Creating a Dashboard That Is Visible to All
Employees
After you have deployed your Acumatica ERP instance, you may want to add a dashboard page that
will be used as a default home page. This dashboard page must be visible to all employees of your
organization who use the system. You use the Dashboards form (SM208600) to create, manage, and
delete dashboards in the system.
In this step, you will create a dashboard page and specify users' access rights to the dashboard page.
Do the following:
1.

Sign in to the SalesDemo company of Acumatica ERP.

2.

Open the Dashboards form (SM208600; System > Customization > Manage).

3.

On the form toolbar, click Add New Record.

4.

In the Name box, type the name of the new dashboard: SalesDemo.
The dashboard name should be unique within the system, because it is used as the identifier of
the dashboard.

5.

To the right of the Site Map Location box, click Add New Node.

6.

In the Add New Dashboard Node dialog box, which opens, do the following:
a.

In the Folder box, select Shared Dashboards (Company > Organization), as shown in the
following screenshot.

Figure: Selecting a dashboard location

By selecting a folder for a dashboard in the Folder box, you define the location of the
dashboard in the site map. In the modern UI, the dashboard will be automatically added
to the Data Views workspace.
b.

In the Title box, type the title of the node: SalesDemo.

c.

Click Add to save your changes and close the dialog box.
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7.

In the Owner Role box, select DashboardDesigner.
Users with the dashboard owner role (in this case, DashboardDesigner) have full access to
the dashboard. That is, they can edit the dashboard page and manage the widgets on the
dashboard.

8.

Clear the Allow Users to Personalize check box.
This setting means that users cannot create their personal copy of this dashboard and edit it.

9.

In the Visible to table, select all roles by clicking the unlabeled check box in the table header.
You have allowed users with all roles assigned to view the dashboard page.

10. On the form toolbar, click Save.
After you have performed these instructions, you will see the dashboard settings displayed in the
following screenshot.

Figure: Reviewing the settings of the SalesDemo dashboard

Now that you have created the dashboard, you need to add widgets to it.
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Step 13.2: Adding a Chart Widget to the SalesDemo Dashboard
Now you need to populate the dashboard with widgets. First, you will add to the SalesDemo dashboard
a chart widget that displays the top ten customers by total sales during the last activity period, using
data from the Customer Summary form (AR401000). Do the following:
1.

In the Search box on the top panel of the Acumatica ERP screen, type SalesDemo to find the
SalesDemo dashboard, and click the link under Dashboards to open the dashboard (see the
following screenshot).

Figure: Searching for a dashboard

Alternatively, you can open any dashboard from the Dashboards form (SM208600; System >
Customization > Manage) by selecting that dashboard by its name and then clicking View on
the form toolbar.
2.

On the dashboard title bar (top right), click Design to turn on design mode for the dashboard.

3.

On the widget placeholder, click add a new widget.

4.

In the Add Widget dialog box, which opens, click Chart and then click Next.

5.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Inquiry Screen box, select Customer Summary (Company > Finance > Accounts
Receivable > Work Area > Explore), which is the form whose data will be used for the
chart widget.
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b.

Click Inquiry Parameters, and in the Inquiry Parameters dialog box (which opens),
clear the Split by Currency check box to list customers' total sales regardless of the
currency of the items and services sold.
In the Inquiry Parameters dialog box, you can specify the values of the form
parameters to be used to select the displayed data; otherwise, the default values will be
used.

c.

Click OK to close the Inquiry Parameters dialog box.

d.

Make sure the Shared Filter to Apply box contains the default value: All Records.
In this box, you can select any shared filter that has been created for the selected form.

e.

Click Configure to specify the settings of the chart.

f.

In the Chart Settings dialog box, which opens, do the following:
a.

In the Chart Type box, select Doughnut.
A doughnut chart is a circular chart divided into sectors or parts that illustrate
proportions. This type of chart effectively conveys how the parts compare to one
another.

b.

In the Legend box of the Categories section, select Customer Name.
The selected parameter of the form is used to label the names of the sectors on
the doughnut. Based on the selected value, the customers' names will be the
labels of the sectors.

c.

In the Sort By boxes, make sure the default values are selected: Legend Values
and Descending.
In these boxes, you select the sort order for the legend data. The left box defines
the sequence to be sorted, and the right box defines the sort order.

d.

Make sure that the Legend Position box, which appeared when you when you
made a selection in the Legend box, contains the default value: Popup.
The legend position is the location of the legend on the widget. With the selected
value, the user can open the legend as a pop-up box by clicking the icon in the
bottom left corner of the widget. The Legend Position box is displayed for only
doughnut and funnel chart types.

e.

In the Maximum Number of Values Shown box, make sure the default value of
10 is selected.

f.

Make sure the Show Sum of Other Entities check box is cleared.
If you had selected this check box, the values that are not among the largest
values (those whose number is specified in the Maximum Number of Values
Shown box) would be summed and shown on the chart as a single element. With
the check box cleared, the system will display only the ten largest values on the
chart.

g.

In the Value boxes of the Values section, in the left box, select PTD Sales, and in
the right box, make sure that the default Sum value is selected.
The parameter of the form that you select in the left box defines the size of
doughnut sectors. You have selected PTD Sales, which holds the total amount
(in the base currency) of the period-to-date sales for the specified period. You
have specified no period in the inquiry parameters. Thus, PTD Sales shows the
total sales amount of a customer during the last period in which any transactions
related to the customer were released.
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In the right box, you select the aggregation function, which the system uses to
perform a calculation on the column of data selected in the Value box and return
a single value. The Sum function, which you have selected, calculates the sum of
the items in the column.
h.

In the Format box, select 0.00.
In this box, you can select the format of the numeric values.

i.

Review the settings of the doughnut chart (see the following screenshot).

Figure: Reviewing the settings of the chart

j.

Click OK to save your changes and close the Chart Settings dialog box.

g.

In the Caption box, type Top 10 Companies.

h.

Click Finish to save your changes and close the Widget Properties dialog box.

6.

Drag the bottom right corner of the widget placeholder to widen the widget area so that the
company names appear on the widget.

7.

On the dashboard title bar, click Design to turn off design mode.

In the following screenshot, you can see the dashboard with the chart widget. You can click the legend
icon in the bottom right corner of the widget to view the chart legend.
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Figure: Viewing the SalesDemo dashboard with the doughnut chart

Now that you have added the chart widget to the SalesDemo dashboard, you will change its type from
Doughnut to Columns in the next step.
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Step 13.3: Changing the Type of a Chart Widget
At any time, you can change the type of chart that is used for a widget.
In this step, you will change the type of the Top 10 Companies chart from Doughnut to Columns.
Proceed as follows:
1.

Open the SalesDemo dashboard.

2.

On the title bar of the dashboard, click Design to turn on design mode.

3.

On the toolbar of the Top 10 Companies widget, click Edit (the pencil icon).

4.

In the Widget Properties dialog box, which opens, click Configure.

5.

In the Chart Type box, select Column.
Notice that the Legend Position box has disappeared and the Series group of boxes has
appeared in the dialog box, as shown in the following screenshot.

Figure: Reviewing the settings of the column chart

The Legend box of the Categories section contains the element whose values the system will
display on the horizontal or vertical axis, depending on the type of chart. For example, for the
column chart, the element values are displayed on the horizontal axis.
The Legend box of the Series section contains the element whose values the system will use
for additional data view. For example, in the stacked column chart, the values of this element
are displayed as sections of the chart column for each category.
The Value box of the Values section contains the element whose values the system will use in
the data area on the horizontal or vertical axis, depending on the type of chart. For example, for
the column chart, the element values are displayed on the vertical axis.
6.

Click OK to save your change and close the Chart Settings dialog box.

7.

Click Finish to save your changes and close the Widget Properties dialog box.

8.

On the dashboard title bar, click Design to turn off design mode of the dashboard.

As you can see in the following screenshot, the doughnut chart was changed to a column chart where
columns are sorted in descending order by the values of the PTD Sales element on the Customer
Summary form (AR401000).
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Figure: Viewing the SalesDemo dashboard with the column chart

Now that you have added the chart widget to the SalesDemo dashboard, you will add a scorecard KPI
widget to the same dashboard in the next step.
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Step 13.4: Adding a Scorecard KPI Widget to the SalesDemo
Dashboard
The second widget that you will add to the SalesDemo dashboard is a scorecard KPI (key performance
indicator) widget that displays the average deal size. (In our example, the average deal size is
calculated based on totals of closed sales orders).
You can configure the scorecard KPI widget to indicate the level of a parameter directly or conversely. You
use the direct way for parameters whose lower values indicate that the performance is good (such as the
number of unprocessed support requests). You use the converse way for parameters whose lower values
indicate that the performance is dissatisfied (such as the average deal size).

Do the following:
1.

On the title bar of the SalesDemo dashboard, click Design to turn on design mode.

2.

On the widget placeholder to the right of the Top 10 Companies widget, click the add a new
widget link.

3.

In the Add Widget dialog box, which opens, click Scorecard KPI and then click Next.

4.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Inquiry Screen box, select DB SO Total (Company > Hidden > Hidden Generic
Inquiries), as shown in the following screenshot.

Figure: Selecting a generic inquiry

b.

Make sure the Shared Filter to Apply box contains the default value: All Records.

c.

In the Scorecard Title box, type Average Deal Size.

d.

In the Field to Aggregate box, select Order Total.
The widget will aggregate the total sums of sales orders.
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e.

In the Aggregate Function box, select Average.
With this setting, the system calculates the average of sales order totals.

f.

In the Normal Level box, type 20,000.
In this box, you have typed the low end of the normal range of the budgeted deal size.

g.

In the Alarm Level box, type 30,000.
In this box, you have typed the desired average deal size.

h.

In the Normal Color box, select Acumatica Red.
If the average deal size is less than or equal to the threshold you have specified in the
Normal Level box, the system will use the color selected in the Normal Color box for
the widget background. You have selected the red color in this box because the low deal
size may indicate about improper performance of the sales department.

i.

In the Warning Color box, keep the default value: Acumatica Yellow.
If the real average deal size is between the values specified in the Normal Level and
Alarm Level boxes, the system will use the color specified in the Warning Color box for
the widget background. You have selected the yellow color in this box to indicate that the
average deal size is not as good as it is expected to be.

j.

In the Alarm Color box, select Acumatica Green.
If the real average deal size is equal to or greater than the value specified in the Alarm
Level box, the system will use the color specified in the Alarm Color box for the widget
background. You have selected the green color in this box to indicate that the average
deal size is equal to or above the desired figure.

k.

Keep the Automatically Adjust Front Size check box selected.
With this check box selected, the size of the font used in the widget is adjusted
automatically, depending on the widget size.

l.

Keep the Caption box blank.

m. Review the properties of the scorecard KPI widget (see the following screenshot).
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Figure: Reviewing the properties of the widget

n.
5.

Click Finish to save your changes and close the Widget Properties dialog box.

On the dashboard title bar, click Design to turn off design mode.

You can see the result in the following screenshot, where the color of the widget is green. This means
that the average deal size is above the desired figure.
The widgets that you see may differ from the widgets on the screenshot below because data in the
SalesDemo data set is regularly updated.
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Figure: Reviewing the SalesDemo dashboard with the scorecard KPI

Now that you have added the scorecard KPI to the SalesDemo dashboard, you will change its settings in
the next step.
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Step 13.5: Changing the Settings of a Scorecard KPI Widget
After you create a scorecard KPI widget, the limits that you used (which influence the background color
of the widget) may change. In this case, you can easily apply these changes to the widget settings.
Suppose that in your organization, the minimum deal size (that is, the low end of the normal range)
was budgeted as $50,000 for the next year. The desired average deal size is $70,000 and higher. You
will reflect this change on the SalesDemo dashboard. Proceed as follows:
1.

On the title bar of the SalesDemo dashboard, click Design to turn on design mode.

2.

On the toolbar of the Average Deal Size widget, click Edit (the pencil icon).

3.

In the Widget Properties dialog box, do the following:

4.

a.

In the Normal Level box, type 50,000.

b.

In the Alarm Level box, type 70,000.

c.

Click Finish to save your changes and close the dialog box.

On the dashboard title bar, click Design to turn off design mode.

In the following screenshot, you can see that the widget background color is now red. This means that
the current average deal size of $41,820 is below the minimum size of $50,000.

Figure: Reviewing the SalesDemo dashboard with the changed scorecard KPI

Now that you have changed the scorecard KPI on the SalesDemo dashboard, you will add a trend card
KPI widget to the dashboard in the next step.
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Step 13.6: Adding a Trend Card KPI Widget to the SalesDemo
Dashboard
Trend card KPI (key performance indicator) widgets provide you with the ability to compare totals,
averages, and counts of items between specific time periods, such as years or months. The system
counts the time period backward, starting from the current business date. Suppose that the current
business date is December 7, 2017, and you want to make a year-to-year comparison of a particular
parameter to see if it is trending upward or downward. The system will aggregate the values between
December 7, 2017, and December 8, 2016; it will also total the values between December 7, 2016,
and December 8, 2015. Then the system will compare the figure for the most current time period (that
is, the time period closest to the current business date) with the older figure, and indicate the trend:
rising, flat, or falling.
The third widget that you will add to the SalesDemo dashboard is a trend card KPI widget that displays
the year-to-year trend for the number of reported support cases. Do the following:
1.

On the title bar of the SalesDemo dashboard, click Design to turn on design mode.

2.

On the widget placeholder below the Top 10 Companies widget, click add a new widget.

3.

In the Add Widget dialog box, which opens, click Trend Card KPI and then click Next.

4.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Inquiry Screen box, select DB Cases (Company > Hidden > Hidden Generic
Inquiries), as shown in the following screenshot.

Figure: Selecting the generic inquiry for the trend card KPI widget

b.

Make sure the Shared Filter to Apply box contains the default value: All Records.

c.

In the Trend Card Title box, type Yearly Dynamics of Support Cases

d.

In the Field to Aggregate box, select Case ID.
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e.

Check to be sure the Aggregate Function box contains the default value: Count.
With this setting, the system will count the number of unique support cases.

f.

In the Timeline Field box, select Date Reported.
In this box, you select an element of the date type from the selected inquiry. This field is
used for calculating trends.

g.

In the Period box, select Last Year.
With this setting, the system will count the support cases created during the year
immediately before the current business date and compare it with the number of cases
created during the previous year.

h.

In the Rising Trend Color box, select Acumatica Red.
You have selected red in this box to draw employees' attention when the number of
support cases is growing. (This may mean that your organization needs to allocate more
resources to the support of customers.)

i.

In the Flat Trend Color box, keep the default value: Acumatica Yellow.
You have selected yellow to let employees know when the number of support cases has
remained identical in comparison to the previous period.

j.

In the Falling Trend Color box, select Acumatica Blue.
You have selected blue in this box to notify employees when the number of support cases
is falling. (This trend might be good for your organization because some of the employees
who support customers can be redeployed to other tasks.)

k.

Make sure the Automatically Adjust Font Size box is selected.

l.

Leave the Caption box blank.

m. Review the properties of the trend card KPI widget (see the following screenshot).

Figure: Reviewing the properties of the widget

n.

Click Finish to save your changes and close the dialog box.
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5.

On the dashboard title bar, click Design to turn off design mode.

You can see the result in the following screenshot.
The widgets that you see may differ from the widgets on the screenshot below because data in the
SalesDemo data set is regularly updated.

Figure: Reviewing the SalesDemo dashboard with the trend card KPI widget

As you can see, the color of the widget is blue, which means that the year-to-year number of support
cases is falling.
Now that you have added the trend card KPI to the SalesDemo dashboard, you will embed an external
webpage in the same dashboard.
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Step 13.7: Adding an Embedded Page Widget to the SalesDemo
Dashboard
You can add to the dashboard an external webpage with a useful resource, such as a search engine,
currency rates, or financial news.
You can use the Embedded Page widget to place an empty area on your dashboard for design reasons.
To do this, in the Widget Properties dialog box, you need to type about:blank in the Source box and
leave the Caption box empty.

You will embed the Microsoft Bing page in the SalesDemo dashboard. Do the following:
1.

On the title bar of the SalesDemo dashboard, click Design to turn on design mode.

2.

On the widget placeholder to the right of the Yearly Dynamics of Support Cases widget, click
add a new widget.

3.

In the Add Widget dialog box, which opens, click Embedded Page and then click Next.

4.

In the Widget Properties dialog box, do the following:
a.

In the Source box, type https://www.bing.com.

b.

In the Caption box, type Bing.

c.

Review the properties of the embedded page widget (see the following screenshot).

Figure: Reviewing the properties of the widget

d.
5.

Click Finish to save your changes and close the dialog box.

On the dashboard title bar, click Design to turn off design mode.

In the following screenshot, you can see the SalesDemo dashboard with the four widgets.
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Figure: Viewing the Sales Demo dashboard with the embedded page

Now that you have populated the dashboard with widgets, you will arrange the widgets in the next step.
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Step 13.8: Arranging Widgets on a Dashboard
After you have added all the required widgets to the dashboard, you can arrange them in any of the
following ways:
•

Resize widgets

•

Change the order of widgets

•

Change the layout of widgets on a dashboard

•

Delete widgets

You will arrange widgets on the SalesDemo dashboard. Do the following:
1.

On the title bar of the SalesDemo dashboard, click Design to turn on design mode.

2.

On the dashboard title bar, click Edit Layout.

3.

In the Dashboard Layouts dialog box, click the fourth layout (see the following screenshot)
and click OK.

Figure: Selecting the dashboard layout

4.

Drag the Top 10 Companies chart widget to the right part of the widget.

5.

Drag the right border of the Average Deal Size widget so that it has the full width of the left part
of the dashboard.

6.

Drag the bottom right corner of the Top 10 Companies widget so that it has the full width of the
right part of the dashboard and its height is the same as the height of the Average Deal Size
widget.

7.

On the toolbar of the Bing widget, click Delete.

8.

Drag the right border of the Yearly Dynamics of Support Cases widget so that it has the full
width of the left dashboard part.

9.

On the dashboard title bar, click Design to turn off design mode.

In the following screenshot, you can see the SalesDemo dashboard with the rearranged widgets.
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Figure: Viewing the changed SalesDemo dashboard

Now that you have arranged widgets on the dashboard, in the next step, you will set up the dashboard
as a default home page so that all employees who sign in to your Acumatica ERP instance will see it.
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Step 13.9: Setting Up the SalesDemo Dashboard as the Default
Home Page
As an administrator, you can set up any dashboard as the default home page of your Acumatica ERP
instance. Users will see this dashboard when they sign in to the system if they did not set up a personal
home page.
The home page is the first screen users see when they sign in to the system. To open the home page
at any time, users can click the logo in the upper-left corner of the Acumatica ERP screen, as shown in
the following screenshot. (In the modern UI, this button is moved to the left of the business date if the
main menu is collapsed to the top.)

Figure: Viewing the Home button

To set up the SalesDemo dashboard as the default home page of your instance, do the following:
1.

On the Site Preferences form (SM200505; Configuration > Common Settings > User Settings),
in the Home Page box of the General Defaults group, select SalesDemo (Company >
Organization > Shared Dashboards), as shown in the following screenshot.
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Figure: Setting up the default home page

2.

Save your changes.

3.

In the top right corner of the screen, click your user name and then click My Profile to open the
User Profile form (SM203010).

4.

On the General Info tab, in the Home Page box of the Personal Settings section, delete the
predefined value (see the following screenshot). Save your changes.
You have deleted the value of the Home Page box, which was predefined in your Acumatica ERP
instance with the SalesDemo data set, so that you can see the default home page when you sign
in to the system.
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Figure: Deleting the value of the Home Page box

5.

In the top left corner of the screen, click the Acumatica logo to open the home page. The
SalesDemo dashboard opens.

Now that you have created and configured the public dashboard, you will create a dashboard that is
visible to only users with a particular role.
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Step 13.10: Creating a Dashboard That Is Visible to a
Particular Role
In Acumatica ERP, you can create a dashboard that is designed especially for users with a particular
functional role, such as accountants or sales managers. This dashboard should display role-specific
information and be visible to only users who are assigned this particular role.
Suppose that you need to create a dashboard for accountants who work with Accounts Receivable
documents in Acumatica ERP. Do the following:
1.

On the Dashboards form (SM208600; System > Customization > Manage), click Add New
Record and specify the following properties:
•

Name: Accounts Receivable

•

Site Map Location: Accounts Receivable (Company > Finance)

•

Owner Role: DashboardDesigner

•

Allow Users to Personalize: Selected

2.

In the Visible to table, select the unlabeled check boxes for the following roles: Administrator,
DashboardDesigner, and Finance.

3.

Save your changes to the dashboard.

In the following screenshot, you can see the settings of the Accounts Receivable dashboard.

Figure: Creating a dashboard that is visible to users with the Finance role

Now that you have created this dashboard, you need to populate it with widgets, which you will do in
the next four steps.
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Step 13.11: Adding a Table Widget to the Accounts Receivable
Dashboard
Although table widgets are not as eye-catching as charts are, they are often the best way to help the
viewer grasp key ideas about the data. A table is often a better choice than a chart when you want to
show multiple types (shown as columns) of data.
To add a table that lists the signed-in user's tasks to the Accounts Receivable dashboard, do the
following:
1.

Open the Accounts Receivable dashboard.

2.

On the dashboard title bar, click Design to turn on design mode.

3.

On the widget placeholder, click add a new widget.

4.

In the Add Widget dialog box, which opens, click Data Table and then click Next.

5.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Inquiry Screen box, select Tasks (Company > Organization > Communication >
Works Area > Tasks) as shown in the following screenshot.

Figure: Selecting the form for the table widget

b.

In the Shared Filter to Apply box, select My Tasks.
The My Tasks tab is a reusable filter, which you can use to select the data for a widget.
You have become familiar with the functionality of these filters in Lesson 12: Using Reusable
Filters.

c.

Make sure that the Automatically Adjust Height check box is cleared.
With this check box cleared, you can adjust height of the table widget manually.

d.

Click Column Settings.
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e.

In the Column Settings dialog box, which opens, click each of the following columns and
then click the arrow pointing right to select the column (see the following screenshot):
•

Summary

•

Status

•

Due Date

•

Related Entity Description

Figure: Selecting the columns for the table widget

f.

Click OK to save your changes and close the Column Settings dialog box.

g.

In the Caption box, type My Tasks.

h.

Review the settings of the table widget (see the following screenshot).
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Figure: Reviewing the settings of the widget

i.

In the Widget Properties dialog box, click Finish to save your changes and close the
dialog box.

6.

Change the size of the My Tasks widget as needed by dragging any of its corners or borders.

7.

On the dashboard title bar, click Design to turn off design mode.

You can see the dashboard with the table widget in the following screenshot. By using this widget, you
can add a new task and open an existing one.

Figure: Reviewing the Accounts Receivable dashboard with the table widget

Now that you have added the table widget to the Accounts Receivable dashboard, you will add a line
chart widget to the dashboard in the next step.
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Step 13.12: Adding a Chart Widget to the Accounts Receivable
Dashboard
Chart widgets are useful when you need to visualize dynamic changes of particular parameters.
You will create a chart widget of the Line type that will display dynamic changes of sales amounts on
the Accounts Receivable dashboard. Do the following:
1.

On the title bar of the Accounts Receivable dashboard, click Design to turn on design mode.

2.

On the widget placeholder to the right of the My Tasks widget, click add a new widget.

3.

In the Add Widget dialog box, which opens, click Chart and then click Next.

4.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Inquiry Screen box, select Sales Profitability Analysis (Company > Finance >
Accounts Receivable > Work Area > Explore), as shown in the following screenshot.

Figure: Selecting the form for the chart widget

b.

Click Inquiry Parameters.

c.

In the Date From line of the Inquiry Parameters dialog box (which opens), type
11/01/2016.

d.

Click OK to save your changes and close the Inquiry Parameters dialog box.

e.

Make sure that the Shared Filter to Apply contains the default value: All Records.

f.

Click Configure to specify the settings of the chart.

g.

In the Chart Settings dialog box, which opens, do the following:
a.

In the Chart Type box, select Line.

| Step 13.12: Adding a Chart Widget to the Accounts Receivable Dashboard | 245

b.

In the Legend box of the Categories section, select Date.

c.

In the Sort By boxes of the Categories section, keep the default values: Legend
and Ascending.

d.

In the Maximum Number of Values Shown box of the Categories section, type
12.

e.

In the Date Rounding box, select Months.
This box appears only for fields of the date type. In this box, you select the part of
the date field that will be displayed on the chart widget.

f.

In the Format box of the Categories section, select yyyy - MMM.
In this box, you select the format of the date field to be displayed on the chart.

g.

In the Value box of the Values section, select Net Sale.

h.

In the Format box of the Values section, select 0.00.

i.

Review the settings of the line chart (see the following screenshot).

Figure: Reviewing the settings of the chart

j.

5.

Click OK to save your changes and close the Chart Settings dialog box.

h.

In the Caption box, type Sales by Month.

i.

Click Finish to add the chart to the dashboard and close the Widget Properties dialog
box.

On the dashboard title bar, click Design to turn off design mode.

The Accounts Receivable dashboard with the table and line chart widgets is shown in the following
screenshot.
The widgets that you see may differ from the widgets on the screenshot below because data in the
SalesDemo data set is regularly updated.
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Figure: Reviewing the Accounts Receivable dashboard with the line chart widget

You can click points on the line chart to see detailed data for each month. When you click a point, the
system opens the source form with the data filtered by the month.
Now you have added the line chart widget to the Accounts Receivable dashboard. In the next step, you
will add an article widget to the dashboard.
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Step 13.13: Adding an Article Widget to the Accounts
Receivable Dashboard
An article widget is a dashboard view of a wiki article, generally one that you need to refer to
frequently. You can add to a dashboard any wiki article you have sufficient rights to, and you can create
a new article and then add it to the dashboard. For more information on wiki articles, see the link in the
Related Links section of this topic.
To add an existing wiki article to the Accounts Receivable dashboard, do the following:
1.

On the title bar of the Accounts Receivable dashboard, click Design to turn on design mode.

2.

On the widget placeholder below the My Tasks widget, click add a new widget.

3.

In the Add Widget dialog box, which opens, click Wiki Page and then click Next.

4.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Wiki Article box, select Overview (Company > Help > User Guide > Accounts
Receivable).

b.

In the Caption box, type Accounts Receivable Overview.

c.

Review the settings of the wiki article widget (shown in the following screenshot).

Figure: Reviewing the settings of the widget

d.

Click Finish to save your changes and close the dialog box.

5.

Change the size of the wiki article widget by dragging its corners or borders.

6.

On the dashboard title bar, click Design to turn off design mode.

In the following screenshot, you can see the Accounts Receivable dashboard with three widgets.
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Figure: Reviewing the Accounts Receivable dashboard with the wiki article widget

Now that you have added the wiki article widget to the Accounts Receivable dashboard, in the next
step, you will create a custom widget and add it to the dashboard.
Related Links
Wiki Overview
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Step 13.14: Creating a Custom Widget
You can create a custom widget by using the functionality of wiki articles. You will create a widget that
contains an image and links to the most frequently used forms in the Finance module of Acumatica ERP
and add this widget to the Accounts Receivable dashboard. Do the following:
1.

2.

3.

4.

Open the Wiki Editor form as follows:
a.

On the top panel of Acumatica ERP, click Help (the question mark enclosed in a circle),
and then click the Acumatica Educational Resources link to open the Help dashboard.

b.

On the Interface Guide card, click Explore to open this guide.

c.

On the toolbar of the Help topic, click Add New Article (the plus icon).

On the Content tab of the Wiki Editor form, specify the following settings:
•

Article ID: S130

•

Name: AR Links

•

Article Type: Html

•

Hold: Cleared

To upload an image to be used on the widget, do the following:
a.

On the form toolbar, click Attach. The File Upload dialog box opens.

b.

In the dialog box, click Choose File, and select the invoice.png file, which is provided
with this course.

c.

Click Upload to upload the image.

d.

In the File Link Editor dialog box, which opens, click OK to close the dialog box.

In the details area of the Content tab, enter the following HTML code:

<img src="../Frames/GetFile.ashx?fileID=a5b1c276-5fa1-4cb3-b0cc-4bcb095debab"
usemap="#flowS130">
<map name="flowS130" id="flowS130">
<area shape="rect" coords="4,4,114,119" href="../Main.aspx?
ScreenId=AR301000" target="_blank" alt="invoices" />
<area shape="rect" coords="228,9,329,118" href="../Main.aspx?
ScreenId=AR302000" target="_blank" alt="payments and applications" />
</map>
<br>
<ul>
<li><a href="../Main.aspx?ScreenId=AR303000" target="_blank"
style="color:#000000; text-decoration:none">View customers</a></li>
<li><a href="../Pages/AR/AR402000.aspx" style="color:#000000; textdecoration:none">View customer details</a></li>
<li><a href="../Main.aspx?ScreenId=AR651000" target="_blank"
style="color:#000000; text-decoration:none">Print customer details</a></li>
</ul>
The <img> tag is used to display an image on the widget. You should replace the image source
(the value of the src attribute) with the URL of the image you have uploaded.
5.

To get the URL of the uploaded file, do the following:
a.

On the Attachments tab, select the image you have uploaded, and on the tab toolbar,
click Get Link.
The dialog box, which opens, contains links in the following boxes:
•

External Link: The URL to use in the HTML articles (that is, when the Article Type
of the article is Html)
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•

Wiki Link: The URL to use in the wiki articles (that is, when the Article Type of
the article is Wiki)

The URL in the External Link box is similar to the following link.

http://localhost/InstanceName/Frames/GetFile.ashx?
fileID=a5b1c276-5fa1-4cb3-b0cc-4bcb095debab
The first part of the URL, such as http://localhost/InstanceName, is the URL of
your application. The second part is the URL to the file.
b.

In the External Link box, replace the URL of the application with two periods, as shown
in the following link:

../Frames/GetFile.ashx?fileID=a5b1c276-5fa1-4cb3-b0cc-4bcb095debab

6.

c.

Copy the URL in the External Link box.

d.

Click Close to close the dialog box.

In the details area of the Content tab, replace the image source, which is inside quotation
marks for the src attribute of the <img> tag, with the URL you have copied, as shown in the
screenshot below.

Figure: Configuring the custom widget

You can preview the article by clicking the magnifier icon on the toolbar of the details area (see the
screenshot above). Similarly, you can switch back to editing mode.

If you want to get more information on the code used for this article, see the Reviewing the
Code Used for the AR Links Widget section of this lesson.
7.

Save your changes to the article.

8.

To add the article you have created as a widget to the dashboard, do the following:
a.

Open the Accounts Receivable dashboard.

b.

On the dashboard title bar, click Design to turn on design mode.

c.

On the widget placeholder below the Sales By Month widget, click add a new widget.

d.

In the Add Widget dialog box, which opens, click Wiki Page and then click Next.
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e.

9.

In the Widget Properties dialog box, which opens, do the following:
a.

In the Wiki Article box, select AR Links (Company > Help > Interface Guide).

b.

In the Caption box, type AR Links.

c.

In the Widget Properties dialog box, click Finish to save your changes and close
the dialog box.

Arrange the widgets on the dashboard so that it is convenient to view the information presented
by the widgets.

10. On the dashboard title bar, click Design to turn off design mode.
In the following screenshot, you can see the Accounts Receivable dashboard with the custom widget.

Figure: Viewing the dashboard with the custom widget

Now you have added all necessary widgets to the Accounts Receivable dashboard. In the next step, you
will set up the dashboard as a personal home page for multiple users.
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Step 13.15: Setting Up the Accounts Receivable Dashboard as
Your Personal Home Page
You can set up any available dashboard as your personal home page. To set up the Accounts Receivable
dashboard as your home page, do the following:
1.

In the upper-right corner of the Acumatica ERP screen, in the info area, click your user name to
open the user menu, as shown in the following screenshot, and select My Profile. (If you are
using the classic UI, select User Profile instead.)

Figure: The My Profile button in the user menu

2.

On the General Info tab of the User Profile form (SM203010), which opens, in the Home Page
box of the Personal Settings section, select Accounts Receivable (Company > Finance), as
shown in the following screenshot.

Figure: Specifying the personal home page

3.

Save your changes.
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4.

Click the logo in the upper-left corner of the Acumatica ERP screen to open your home page. The
Accounts Receivable dashboard, which you have selected as the home page, is opened.

5.

Sign out, and then sign in again. The Accounts Receivable dashboard is opened by default.

Now that you have set up the Accounts Receivable dashboard as your personal home page, you will set
up this dashboard as the home page for another user.
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Step 13.16: Setting Up the Accounts Receivable Dashboard as
a User's Home Page
You can set up a personal home page for not only the user account to which you are signed in but also
any user of the system. You will specify the Accounts Receivable dashboard as the home page for the
wiley user account. Proceed as follows:
1.

On the Users form (SM201010; Configuration > User Security > Manage), in the Login box,
select wiley.

2.

On the Personal Settings tab, in the Home Page box, select Accounts Receivable (Company >
Finance), as shown in the screenshot below.

Figure: Specifying the home page for a user

3.

Save your changes to the user.

4.

On the form toolbar, click Log In as User. You will be signed in to the system as wiley. Notice
that the Accounts Receivable dashboard is opened by default.

5.

Sign out of the system, and again sign in as admin.
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Reviewing the Code Used for the AR Links Widget
The information of this section is provided for reference.

You have entered the following code in the AR Links article you created. In this section, you can find
additional information on how to develop similar code.

<img src="../Frames/GetFile.ashx?fileID=a5b1c276-5fa1-4cb3-b0cc-4bcb095debab"
usemap="#flowS130">
<map name="flowS130" id="flowS130">
<area shape="rect" coords="4,4,114,119" href="../Main.aspx?ScreenId=AR301000"
target="_blank" alt="invoices" />
<area shape="rect" coords="228,9,329,118" href="../Main.aspx?ScreenId=AR302000"
target="_blank" alt="payments and applications" />
</map>
<br>
<ul>
<li><a href="../Main.aspx?ScreenId=AR303000" target="_blank" style="color:#000000;
text-decoration:none">View customers</a></li>
<li><a href="../Pages/AR/AR402000.aspx" style="color:#000000; textdecoration:none">View customer details</a></li>
<li><a href="../Main.aspx?ScreenId=AR651000" target="_blank" style="color:#000000;
text-decoration:none">Print customer details</a></li>
</ul>
You can configure the image of an article so that the image area will contain a link to a form or
report in Acumatica ERP or to any external object. The user can click the area of the image to get the
appropriate information. For example, this code specifies links for two areas of the uploaded image.
That is, the invoice in the left side of the image (see the screenshot below) is a link to the Invoices and
Memos form (AR301000), and the credit card in the right side of the image is a link to the Payments
and Applications form (AR302000).
In the code, the usermap attribute of the <img> tag specifies the map with these links, which is
applied to the image. This map is enclosed in the <map> tag with the appropriate name attribute. Each
<area> tag within the <map> tag specifies a link.

The shape attribute of the <area> tag defines the shape of the image area that will be a link. In the
code, the shapes are rectangular. The coords attribute of the <area> tag defines the borders of the
area. Within the quotation marks of the coords attribute, the first two numbers are the horizontal and
vertical coordinates, in pixels, of the upper-left corner of the rectangular area. The last two numbers
are the coordinates of the bottom-right corner of the rectangular area. These coordinates are defined
based on the upper-left corner of the image, whose coordinates are 1 and 1.
For example, the coordinates of the upper-left corner of the rectangular area that includes the invoice
(item 1 in the screenshot below) are 4 and 4. The coordinates of the bottom-right corner of this area
(item 2) are 114 and 119. Similarly, the coordinates of the upper-left corner of the rectangular area
that includes the credit card (item 3) are 228 and 9. The coordinates of the bottom-right corner of this
area (item 4) are 329 and 118.
The href attribute of the <area> tag defines the URL assigned to the area. For example, the URL of
the Invoices and Memos (AR301000) form is similar to the following link.

http://localhost/InstanceName/Main.aspx?ScreenId=AR301000
The first part of this URL, http://localhost/InstanceName, is the URL of the application. The
second part is the URL of the form. You can replace the application URL with two periods and get the
same URL as was used in the code.
The target attribute of the <area> tag, which is equal to _blank, directs the system to navigate to
the page in a new window.
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Figure: Previewing the image

You define a bullet list by using the <ul> and </ul> tags and the <li> tags within them. Each <li>
tag represents one item of the list.
The <a> tag is used to show a link. The link description is placed within the <a> and </a> tags. The
href attribute of the <a> tag defines the URL of the link. The style attribute of the <a> tag defines
the style of the link.
If you want the link to open in a new window, use the target attribute of the <a> tag with
the _blank value, such as target=_blank, and specify the URL as ../Main.aspx?
ScreenId={screen identifier}. For example, ../Main.aspx?ScreenId=AR301000.

If you want the link to open in the same window, omit the target attribute, and specify the URL as
../Pages/{module name}/{page}. For example, ../Pages/AR/AR301000.aspx.
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Lesson Summary
In this lesson, you have learned how to create and manage dashboards. In particular, you have done
the following:
•

Created two dashboards and specified the access rights to each of the dashboards

•

Added the following types of widgets to dashboards: chart, scorecard KPI, embedded page, table,
and wiki article

•

Created a custom widget and added it to a dashboard

•

Arranged the added widgets on dashboards

•

Changed the site home page, your personal home page, and the home page of a particular user
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Review Questions
1.

2.

3.

4.

Which of the following are not types of widgets that you can add to a dashboard? Select all
correct responses.
•

A. Wiki articles

•

B. Inquiries

•

C. Charts

•

D. Forms

•

E. Reports

How can you create a personal dashboard—that is, a dashboard that only you can view? Select
all correct responses.
•

A. You can create a dashboard and set it as your personal home page.

•

B. You can create a dashboard and configure access rights so that only you can view and
edit this dashboard.

•

C. You cannot create a personal dashboard. All dashboards are shared among the
Acumatica ERP users.

Can you delete a dashboard?
•

A. Once created, a dashboard cannot be deleted.

•

B. You can delete a dashboard on the Dashboards form (SM208600) if you have sufficient
access rights.

•

C. You can delete only dashboards that are visible to you.

•

D. You can delete dashboards that are visible to all Acumatica ERP users.

How can you make a dashboard visible to multiple users in Acumatica ERP? Select all correct
responses.
•

A. On the Dashboards form (SM208600), select the Allow Users to Personalize check
box.

•

B. In the Visible to table of the Dashboards form (SM208600), select all user roles that
can view the dashboard.

•

C. On the Users form (SM201010), specify the dashboard as a personal home page for
each user who can see the dashboard.

•

D. In design mode for the dashboard, click Properties, and in the Visible to table, select
all user roles that can view the dashboard.

•

E. On the Site Preferences form (SM200505), set the dashboard as the site home page.

Answer Key
1 - B, D, E; 2 - B; 3 - B; 4 - B, D.
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Part 5: Pivot Tables
In Acumatica ERP, you can use pivot tables to reorganize and summarize data taken from generic
inquiries and to analyze it from various perspectives.
In this part, you will learn how to create and configure pivot tables.
Prerequisites
In this part, you will use the AR-Invoices inquiry, which you have imported to the system with the S130
customization project ans specified as an entry point for the Invoices and Memos form (AR301000).
You also will use the Current Year filter, which you have created in Lesson 12: Using Reusable Filters for
the Invoices and Memos generic inquiry.
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Reviewing Pivot Tables
In Acumatica ERP, you can use pivot tables to reorganize and summarize data from generic inquiries
and analyze it from various perspectives. This capability is useful when you have large amounts of data
in the generic inquiry and you need to build aggregate reports based on this data. Another way to use
pivot tables is to create reports that contain records with row and column totals.
You use the data from generic inquiries to build pivot tables. For a single generic inquiry, you can create
multiple pivot tables that will summarize data in different dimensions. You use only one generic inquiry
to build each pivot table. If you need to build pivot tables with information stored in multiple generic
inquiries, you must first create a single generic inquiry that includes all the necessary data.
Related Links
Pivot Tables in Acumatica ERP
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Lesson 14: Creating and Managing Pivot Tables
By using a pivot table, you can aggregate the data provided by a generic inquiry and display totals for
each row and column.
In this lesson, you will create and configure a pivot table based on the AR-Invoice generic inquiry, which
you imported with the S130 customization project.
Lesson Objectives
In this lesson, you will learn how to do the following:
•

Create a pivot table

•

Modify a pivot table

•

Filter data in a pivot table

•

Share a pivot table

•

Delete a pivot table
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Step 14.1: Creating a Pivot Table
In this step, you will create a pivot table that aggregates invoice totals by quarter for each customer. Do
the following:
1.

Sign in to the SalesDemo company of Acumatica ERP.

2.

Open the Pivot Tables form (SM208010; System > Customization > Manage).

3.

On the form toolbar, click Add New Record.

4.

In the Screen ID box, select Invoices and Memos (Company > Finance > Accounts Receivable >
Work Area > Enter > Invoices and Memos), as shown in the following screenshot.

Figure: Selecting the Invoices and Memos generic inquiry

5.

In the Name box, type Invoice Totals by Customer.

6.

On the form toolbar, click Save. In the Pivot Table ID box, notice that the name you have
entered is used as the ID of the pivot table.

7.

Add fields to the pivot table as follows:
a.

Drag Customer from the Fields pane to the Rows pane.
The names of customers will be displayed as row headers in the pivot table.

b.

In the Rows pane, click Customer to display its properties in the Properties pane (see
the screenshot below).

c.

In the Properties pane, make sure that the Show Total check box is selected.
With this setting, the system will add the Total row, which will display a total for all
customers in each column.
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Figure: Reviewing the properties of the Customer field

d.

Drag Date from the Fields pane to the Columns pane.

e.

In the Columns pane, click Date (see Item 1 in the screenshot below) to display its
properties in the Properties pane.

f.

In the Properties pane, make sure that the Show Total check box is selected (Item 2).
With this setting, the system will add the Total column, where a total for all dates in each
row will be displayed.

g.

In the Round To box, select Quarters to aggregate invoice totals by quarter. Notice that
in the Format box (Item 3), the format of the date is displayed automatically.
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Figure: Reviewing the properties of the Date field

h.

Drag Line Total from the Fields pane to the Values pane.
The pivot table will display invoice amounts, aggregated by quarter, for each customer.

8.

Save your changes to the pivot table.

9.

On the form toolbar, click View Pivot to open the pivot table (shown in the following
screenshot) in a separate tab.
The pivot table you can see on the screenshot may show different data from the pivot table on
your screen because data in the SalesDemo data set is updated regularly.
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Figure: Viewing the pivot table

The pivot table you have created is available only to you. You can, however, share a pivot table with
other users of Acumatica ERP. (You will do this later in this lesson.)
In the next step, you will configure a hierarchical structure of the column headers to make the table
more convenient for analysis.
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Step 14.2: Configuring a Hierarchical Structure of Column
Headers
For date fields and fields with segmented identifiers (such as item classes), you can configure a
hierarchical structure of column headers, which makes the headers more convenient for users to
perceive.
In this step, you will set up two-level column headers for the Invoice Totals by Customer pivot table.
Proceed as follows:
1.

On the Pivot Tables form (SM208010; System > Customization > Manage) for the Invoice Totals
by Customer pivot table, drag the Date field from the Fields pane to the Columns pane. Now
this pane contains two copies of the Date field.

2.

In the Columns pane, select the first copy of the Date field (the one in the higher row).

3.

In the Properties pane, specify the following settings (as shown in the following screenshot):
•

Show Total: Selected

•

Round To: Years

Figure: Reviewing the properties of the first Date field

With the Show Total check box selected, the system will display the Total column with a
cumulative all-year total for each customer.
4.

In the Columns pane, select the second copy of the Date field (the one in the lower row).

5.

In the Properties pane, specify the following settings (see the following screenshot):
•

Show Total: Selected

•

Date Part: Quarter
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Figure: Reviewing the properties of the second Date field

With the Show Total check box selected, the system will display the Total column after the Q4
column for each year.
6.

Save your changes to the pivot table.

7.

Click View Pivot to open the pivot table. As shown in the following screenshot, the column
headers have been divided into two levels: the first level displays years, and the second level
displays quarters. The Total column is displayed after each year. The table also contains the
rightmost Total column, which sums up all years.
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Figure: Reviewing the pivot table with hierarchical column headers

8.

Close the tab with the pivot table and go back to the Pivot Tables form (SM208010).

9.

In the Columns pane, click the second copy of the Date field (that in the lower row).

10. On the pane toolbar of the Columns pane, click Delete Row.
11. In the Columns pane, click Date.
12. In the Round To box of the Properties pane, select Quarters.
13. Save your changes to the pivot table. You have returned the plain headers back to simplify
filtering.
In the next step, you will filter the data in the pivot table by using a shared filter.
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Step 14.3: Filtering Data in a Pivot Table by Using a Shared
Filter
When the pivot table contains a lot of data, it can be difficult for users to analyze the data. To reduce
the amount of data in the table, you can use shared reusable filters created for a generic inquiry whose
data the pivot table displays. By using a shared filter, you can filter data in the pivot table permanently.
(The filter actually is applied to the generic inquiry and then the pivot table uses the filtered data.)
Users who have no access to the Pivot Tables form (SM208010) cannot apply a shared filter (or clear an
applied filter) when they work with the pivot table.
You will apply the Current Year filter, which you have created in Lesson 12: Using Reusable Filters, to
the Invoice Totals by Customer pivot table. Do the following:
1.

2.

3.

Review the settings of the Current Year filter as follows:
a.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area).

b.

On the Current Year tab, click Filter Settings ( ) on the table toolbar. The Filter
Settings dialog box opens with the Current Year filter selected.

c.

Make sure that the Shared check box is selected.

d.

Close the dialog box.

Apply the Current Year filter to the Invoice Totals by Customer pivot table. Do the following:
a.

Open the Pivot Tables form (SM208010; System > Customization > Manage).

b.

Select the Invoice Totals by Customer pivot table.

c.

In the Shared Filter to Apply box (in the upper right of the Summary area), select
Current Year.

d.

Save your changes.

Open the pivot table. In the following screenshot, you can see that the table contains data for
only the current year.
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Figure: Reviewing the pivot table with the shared filter applied

4.

Close the tab with the pivot table.

5.

In the Shared Filter to Apply box, select All Records to clear the filter.

6.

Save your changes.

In the next section, you will work with the pivot table you have configured.
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Step 14.4: Working with a Pivot Table
After you have configured a pivot table, you can use it to analyze data. You can open a pivot table from
the Pivot Tables form (SM208010) or from the generic inquiry form on which the pivot table is based.
In this step, you will open the Invoice Totals by Customer pivot table, export the data from the table to
Microsoft Excel, modify the table on the fly, filter data, create a copy of the pivot table, and delete the
copy. Proceed as follows:
1.

Open the Invoices and Memos form (Finance > Accounts Receivable > Work Area).

2.

On the form title bar, click Pivot Tables and then click Invoice Totals by Customer. The pivot
table opens in a separate browser tab.

3.

Export the data from the table to a Microsoft Excel workbook. Do the following:

4.

a.

On the table toolbar, click Export to Excel.

b.

Save the file on the hard disk of your computer. Now you can analyze data in the pivot
table by using Microsoft Excel. (This task is beyond the scope of this course.)

Customize the pivot table as follows:
a.

On the form title bar, click Customize. The Pivot Tables form (SM208010) is opened with
this pivot table selected, so you can modify its settings.
Only users who have access to the Pivot Tables form (SM208010) can see the Customize
button on a pivot table title bar.

b.

In the Fields pane, drag the Status field to the Filters pane.
You can add to the Filters pane one field or multiple fields whose values you want to use
for filtering the data in a pivot table.

5.

c.

On the form toolbar, click Save & Close to save your changes to the pivot table and close
the form.

d.

On the table toolbar, click Refresh to update the pivot table. Notice that the Status
button has appeared on the table toolbar.

Filter the data in the table as follows:
a.

On the table toolbar, click the filter icon on the Status button and select only the Open
status, as shown in the following screenshot.

Figure: Configuring a filter by status

b.

Click OK in the dialog box to apply the filter. In the following screenshot, you can see the
resulting pivot table, which displays the data for open invoices only.
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Figure: Viewing the pivot table with data filtered by invoice status

c.

On the table toolbar, click the filter icon on the Status button and select all check boxes
to clear filter by status.

The system clears filter settings by fields automatically after you close a pivot table. If you want
to continue working with the full data in the table, you clear the filter settings manually.
6.

7.

Create a copy of the pivot table as follows:
a.

On the title bar of the pivot table, click Save As.

b.

In the Pivot Name box of the Save Pivot As dialog box, type Copy of Invoice Totals
Pivot.

c.

Click Save. Notice that the tab with the pivot table name has appeared next to the
Invoice Totals by Customer tab.

Delete the copy of the pivot table as follows:
a.

Close the tab with the pivot tables.

b.

Open the Pivot Tables form (SM208010; System > Customization > Manage).

c.

Find the Copy of Invoice Totals Pivot pivot table by using the Go to Next Record button
on the form toolbar.

d.

On the form toolbar, click Delete. The Copy of Invoice Totals Pivot pivot table is deleted
from the system.

In the next step, you will share the pivot table with other users of Acumatica ERP.
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Step 14.5: Sharing a Pivot Table
If you want other users to work with the pivot table that you have created, you need to share the table.
You will share the Invoice Totals by Customer pivot table, add it to a workspace, and open it acting as a
different user. Do the following:
1.

Share the Invoice Totals by Customer pivot table as follows:
a.

On the Pivot Tables form (SM208010; System > Customization > Manage) for the
Invoice Totals by Customer pivot table, select the Is Shared check box, as shown in the
following screenshot. Notice that the Site Map Location box becomes available.

b.

In the Site Map Location box, select Accounts Receivable (Company > Finance).

c.

Review the settings of the pivot table (see the following screenshot).

Figure: Reviewing the settings of the pivot table

d.
2.

Save your changes to the form.

To add the Invoice Totals by Customer pivot table to a workspace, proceed as follows:
a.

In the main menu, click the Receivables workspace.

b.

In the main menu, click Configure (the ellipsis in the bottom left corner) and then click
Edit Menu.

c.

On the top pane, click Add Menu Item.

d.

In the Search box of the Select Forms dialog box, type Invoice Totals by Customer.

e.

Select the check box to the left of the link for Invoice Totals by Customer.

f.

Click Add & Close to add the pivot table to the workspace and close the dialog box.

g.

Under the Pivot Tables category, select the check box to the left of the link for Invoice
Totals by Customer to add the table to the Quick Menu.
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h.
3.

Click Exit Edit Menu. Notice that the link to the Invoice Totals by Customer pivot
table has appeared in the Receivables workspace.

Open the Invoice Totals by Customer pivot table while you are signed in as the wiley user, to
confirm that it is now shared. Do the following:
a.

Open the Users form (SM201010; Configuration > User Security > Manage).

b.

In the Login box, select wiley.

c.

On the form toolbar, click Log In as User. You will be signed in to the system as wiley.

d.

In the main menu, click Receivables and then click Invoice Totals by Customer. This
confirms that wiley can open the pivot table.

e.

Sign out of the system and sign in as admin.
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Lesson Summary
In this lesson, you have learned how to create and configure pivot tables and how to work with them.
By using the Pivot Tables form (SM208010), you have created a pivot table, added fields to the table,
applied a shared filter to the table, and shared the pivot table with other users of Acumatica ERP.
After you opened the pivot table, you added an extra field for filtering data, filtered the data by status,
exported the data to a Microsoft Excel workbook, and created a copy of the pivot table.
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Review Questions
1.

2.

3.

4.

How can you filter data in a pivot table? Select all correct responses.
•

A. You specify a shared filter in the settings of a pivot table.

•

B. You cannot filter data in a pivot table in Acumatica ERP.

•

C. You filter data by the values of a field you add to the Values pane of the Pivot Tables
form (SM208010).

•

D. You filter data by the values of fields you add to the Rows, Columns, or Filters pane
of the Pivot Tables form (SM208010) for the pivot table.

Can other users open a pivot table created by you if it is not shared?
•

A. Yes, they can open the table if they have access to the Pivot Tables form (SM208010).

•

B. No, they cannot.

•

C. Yes, they can find all pivot tables in the Data Views workspace and open any of them.

How can you add a column with totals for each row in a pivot table?
•

A. Select the Show Total check box in the properties of a field listed in the Rows pane.

•

B. Select the Show Total check box in the properties of a field listed in the Values pane.

•

C. Select the Show Total check box in the properties of a field listed in the Columns
pane.

How many pivot tables can you create for the same generic inquiry?
•

A. An unlimited number of pivot tables

•

B. Only one pivot table

•

C. No more than five pivot tables

Answer Key
1 - A, D; 2 - B; 3 - C, 4 - A.
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Part 6: Access Rights to Inquiries, Reports,
Dashboards, and Pivot Tables
Acumatica ERP was designed with particular attention to the collection, storage, and processing of
sensitive corporate data that must be protected against unauthorized access, use, modification, and
disclosure. Acumatica ERP uses reasonable security measures, including access control to system
resources.
In this part of the course, you will learn how to specify access rights to inquiries, reports, dashboards,
and pivot tables.

| Lesson 15: Setting Up Access Rights to Inquiries, Reports, Dashboards, and Pivot Tables | 278

Lesson 15: Setting Up Access Rights to Inquiries, Reports,
Dashboards, and Pivot Tables
In Acumatica ERP, you create user accounts to allow people access the system. Based on users' job
responsibilities, you can control their access to forms, entities created through these forms, and
operations on these entities based on the user's job responsibilities. Rather than assigning each
individual user access rights to each object the user must access, you define roles, which are sets of
access rights that fit job responsibilities in your company, and then assign these roles to individual
users.
Roles help you easily manage access rights for groups of users in the system. Changing one role alters
the access rights for all users to whom this role is assigned.
In this lesson, you will specify access rights to the inquiries, reports, dashboards, and pivot tables you
have created in the previous lessons of this course. You will configure the Administrator and DEMO
roles, and assign them to the users with the admin and user user names, respectively. The levels of
access you should specify for the roles are summarized in the following table.
Access Rights to the Reports, Inquiries, and Dashboards

Report, Inquiry, or Dashboard

Access Rights of the User
admin

user

The Invoices Commissionable by Salesperson report (AR670000)

Can view

Can view

The Items Invoiced by Salesperson report (AR680000)

Can view

Cannot view

The Open Sales Orders by Customer inquiry

Can view

Can view

The Sales Orders by Date and Status inquiry

Can view

Cannot view

SalesDemo Dashboard

Can view and edit

Can view

Accounts Receivable Dashboard

Can view and edit

Cannot view

The Invoice Totals by Customer pivot table

Can view and edit

Cannot view

Lesson Objectives
In this lesson, you will learn how to do the following:
•

Set up access rights to a report

•

Set up access rights to a generic inquiry

•

Set up access rights to a dashboard

•

Set up access rights to a pivot table

•

Set up a user with access rights

Related Links
User Security
Role-Based Access
Access Rights by Role
Levels of Access Rights
Users
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Step 15.1: Setting Up Access Rights to Reports
You can grant any role access to any form, including any report form, on the Access Rights by Screen
form (SM201020).
You can also grant a specific role access to any form on the Access Rights by Role form (SM201025). On
the Access Rights by Screen form (SM201020), you can select a form (or report form) and then grant any
number of roles access to the selected form. On the Access Rights by Role form, you can select a role and
grant that role access to forms (including report forms) and other system entities, such as modules, suites,
and form elements.

In this step, you will specify the access rights for the Invoices Commissionable by Salesperson
(AR670000) and Items Invoiced by Salesperson (AR680000) report forms. Proceed as follows:
1.

Sign in to the SalesDemo company of Acumatica ERP.

2.

On the Access Rights by Screen form (SM201020; Configuration > User Security > Manage), in
the left pane, select Company > Finance > Accounts Receivable > Reports > Audit > Invoices
Commissionable by Salesperson. You created this report in Lesson 4: Creating a Report.

3.

In the table in the right pane, which lists all the roles defined in the system, select the following
levels of access rights for the specified roles (as shown in the screenshot below):
•

Administrator: Granted

•

DEMO: Granted

Figure: Roles' access rights to this report form

For each role, you can specify one of the following levels of access rights to this report form (and
to any report form):
•

Not Set (default): If this level of access rights is assigned to all roles for the report
form, users with any of these roles have access to the report form. If at least one role
is assigned the Revoked or Granted access rights for the report form, a user with a role
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with the Not Set level is denied access to the form; for this user, the report form is not
displayed in the UI.
•

Revoked: If this level of access rights is assigned to a role, users with this role are denied
access to the report form; for these users, the report form is not displayed in the UI.

•

Granted: If this level of access rights is assigned to a role, users with the role can access
the report form and run the report.
In the classic UI, for a role, you could grant access to the report form but revoke access to
the whole module that contains it. A user with such a role could access this form only from
forms outside of the module that have commands or links to the report form; the user would
not be able to view the form on the navigation pane due to the unavailability of the module.

4.

Save your changes to the form.
Based on the settings you have specified, only users with the Administrator or Demo role (or
both roles) can access the Invoices Commissionable by Salesperson report form (AR670000) and
run the report.

5.

In the left pane, select Company > Finance > Accounts Receivable > Reports > Audit > Items
Sold by Salesperson. You created this report in Lesson 6: Creating Tabular Reports.

6.

In the table in the right pane, for the Administrator role, select the Granted level of access
rights.

7.

Save your changes to the form.
Based on the settings you have specified, only users with the Administrator role can access the
Items Invoiced by Salesperson report form (AR680000) and run the report. Other roles still have
the default Not Set access rights, which forbid users with these roles to access the report form
now that one other role has the Granted level of access rights specified.
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Step 15.2: Setting Up Access Rights to Generic Inquiries
Now you will specify assess rights for the Open Sales Orders by Customer and Sales Orders by Date
and Status inquiry forms. Do the following:
1.

On the Access Rights by Screen form (SM201020), in the left pane, select Company >
Distribution > Sales Orders > Reports > Audit > Open Sales Orders by Customer. You created
this generic inquiry in Lesson 1: Creating a Generic Inquiry.

2.

In the table in the right pane, select the following levels of access rights for the specified roles:
•

Administrator: View Only

•

DEMO: View Only

For each role, you can specify one of the following levels of access rights to this inquiry form
(and to any form):
•

Not Set (default): If this level of access rights is assigned to all roles, it allows all roles to
have access to the form until access rights are set to any other level for at least one role.
After at least one role has been assigned another level of access rights, access to the form
is denied for a role with this access level.

•

Revoked: If this level of access rights is assigned to a role, users with the role are denied
access to the form and its functionality.

•

View Only: If this level of access rights is assigned to a role, it gives the role restricted
access to the form and its functionality. This level allows users with the role to view the
form and any records associated with the form (in drop-down lists on other forms). This
level forbids users with the role to edit details about any record, create new records or
entities of the type, and delete records.

•

Edit: If this level of access rights is assigned to a role, it the role restricted access to the
form and its functionality. This level allows users with the role to view the form, select
records, and edit details about any record. This level forbids users with the role to create
new records or entities of the type, and to delete records.

•

Insert: If this level of access rights is assigned to a role, it gives the role restricted access
to the form and its functionality. This level allows users with the role to view the form,
select records, edit details about any record, and create new records or entities of the
type. This level forbids users with the role to delete records.

•

Delete: If this level of access rights is assigned to a role, it gives the role complete access
to the form and its functionality. This level encompasses the capabilities of the View Only,
Edit, and Insert levels, while also giving users with the role the ability to delete records.
If a generic inquiry form replaces an entry or maintenance form, access rights to the generic
inquiry are inherited from this entry or maintenance form.

3.

Save your changes to the form.
Based on the settings you have specified, only users with the Administrator or Demo role (or
both roles) can access the Open Sales Orders by Customer inquiry form.

4.

In the left pane, select Company > Distribution > Sales Orders > Reports > Audit > Sales
Orders by Date and Status. You created this generic inquiry in Lesson 1: Creating a Generic
Inquiry.

5.

In the table in the right pane, for the Administrator role, select the View Only level of access
rights.

6.

Save your changes to the form.
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Based on the settings you have specified for this form, only users with the Administrator role can
access the Sales Orders by Date and Status inquiry form. Other roles have the default Not Set
access rights, and these users may not access the inquiry form.
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Step 15.3: Setting Up Access Rights to Dashboards
When you created dashboards in Lesson 13: Creating and Managing Dashboards, you specified access
rights to these dashboards on the Dashboards form (SM208600).
In this step, you will configure access to this form and to dashboard widgets, and review access rights
to the SalesDemo and Accounts Receivable dashboards. Proceed as follows:
1.

Configure the access rights to the Dashboards form (SM208600) as follows:
a.

Open the Access Rights by Screen form (SM201020; Configuration > User Security >
Manage).

b.

In the left pane, select Company > System > Management > Customization > Work Area
> Manage > Dashboards.

c.

In the table in the right pane, for the Administrator role, select the Delete level of access
rights.

d.

Save your changes to the form.
With this configuration, only users with the Administrator role can access the Dashboards
form (SM208600). That is, only these users can create and delete dashboards in the
system, in addition to specifying the access rights to all dashboards in the system.
You were able to access the Dashboards form (SM208600) in Lesson 13: Creating and
Managing Dashboards without explicitly setting access rights because the Not Set level of
access rights had been specified to this form for all user roles before your changes in this
step.

2.

Configure the access rights to the DB SO Total generic inquiry form (on which you based the
scorecard KPI widget, Average Deal Size, in Lesson 13: Creating and Managing Dashboards) as
follows:
a.

In the left pane of the Access Rights by Screen form (SM201020), select Company >
Hidden > Hidden Generic Inquiries > DB SO Total.

b.

In the table in the right pane, for the Administrator role, select the Delete level of access
rights.

c.

Save your changes to the form.
Based on this configuration, only users with the Administrator role assigned can view the
Average Deal Size widget on the SalesDemo dashboard.

3.

Review access rights to the SalesDemo dashboard as follows:
a.

Open the Dashboards form (SM208600; System > Customization > Manage).

b.

In the Name box, select SalesDemo.

c.

Make sure that the Allow Users to Personalize check box is cleared.
With this setting, users who can view the dashboard cannot create a personal copy of the
dashboard.

d.

In the Granted column of the Visible To table, make sure that the check box is selected
for the Administrator and DEMO roles.
This configuration means that users with these roles assigned can view the SalesDemo
dashboard.
If a user can view a dashboard but does not have access to the form or generic inquiry on
which one of the dashboard's widgets is based, the user will see a placeholder instead of the
widget.

4.

Review the access rights to the Accounts Receivable dashboard as follows:
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a.

In the Name box of the Dashboards form (SM208600), select Accounts Receivable.

b.

Make sure that the Allow Users to Personalize check box is selected.
This setting means that users who can view the dashboard can also create a personal
copy of the dashboard and edit it (that is, add, edit, arrange, and remove widgets on the
dashboard).

c.

In the Granted column of the Visible To table, make sure the check boxes are set as
follows for these roles:
•

Administrator: Selected

•

DEMO: Cleared

Based on this configuration, users with the Administrator role can view the Accounts
Receivable dashboard, and users with the DEMO role cannot view this dashboard.
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Step 15.4: Setting Up Access Rights to Pivot Tables
In Lesson 14: Creating and Managing Pivot Tables, you created the Invoice Totals by Customer pivot
table, which is shared with other users of the system. In this step, you will restrict access to the
table. First, you will configure access to the Pivot Tables form (SM208010) so that only a user with the
Administrator role could manage pivot tables. Second, you will configure access rights to the Invoice
Totals by Customer pivot table.
Do the following:
1.

Configure the access rights to the Pivot Tables form (SM208010) as follows:
a.

Open the Access Rights by Screen form (SM201020; Configuration > User Security >
Manage).

b.

In the left pane, select Company > System > Management > Customization > Work Area
> Manage > Pivot Tables.

c.

In the table in the right pane, for the Administrator role, select the Delete level of access
rights.

d.

Save your changes to the form.
With this configuration, only users with the Administrator role can access the Pivot Tables
form (SM208010). That is, only these users can create, delete, and modify pivot tables.

2.

Configure the access rights to the Invoice Totals by Customer pivot table. Proceed as follows:
a.

On the Access Rights by Screen form (SM201020; Configuration > User Security >
Manage), in the left pane, select Company > Finance > Accounts Receivable > Invoice
Totals by Customer.

b.

In the table in the right pane, for the Administrator role, select the Granted level of
access rights.
The levels of access rights for pivot tables are the same as those for reports.

c.

Save your changes to the form.
Based on this configuration, only users with the Administrator role can view the Invoice
Totals by Customer pivot table.
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Step 15.5: Providing a User with Access Rights
On the Users form (SM201010), you can create a new user, manage an existing user, and assign any
role to a specific user.
You can also assign a specific role to any user on the User Roles form (SM201005; Configuration > User
Security > Manage). On the Users form (SM201010), you can select a user and then assign any number of
roles to the selected user. On the User Roles form, you can select a role and assign that role to any number
of users.

In this step, you will create a user, assign the appropriate roles to this user, and test the access rights
of users by signing in as them. Do the following:
1.

On the Users form (SM201010; Configuration > User Security > Manage), in the Login box,
select admin (the user name of the user you are signed in to). On the Roles tab, make sure that
the check boxes for the Administrator and DashboardDesigner roles are selected for this user.
In Lesson 13: Creating and Managing Dashboards, you have specified the DashboardDesigner role
as the owner role for the SalesDemo and Accounts Receivable dashboards. Users with this role
assigned will be able to edit properties of these dashboards.

2.

Create a new user as follows:
a.

On the form toolbar, click Add New Record.

b.

Specify the following settings for the new user (shown in the screenshot below):

c.

•

Login: user

•

Generate Password: Cleared

•

Password: Any password you want to specify for the user

•

Email: user@acumatica.com

On the Roles tab, in the Selected column, select the check boxes for the following roles
(also shown in the screenshot below):
•

BRANCH HQ

•

BRANCH VA

•

DEMO
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Figure: Creating a new user

d.
3.

Save your changes.

Test the access rights of admin as follows:
a.

Make sure that you are signed in as admin. You can find this information in the info area
in the upper-right corner of the Acumatica ERP screen.

b.

Open the Receivables workspace by clicking its name on the main menu. Notice that the
Invoices Commissionable by Salesperson (AR670000) and Items Invoiced by Salesperson
(AR680000) reports are listed in the workspace, and thus available to admin (see Item 1
in the screenshot below).
In the classic UI, you can find these reports as follows: Finance > Accounts Receivable >
Reports > Audit.

c.

Notice that the Invoice Totals by Customer pivot table is also visible to admin in this
workspace (Item 2).
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Figure: Checking the reports and pivot tables admin can view

d.

Open the Sales Orders workspace by clicking its name on the main menu. Notice that
the Open Sales Orders by Customer and Sales Orders by Date and Status generic inquiry
forms are available to admin. (See the following screenshot.)

Figure: Reviewing the generic inquiry forms visible to admin

In the classic UI, you can find these generic inquiries as follows: Distribution > Sales
Orders > Reports > Audit.

e.

Open the SalesDemo dashboard. Notice that the Design button is displayed on the
dashboard title bar. This means that admin can manage the widgets of the dashboard:
add widgets, delete them, arrange them, or change their properties.
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f.

4.

Open the Accounts Receivable dashboard. Again notice that the Design button is
displayed on the title bar of this dashboard. The admin user can manage the widgets of
this dashboard also.

Verify the access rights of user by doing the following:
a.

Sign out as admin, and then sign in to the SalesDemo company of Acumatica ERP as
user.

b.

Open the Receivables workspace by clicking its name on the main menu. Notice that
the Invoices Commissionable by Salesperson report (AR670000) is listed and thus visible
to user, but the Items Invoiced by Salesperson report (AR680000) is not listed and thus
inaccessible, as shown in the following screenshot. Access rights to this report are not
permissive for any of the roles of user.

Figure: Reviewing the reports that can be viewed user

In the classic UI, you can find these reports as follows: Finance > Accounts Receivable >
Reports > Audit.

c.

Notice that user cannot see the Pivot Tables category on this workspace. This means
that this user cannot access the Invoice Totals by Customer pivot table, which is the only
item in this category.

d.

Open the Sales Orders workspace by clicking its name on the main menu. Notice that
the Open Sales Orders by Customer inquiry is listed, but the Sales Orders by Date and
Status inquiry is not. (See the following screenshot.)
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Figure: Reviewing generic inquiries that can be viewed by user

In the classic UI, you can find these generic inquiries as follows: Distribution > Sales
Orders > Reports > Audit.

e.

Open the SalesDemo dashboard. Notice that the Design button is not shown on the
dashboard title bar (see the screenshot below). Thus, user cannot manage the widgets
of the original dashboard because this user is not assigned the DashboardDesigner role.
User also cannot create a personal copy of the dashboard because you cleared the Allow
Users to Personalize check box on the Dashboards form (SM208600).
You can see a placeholder with a lock in place of the Average Deal Size widget. This
widget is based on the DB SO Total generic inquiry, which can be accessed by only users
with the Administrator role assigned.
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Figure: Reviewing the SalesDemo dashboard for user

f.

In the Search box of the top pane, type Accounts Receivable. Notice that nothing is
listed on the Menu Items tab. This happens because no user roles assigned to user can
access this dashboard.

You have successfully configured the access rights to the reports, inquiries, dashboards, and pivot
tables.
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Lesson Summary
In this lesson, you have learned how to specify access rights to inquiries, reports, dashboards, and
pivot tables. On the Access Rights By Screen form (SM201020), you granted access for specific roles
to the inquiries, reports, dashboards, and pivot tables you have created in the previous lessons of this
course. On the Users form (SM201010), you created a new user and set up access rights to this user.
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Review Questions
1.

2.

3.

4.

Where can you grant a role access to a particular form? Select all that apply.
•

A. On the Users form (SM201010)

•

B. On the Users Roles form (SM201005)

•

C. On the Access Rights by Role form (SM201025)

Select the level of access rights to reports that imparts the most privileges.
•

A. Not Set

•

B. Granted

•

C. Revoked

Select all statements that correctly describe the Not Set level of access rights.
•

A. This is the default level of access.

•

B. If this level of access is assigned to all roles for the form, users with any of these roles
have access to the form.

•

C. Once another level of access rights is set to the form for at least one role, a user with a
role with the Not Set level is granted access to the form.

Suppose that you opened a dashboard and see a lock instead of one widget. Why are you seeing
the lock?
•

A. The widget is under construction

•

B. Another user is viewing a source form of this widget

•

C. You do not have access to the source form of this widget

•

D. The system cannot access an external web page that should be displayed by this widget

Answer Key
1 - C; 2 - B; 3 - A, B; 4 - C.
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Appendix: Updating Reports
Any report of Acumatica ERP contains a database schema. In some cases, such as the following, the
database schema of any report can become outdated even if no one has changed the reports directly:
•

You have installed a new version of Acumatica ERP.

•

Acumatica ERP has been customized—for example, a custom field was added to a class.

To make new fields and database columns available in a report, you need to update the database
schema in the report.
Updating a Report by Using the Report Designer
In the Schema Builder wizard of the Report Designer, load the schema, and update the opened report
classes by clicking one of the following buttons (see the screenshot below):
•

Refresh: To update the class selected in the area above the button

•

Refresh All: To update all the classes used in the report

Figure: The buttons to refresh the report schema

If any class name or data field name used in the report is updated by the new names through one of
these actions, the new names will be substituted for the old ones automatically wherever they are used:
in the relationships, filtering and grouping conditions, text boxes, and expressions.
Updating Multiple Reports by Using the Report Updater Tool
You can use the ReportUpdater.exe command-line tool to update the database schema for multiple
reports at once.
The ReportUpdater.exe tool is the command line utility included in Acumatica Report Designer. It is located
in the same folder as the Report Designer.

When you launch the Report Updater, it performs the following actions:
1.

On the specified site, loads the database schema

2.

For each report from the specified source folder:
a.

Reads the report

b.

Refreshes all the classes used in the report according to the database schema

c.

Writes the updated report file to the specified destination folder
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d.

Outputs the result of the report update to either the system console or the specified log
file

To get the ReportUpdater.exe help information, launch the utility in the Command Prompt without
parameters, as shown in the screenshot below.

Figure: Report Updater help information

Use the following command line syntax to update multiple reports.

>ReportUpdater src=<srcFolder> dest=<dstFolder> url=<url> log=<logName>
login=<login> password=<password>
The Report Updater parameters are listed in the table below.
Parameter

Description

src

The absolute path to the folder from which the utility loads the source reports.

dest

The absolute path to the destination folder to which the utility saves the updated
reports.

url

The URL of the site used to load the database schema.

log

The log file name (optional). If you specify a name, the entire log is output to the
file. Otherwise, the system outputs the log information to the console window.

login

The login for the site used to load the database schema.

password

The password for the site used to load the database schema.

•

If a parameter contains spaces, use quotation marks around the parameter.

•

If you need to override existing reports, use the same path for the source and destination folders.

As an example of using the ReportUpdater.exe tool, see the following command line for the Test
application, and the screenshot below.

>ReportUpdater.exe src=c:\aaa dest="c:\bbb dest" url=http://localhost/Test
login=admin password=123
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Figure: Example of the ReportUpdater.exe utility in use

In the example, the command line does not contain the log parameter; therefore, the
ReportUpdater.exe tool outputs the log information to the Command Prompt window.
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Glossary
Class. See Data Access Class.
Data Access Class. In Acumatica ERP, the data is stored in a database. However, users of Acumatica
ERP do not access the database tables directly. Instead, they access the data access classes. In
many cases, the data access classes directly correspond to the database tables; however, this is not
necessarily the case for all the tables.
Data Field. The fields of the Data Access Classes. The data field correspond to the database
columns, but this is not necessarily the case for all the fields.
Data Class. See Data Access Class.
Excel. Microsoft Office Excel.
MS Excel. Microsoft Office Excel.
OData. The Open Data Protocol is a general-purpose data access technology. OData defines an abstract
data model and a protocol that can be used to expose any client access information from any data
source in Acumatica ERP.
Table. See Data Access Class.

